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Ñaõ töø laâu caùc KTV ñoà hoïa, hoïa só, caùc nhaø xöû lyù aûnh ñeàu xem 

Photoshop CS nhö moät coâng cuï khoâng theå thieáu ñöôïc trong thieát keá xöû lyù 

aûnh.Trong tay caùc nhaø thieát keá myõ thuaät caây gaäy thaàn Photoshop CS ñaõ 

giuùp hoï khoâng chæ taùi hieän theá giôùi theo quan ñieåm rieâng, maø coøn bieán giaác 

mô thaønh hieän thaät, vôùi söï phaùt trieån nhanh cuûa kyõ thuaät soá, kyõ thuaät in aán, 

moâi tröôøng Internet, Multimedia, ñaõ mang laïi cho Photoshop khaû naêng öùng 

duïng voâ haïn  

      Chöông trình Photoshop CS vaø Image Ready 7.0 seõ giuùp caùc baïn hoïc 

vieân tìm hieåu theâm nhöõng tính naêng tuyeät vôøi cuûa phieân baûn môùi.  

      Photoshop CS, trình baøy caùc kyõ thuaät xöû lyù aûnh cao caáp, caùc tính 

naêng môùi  giuùp baïn taïo ñöôïc caùc hình aûnh ñeïp maét roõ neùt, vaø mang tính myõ 

thuaät cao, hoã trôï ñaéc löïc cho caùc chöông trình daøn trang vaø taùch maøu ñieän 

töû, ñaëc bieät caùc hình theå daïng Vector ñöôïc söû duïng trong moâi tröôøng laøm 

vieäc cuûa Photoshop.  

      Image Ready vôùi caùc kyõ thuaät toái öu aûnh, taïo ñöôïc caùc ñoaïn hoaït 

hình Rollover öùng vôùi caùc thao taùc Mouse, taïo caùc nuùt cho trang Web, baïn 

seõ taïo ñoaïn hoaït hình töø moät maûnh ñôn baèng caùch söû duïng caùc file GIF hoaït 

hình, moät file GIF hoaït hình laø moät chuoãi lieân tieáp nhieàu aûnh hoaëc nhieàu 

Frame (khung) hôïp thaønh.  

      Vôùi caùch söû duïng baøi taäp thöïc haønh laøm neàn taûng cho baïn hoïc taäp vaø 

laøm quen vôùi Photoshop CS vaø Image Ready töø baøi caên baûn ñeán naâng cao. 

Hy voïng baïn seõ caûm thaáy vui maét vaø thuù vò hôn vôùi caùc hình aûnh soáng ñoäng 

maø Photoshop ñaõ ñem ñeán cho baïn.  

       Traû laïi giaù trò maëc ñònh cho caùc xaùc laäp maëc ñònh cho Photoshop CS 

vaø Image Ready tröùoc khi tieán haønh thöïc taäp ñieàu ñoù seõ ñaûm baûo cho caùc 

coâng cuï vaø caùc baûn option nhö ñöôïc thöïc hieän trong giaùo trình naøy.  

       File xaùc laäp  (Preferences file) cuûa chöông trình löu giöõ caùc xaùc laäp 

cuûa caùc baûn leänh vaø caùc xaùc laäp caân chænh maøn hình.  

       Nhaân giöõ Phím Shift + Ctrl + Alt  ngay khi vöøa khôûi ñoäng Photoshop 

hoaëc Image Ready xuaát hieän hoäp thoaïi thoâng baùo: � Delete the Adobe 

Photoshop Settings File�, choïn Yes 

 

Höôùng daån Baøi Hoïc vaø Thöïc Haønh Photoshop CS seõ giuùp baïn phaàn 

naøo trong quaù trình tham gia tìm hieåu chöông trình xöû lyù aûnh ñöôïc caäp nhaät 
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môùi nhaát hieän nay. Hy voïng baïn seõ thöïc hieän toát caùc baøi thöïc haønh toâi ñaõ 

soaïn sau ñaây. 

 

CHUÙC BAÏN THAØNH COÂNG TRONG HOÏC TAÄP 
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Khi laøm vieäc vôùi Photoshop CS, baïn seõ khaùm phaù ñöôïc 

nhieàu caùch thöùc ñeå hoaøn thaønh coâng vieäc nhö nhau, muoán söû duïng 

toát khaû naêng chænh söûa aûnh cuûa caû hai chöông trình Photoshop CS 

vaø Image Ready, baïn caàn bieát veà vuøng laøm vieäc cuûa chuùng.  

   Chöông naøy baïn tìm hieåu nhöõng baøi sau :  

- Môû moät file môùi sau khi khôûi ñoäng chöông trình  

- Caùc coâng cuï choïn löïa  

- Laøm vieäc vôùi caùc Palette (baûng)  

 

Baøi 1: Khôûi ñoäng vaø môû 1 file aûnh môùi  

* Khôûi ñoäng : 

    Double click vaøo Icon  (bieåu töôïng) cuûa Photoshop ñeå khôûi 

ñoäng. 

Khi khôûi ñoäng Photoshop, treân maøn hình seõ xuaát hieän menu thanh 

ngang (menu bar), hoäp coâng cuï (Toolbox), thanh tuyø choïn cuûa 

coâng cuï (Tool Option Bar) vaø caùc nhoùm baûng (Palette).  

Chöông trình Photoshop vaø Image Ready ñeàu laøm vieäc vôùi 

aûnh Bitmap, aûnh kyõ thuaät soá  (caùc aûnh do moät loaït caùc hình vuoâng 

nhoû goïi laø caùc Pixel phaàn töû  aûnh hôïp thaønh). 
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Baïn coù theå veõ hình trong Photoshop vaø caùc hình theå naøy taïo ra raát 

tinh xaûo maø vaãn giöõ ñöôïc ñoä saéc neùt khi tyû leä cuûa chuùng ñöôc phoùng lôùn or 

thu nhoû. Baïn xöû lyù caùc aûnh töø maùy queùt aûnh Scanner, queùt töø phim ñöông 

baûn, hoaëc caét  (Capture) töø video hay ñöôïc nhaäp vaøo (Import) töø caùc chöông 

trình veõ khaùc,  nhaäp ñöôïc aûnh töø maùy kyõ thuaät soá (Digital Camera) 

 

Baøi  2: Caùc coâng cuï choïn  

Trong hoäp coâng cuï  (Toolbox) chöùa caùc coâng cuï choïn löïa, veõ vaø 

chænh söûa. Vôùi caùc coâng cuï naøy baïn seõ bieát ñöôc caùc tính naêng chuyeân bieät 

cuûa chuùng.  

      Ñeå choïn moät coâng cuï, baïn chæ caàn click troû mouse vaøo coâng cuï ñoù ôû 

hoäp Toolbox hoaëc coù theå nhaán phím taét töø baøn phím. Coâng cuï ñöôïc choïn seõ 

coù taùc duïng cho ñeán khi baïn choïn moät coâng cuï khaùc.  

      Moät vaøi coâng cuï coù hình tam giaùc nhoû ôû goùc döôùi phaûi ñeå cho baïn 

bieát coøn coù caùc coâng cuï aån phía döôùi  

     Caùch choïn caùc coâng cuï aån  

 - Nhaán giöõ mouse treân coâng cuï coù chöùa coâng cuï aån, sau ñoù di chuyeån 

mouse choïn coâng cuï mong muoán töø menu chöùa.  

- Nhaán giöõ Shift + phím taét cuûa coâng cuï, laäp laïi nhieàu laàn cho ñeán khi 

xuaát hieän coâng cuï maø baïn muoán choïn  

- Nhaán giöõ Alt vaø click vaøo coâng cuï. Moãi laàn click caùc coâng cuï bò aån 

seõ keá tieáp xuaát hieän.  

 

Baøi  3: Söû duïng thanh tuøy choïn cuûa coâng cuï (Tool options bar). 

 

 

 

    Taát caû caùc coâng cuï ñeàu coù caùc tuyø choïn rieâng cuûa noù, vaø caùc tuyø choïn 

naøy ñöôïc theå hieän treân thanh tuyø choïn cuûa coâng cuï  

Thanh tuyø choïn luoân thay ñoåi theo ñeå phuø hôïp vôùi töøng coâng cuï ñang 

ñöôïc choïn, moät vaøi thanh tuyø choïn vaø baûng coù caùc tuyø choïn cho pheùp  baïn 

nhaäp vaøo caùc giaù trò soá baèng caùch söû duïng thanh tröôït, phaàn ñònh goùc, caùc 

nuùt muõi teân hoäp nhaäp.  
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 Baøi   4: Laøm vieäc vôùi caùc baûng Paltte  

 Caùcbaûng giuùp cho baïn giaùm saùt vaø chænh söûa aûnh. Maëc ñònh caùc baûng seõ 

xuaát hieän nhö nhö caùcnhoùm baûng choàng leân nhau. Tuyø theo coâng vieäc maø 

baïn coù theå laøm xuaát hieän hoaëc aån noù. Vaøo meu Window / choïn <teân baûng> 

caàn hieån thò. 

 

        

 

+ Thay ñoåi söï theå hieän cuûa baûng 

  

          

 

 

  - Nhaán phím Tab ñeå laøm aån hoaëc hieän taát caû caùc baûng coù treân maøn hình 

(tröø thanh toolbox) 

  - Drag vaøo caùc Tab vaø drag sang vò trí caùc baûng khaùc hoaëc drag ra ngoaøi 

ñeå taïo moät baûng rieâng bieät. 

  - Gaén baûng vaøo thanh tuyø choïn cuûa Photoshop,  drag Tab cuûa töøng baûng 

thaû vaûo vuøng troáng maøu xaùm ñaäm beân phaûi thanh tuyø choïn.  

  - Click nuùt tam giaùc nhoû beân phaûi cuûa baûng ñeå môû moät menu con. 

  - Click vaøo nuùt tröø goùc treân phaûi cuûa baûng ñeå thu nhoû baûng Minimize hoaëc 

click vaøo daáu vuoâng ñeå môû roäng baûng Maximize. 
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Xaùc laäp vò trí cuaû baûng vaø hoäp thoaïi 

Vò trí cuaû caùc baûng hieän coù vaø caùc hoäp thoaïi seõ ñöôïc löu nhö maëc 

ñònh khi baïn thoaùt ra khoûi chöông trình. Nhöng cuõng coù theå khôûi ñoäng 

chöông trình vôùi vò trí maëc ñònh ñaàu tieân hoaëc baïn coù theå ñöa trôû laïi vò trí 

maëc ñònh taïi baát cöù thôøi ñieåm naøo: 

 Ñeå luoân luoân khôûi ñoäng vôùi vò trí maëc ñònh ñaàu tieân. 

 Menu Edit / Preferences / General vaø huyû boû choïn tuyø choïn Save 

palette Locations. 
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Phaàn quan troïng nhaát ñeå laøm vieäc vôùi Photoshop laø laøm theá naøo ñeå 

choïn ñöôïc moät vuøng maø baïn caàn xöû lyù. Khi moät vuøng treân aûnh ñöôïc choïn 

löïa thì chæ phaàn ñoù chòu taùc ñoäng coøn phaàn khaùc khoâng aûnh höôûng.  

Giôùi thieäu veà coâng cuï choïn  

 

 

 

Baïn coù theå choïn löïa tuyø theo kích côõ cuûa aûnh, hình daùng cuõng nhö 

maøu saéc, baèng caùch söû duïng caùc coâng cuï choïn sau:  

- Coâng cuï choïn Rectangular Marquee:  Cho pheùp baïn taïo moät vuøng 

choïn laø hình chöõ nhaät treân aûnh hoaëc hình vuoâng baèng caùch nhaán giöõ theâm 

phím Shift treân baøn phím. 

- Coâng cuï Eliptical Marquee: Cho pheùp baïn choïn vuøng choïn  laø moät 

vuøng choïn Elip hoaëc hình troøn baèng caùch nhaán giöõ theâm phím Shift treân baøn 

phím.  

- Coâng cuï  Single  Row Marquee vaø Single column Marquee:  Cho 

pheùp choïn moät vuøng choïn laø moät doøng cao 1 pixel vaø moät coät roäng 1 pixel.  

 

- Coâng cuï Drop: Duøng ñeå xeùn nhöõng phaàn aûnh khoâng caàn thieát. 

Choïn vuøng aûnh muoán giöõ laïi, (baïn coøn coù theå xoay hoaëc thu phoùng vuøng 

aûnh choïn muoán giöõ laïi). Nhaán Enter.  
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-  Coâng cuï Lasso:  Drag moät vuøng choïn töï do, ñieåm cuoái cuøng truøng 

ñieåm ñaàu tieân ñeå taïo neân moät vuøng choïn kheùp kín. 

 

 

 

 

- Coâng cuï Polygon lasso : Noái caùc ñoaïn thaúng ñeå taïo neân moät vuøng 

choïn.  

 

 

 

- Coâng cuï Magnetic  Lasso : Drag mouse theo bieân vuøng aûnh coù 

vuøng ñoàng maøu töông töï,  coù tính chaát baét dính (Snap) vaøo bieân cuûa phaàn 

aûnh. 

 

 

                          

- Coâng cuï Magic Wand cho baïn choïn moät phaàn aûnh döïa treân ñoä 

töông ñoàng veà maøu saéc cuûa caùc pixel keà nhau. 
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Duøng baøi thöïc haønh maãu ñeå öùng duïng caùc coâng cuï choïn löïa. 

Choïn vôùi coâng cuï Marquee Rectangular 

Menu file / Open / choïn Lesson 1 / start . psd   

 

 

 

Trong file chöùa caùc aûnh rau traùi ñeå baïn thöc 

taäp baøi choïn löïa baèng coâng cuï, ñeå chuaån bò gheùp 

hình thaønh hình khuoân maët.  

Click choïn coâng cuï Rectangular  Marquee.  

 Drag troû treân traùi xuoáng goùc döôùi phaûi ñeå taïo 

moät vuøng choïn (vuøng kieán boø).  

 Baïn di chuyeån vuøng choïn vöøa taïo theo ñuùng 

vò trí aûnh muoán choïn baèng caùch duøng ngay troû 

vöøa choïn ñaët vaøo trong vaø drag mouse, noù 

khoâng laøm thay ñoåi kích côõ vaø hình daùng cuûa 

vuøng choïn. 

 Neáu khoâng haøi loøng vôùi vuøng choïn vöøa taïo 

baïn coù theå huûy vuøng choïn.  

 Menu select / Deselest (Ctrl + D) hoaëc click troû 

vaøo vò trí baát kyø trong aûnh ñeå huyû choïn.  

Löu YÙ :  Vôùi coâng cuï choïn hình chöõ nhaät naøy khoâng caét ñöôïc ñuùng 

vieàn cuûa quaû döa , neáu caét sang file khaùc vuøng traéng beân ngoaøi quaû döa ñöôïc 

choïn theo. 

 

Choïn vôùi coâng cuï Eliptical Marquee  

Duøng coâng cuï naøy ñeå choïn vuøng con maét cho khuoân maët,  drag choïn 

maët caét cuûa cuû caø roát  
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 Ñaët troû bieân traùi cuûa vuøng aûnh muoán choïn. Nhaán giöõ phím 

Spacebar vaø drag mouse  

 Choïn ñoái töôïng aûnh töø taâm. Di chuyeån coâng cuï choïn vuøng ñeán taâm 

cuûa maët caét cuû caø roát. 

    Click vaø drag ñoàng thôøi giöõ phím Alt khi ñoái töôïng ñöôïc choïn xong thaû 

mouse vaø thaû phím  Alt sau cuøng.  

*  Caùch di chuyeån phaàn aûnh ñöôïc choïn  

    Duøng coâng cuï  Move, ñaët troû vaøo giöõa vuøng choïn, troû thaønh hình muõi 

teân coù keøm theo hình chieác keùo, cho bieát neáu baïn drag mouse noù seõ caét aûnh 

taïi vò trí hieän haønh vaø di chuyeån vuøng aûnh caét sang vò trí môùi.  

 Choïn menu Select /Deselect (Ctrl +D ) ñeå huyû vuøng choïn.  

*  Di chuyeån vaø sao cheùp vuøng choïn  

Ta seõ thöïc haønh sao cheùp vaø di chuyeån cuøng luùc  

Nhaán Ctrl (-) hoaëc Ctrl (+) ñeå trôû veà hình aûnh 100 %  

Duøng coâng cuï choïn Elip choïn vuøng maët caét cuûa cuû caø roát.  

Choïn coâng cuï Move, ñaët troû vaøo trong phaàn  choïn löïa nhaán giöõ phím Alt, 

troû mouse trôû thaønh muõi teân ñoâi cho bieát aûnh seõ ñöôïc sao cheùp khi baïn drag 

mouse ñeå di chuyeån vuøng  aûnh choïn . 

Tieáp tuïc nhaán giöõ Alt vaø drag baûn sao ñaët treân vò trí quaû döa. Baïn 

nhaán giöõ Shift khi di chuyeån vuøng choïn ñeå eùp buoäc noù di chuyeån theo 

höôùng ñöùng hoaëc ngang hoaëc doïc.  

*  Di chuyeån baèng caùc phím taét  

Phím taét cho pheùp baïn söû duïng taïm thôøi coâng cuï, thay vì phaûi choïn 

noù töø hoäp coâng cuï, baïn choïn vaø hoïc thuoäc caùc phím taét coù trong teân caùc 

coâng cuï ñeå thuaän tieän söû duïng cho caùc coâng vieäc xöû lyù aûnh sau naøy moät 

caùch nhanh choùng.  

Choïn vuøng quaû Riwi baèng coâng cuï Elip hoaëc nhaán phím M  

Nhaán giöõ phím Ctrl. Troû bieán thaønh muõi teân vôùi bieåu töôïng chieác keùo beân 

caïnh thoâng baùo vuøng choïn seõ bò caét töø vò trí naøy.  

Di chuyeån quaû Kiwi ñaët leân khuoân maët quaû döa ñeå laøm mieäng.  

*  Di chuyeån vuøng aûnh choïn baèng 4 phím muõi teân  

Baïn coù theå ñieàu chænh vò trí vuøng aûnh choïn moät chuùt baèng caùc phím 

muõi teân vôùi moãi böôùc chuyeån laø 1 pixel hoaëc 10 pixel khi nhaán giöõ phím 

Shift.  

Chuù YÙ : Caùc phím muõi teân chæ ñieàu chænh vò trí cuûa vuøng choïn sau khi baïn ñaõ 

di chuyeån vuøng choïn hoaëc khi coâng cuï Move ñang ñöôïc choïn, neáu khoâng chæ 

laøm di chuyeån bieân choïn maø thoâi, coøn phaàn aûnh choïn seõ khoâng di chuyeån . 

Nhaán giöõ Shift moãi laàn nhaán 1 trong 4 phím muõi teân vuøng aûnh choïn 

seõ di chuyeån 10 pixel.  
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Baïn thöû thöïc hieän vôùi caùc muõi teân ñeå xem taùc duïng.  

*  Sao cheùp vuøng aûnh choïn sang file khaùc  

Choïn vuøng aûnh baèng coâng cuï choïn baát ky.ø  

Choïn coâng cuï Move, ñaët troû vaøo giöõa vuøng choïn vaø drag mouse sang 

file khaùc (file ñaõ ñöôïc môû saün ñang naèm treân vò trí maøn hình) khi drag aûnh 

sang file khaùc troû xuaát hieän laø daáu muõi teân keøm theo hình daáu (+) cho baïn 

bieát laø vuøng aûnh choïn ñaõ ñöôïc copy sang, baïn thaû mouse . 

-  Baïn cuõng coù theå copy vuøng aûnh choïn sang file khaùc baèng leänh Copy, 

Copy Merged, Cut, Paste, Paste Into.  

 Leänh Copy duøng ñeå sao cheùp vuøng choïn treân Layer hoaëc Background  

hieän haønh.  

 Leänh Copy Merged: Sao cheùp vuøng choïn treân taát caû caùc Layer ñang 

hieån thò. 

 Leänh Past: Daùn giöõ lieäu ñaõ ñöôïc Cut  hoaëc  Copy sang vò trí khaùc cuûa 

file aûnh hoaëc sang file khaùc ñeå taïo neân moät Layer môùi.  

 Leänh  Past Into: Daùn döõõ lieäu ñaõ ñöôïc caét hoaëc sao cheùp vaøo beân trong 

moät vuøng choïn khaùc trong file aûnh.  

 

Löu yù: Sao cheùp vaø drag vôùi coâng cuï Move seõ ñôõ toán boä nhôù vì trong tröôøng 

hôïp naøy Clipboard khoâng ñöôïc duøng ñeán nhö leänh Copy, Copy Merged, Cut, 

Paste.  

 

Choïn vôùi coâng cuï lasso: Coâng cuï choïn töï do  

       Drag mouse  töï do treân vuøng aûnh muoán choïn, coâng cuï naøy duøng cho 

nhöõng vuøng aûnh choïn khoâng caàn ñoä chính xaùc cao.  

       Ñieåm cuoái cuøng click truøng ñieåm ñaàu tieân vuøng choïn kheùp kín.  

 

Choïn vôùi coâng cuï Polygon Lasso  

Zoom lôùn phaàn chieác nô trong baøi Start  

Duøng coâng cuï Polygon Lasso Click töøng ñieåm ñeå taïo neân caùc ñoaïn 

thaúng lieân keát, baïn coù theå deå daøng choïn caùc ñöôøng gaáp khaùc  

Ñieåm cuoái cuøng ñaët truøng vaøo ñieåm click ñaàu tieân  con troû hình daáu 

troøn, bieân choïn ñaõ hoaøn thaønh . 

 

Choïn vôùi coâng cuï Magnetic Lasso : 

 Baïn duøng coâng cuï Magnetic Lasso, ñeå drag veõ ñöôøng bieân choïn cho 

1 vuøng coù ñoä töông phaûn cao ôû bieân, khi drag mouse ñöôøng bieân choïn  töï 

ñoäng huùt vaøo ñöôøng bieân cuûa vuøng aûnh muoán choïn. Coù theå ñieàu khieån 
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höôùng cuûa ñöôøng bieân choïn baèng caùch chuû ñoäng click mouse ñeå xaùc ñònh 

caùc ñieåm eùp buoäc, ñieåm ñònh höôùng  (fastening point)  

Thöïc hieän coâng cuï naøy cho vuøng choïn laø laùt caét quaû cam, nho, click ñieåm 

ñaàu  tieân phaàn beân trong, thaû mouse vaø di chuyeån con troû doïc theo ñöôøng 

cong bieân phaàn ruoät  maøu ñoû töø phaûi sang traùi      

                                        

 Con troû seõ huùt vaøo bieân vaø töï ñoäng theâm vaøo caùc ñieåm  Fastening 

point  

 Neáu thaáy ñöôøng bieân choïn khoâng huùt  ñuùng theo phaàn muoán choïn (coù theå 

do ñoä töông phaûn cuûa vuøng aûnh naøy quaù thaáp), baïn click mouse chuû ñoäng 

taïo caùc ñieåm fastening point. Baïn cuõng boû ñöôïc caùc ñieåm fastening ñaõ coù 

baèng caùch nhaán phím Del vaø di chuyeån troû theo höôùng ngöôïc laïi. Moãi laàn 

nhaán Del seõ xoaù ñi moät ñieåm Fastening.  

 

Choïn baèng coâng cuï Magic Wand  

Coâng cuï Magic Wand cho pheùp choïn nhöõng pixel gaàn nhau trong 

aûnh döïa treân söï töông ñoàng veà maøu saéc.  

Thöïc hieän coâng cuï naøy ñeå choïn hình quaû leâ trong aûnh ñeå laøm chieác 

muõi.  

Thanh tuyø choïn cuûa coâng cuï naøy cho pheùp baïn thay ñoåi tính naêng cuûa 

coâng cuï xaùc laäp Tolerance cho bieát coù bao nhieâu tone maøu seõ ñöôc choïn 

khi click vaøo moät vuøng aûnh naøo ñoù. Giaù trò maët ñònh laø 32 (32 tone maøu 

saùng xaáp xæ nhau vaø 32 tone maøu ñaäm töông töï nhau ñöôïc choïn).  

Click troû Magic Wand vaøo quaû leâ, moät vuøng choïn xuaát hieän, nhaán giöõ 

shift  daáu (+) xuaát hieän beân troû, baïn click troû vaøo phaàn coøn laïi cuûa quaû döa 

ñeå choïn theâm vuøng choïn.  

*  Theâm vaø bôùt vuøng choïn  

- Nhaán giöõ shift drag mouse ñeå theâm moät vuøng choïn löïa.  

- Nhaán giöõ Alt  drag mouse vaøo vuøng choïn coù saün ñeå tröø bôùt vuøng 

choïn löïa.  

*  Laøm meàm bieân choïn  

  Laøm cho bieân choïn trong meàm hôn khoâng bò gaõy khuùc.  

Copy laät ñoái xöùng 
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 Anti Alias: Laøm trôn caùc bieân lôõm chôõm cuûa vuøng choïn baèng caùch hoaø 

laãn maøu chuyeån tieáp giöõa caùc pixel bieân vaø pixel neàn, chæ pixel bieân bò thay 

ñoåi, caùc chi tieát khoâng bò maát.  

Tuyø choïn Anti alias phaûi ñöôïc choïn tröôùc khi duøng caùc coâng cuï choïn 

ñeå choïn vuøng aûnh.  

 Feather: Laøm môø, nhoøe bieân baèng caùch taïo söï chuyeån tieáp giöõa vuøng 

choïn vaø caùc pixel sung quanh noù vieäc laøm nhoøe naøy coù theå laøm maát chi tieát 

taïi bieân vuøng choïn. Ñònh ñoä Feather tröôùc khi choïn vuøng choïn  löïa baèng 

caùc coâng cuï Marquee, Lasso, Polygon Lasso, Magnetic Lasso. 

Giaù trò Feather töø 1 ñeán 255 pixel.  

Tröôøng hôïp neáu bieân choïn ñaõ thöïc hieän muoán xaùc laäp Feather  

         Menu Select /  choïn Feather,  nhaäp giaù trò ñoä môø bieân tuyø yù.  Click 

nuùt OK. 

 

* Bieán ñoåi aûnh vuøng choïn treân Layer  

Menu Edit / Transfrom(Ctrl+T)  

 

   Scale: Co giaõn vuøng aûnh 

choïn hoaëc ñoái töôïng aûnh treân 

Layer 

  Skew: Laøm nghieâng vuøng 

aûnh choïn hoaëc ñoái töôïng aûnh 

treân Layer  

  Distort: Hieäu chænh bieán 

daïng hình aûnh. 

  Perspective: Thay ñoåi phoái 

caûnh cuûa vuøng aûnh choïn.  

  Rotate: Xoay vuøng aûnh 

choïn hoaëc ñoái töôïng aûnh treân Layer.  

  Number: Tính chính xaùc theo ñieåm aûnh. 

  Rotate: Xoay vuøng aûnh choïn hoaëc ñoái töôïng aûnh treân Layer 

90 ñoä CW theo chieàu kim ñoàng hoà   

90 ñoä CCW ngöôïc chieàu kim ñoàng hoà 

  Elip Horizontal : Laät ñoái xöùng theo phöông doïc. 

 Elip Vertical : Laät ñoái xöùng theo phöông ngang. 

Moät hoäp bao (Bounding Box) xuaát hieän, baïn coù theå thöïc hieän co giaõn, 

xoay, nghieâng, laät ñoái xöùng, thay ñoåi kích côõ.  
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Ñaët troû vaøo moät trong caùc handle vaø drag mouse, nhaán giöõ shift trong 

khi drag ñeå eùp buoäc thay ñoåi theo tyû leä, nhaán Enter ñeå keát thuùc vieäc chænh 

söûa .  

Thöïc hieän cho vuøng tai, duøng Rotate 90 ñoä CW ñeå xoay ñoái töôïng 

aûnh chieàu kim ñoàng hoà 

 Copy di chuyeån. 

 Duøng hieäu öùng Elip Horizontal  ñeå laät ñoái xöùng theo phöông ngang. 

 

Maãu thöïc haønh gheùp aûnh öùng duïng 

Döïa treân baøi öùng duïng vöøa thöïc hieän ôû treân 

 

        

 

maãu ban ñaàu                       maãu ñaõ hoaøn thaønh 
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Moãi file cuûa Photoshop chöùa  moät hoaëc nhieàu  Layer  rieâng bieät. 

Moät file môùi thöôøng laø moät Background chöùa maøu hoaëc aûnh neàn maø coù theå 

nhìn thaáy ñöôïc thoâng qua phaàn trong suoát cuûa caùc Layer taïo theâm sau. Baïn 

coù theå quaûn lí caùc  Layer baèng baûng hieån thò lôùp. 

1. Caùch hieån thò hoäp Layer  

Menu window / Layers  

 

 
 

Taát  caû caùc Layer tröø neàân Background luoân luoân trong suoát, phaàn beân 

ngoaøi cuûa moät aûnh treân Layer cuõng laø moät phaàn trong suoát coù theå nhìn thaáy 

ñöôïc caùc lôùp beân döôùi no.ù  

Caùc Layer trong suoát töông töï nhö taám phim coù veõ hình, choàng leân 

nhau thaønh nhieàu lôùp,  baïn coù theå chænh söûa, thay ñoåi kích thöôùc vò trí, xoùa 

treân töøng lôùp maø khoâng heà aûnh höôûng tôùi caùc hình veõ khaùc treân Layer khaùc.  

Khi keát hôïp caùc lôùp xeáp choàng leân nhau ñeå taïo neân  1 böùc aûnh hoaøn haûo.  

* Taïo vaø tham khaûo baûng Layer khi choïn vuøng aûnh hoaëc duøng Move 

di chuyeån moät aûnh töø  file khaùc sang seõ töï taïo thaønh moät Layer.  
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 Baïn cuõng coù theå nhôn baûn Layer ñeå taïo neân moät Layer môùi rieâng.  

Baïn taïo ñöôïc toiá ña laø 8000 Layer goàm Layer Set (boä Layer), Layer 

chöùa caùc hieäu öùng Effect (caùc hieäu öùng laøm noåi) cho rieâng töøng file aûnh. 

Treân moãi Layer baïn xaùc laäp phöông thöùc phoái troän maøu  (Blending mode)  

Opacity ñoä môø ñuïc cho rieâng Layer, nhöng do maùy tính coù boä nhôù giôùi haïn 

vaø baïn cuõng chæ caàn soá Layer vöøa ñuû ñeå taïo neân moät file aûnh cuûa mình. Vì 

moãi  Layer, boä Layer ñaõ chöùa caùc hieäu öùng vaø döõ lieäu rieâng neân giaù trò thöïc 

teá seõ chæ tôùi 1000 Layer.  

*   Bieåu töôïng con maét trong hoäp Layer ñeå aån vaø hieän Layer.  

*   Bieåu töôïng caây buùt: Layer ñang choïn  

 

  

 

 

2. Caùc caùch taïo Layer aûnh vaø copy Layer aûnh. 

 Vuøng choïn aûnh  

 Menu Layer / New / Layer Via Copy: Copy vuøng aûnh choïn ñaët treân1 

Layer môùi  

  Menu Layer /New / Layer Via Cut: Caét vuøng aûnh choïn ñaët treân 1 Layer 

môùi.  

 Nhaán phaûi vaøo Layer muoán Copy, trong hoäp Show Layer -> choïn 

Duplicate Layer. 

 Nhaáp vaøo Menu con cuûa hoäp Show Layer choïn Duplicate Layer.  

 Drag Layer muoán Copy thaû vaøo oâ New Layer trong hoäp Layer.  

 Khi nhaäp vaên baûn baèng coâng cuï Type cuõng töï taïo thaønh 1 Layer môùi.  
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3. Saép xeáp caùc Layer  

      Trong baûng Layer -> duøng troû mouse ñaët vaøo Layer muoán di chuyeån -

> troû thaønh hình baøn tay, nhaán giöõ  mouse vaø drag leân hoaëc xuoáng döôùi caùc 

Layer.  

*  Thuaän lôïi khi söû duïng caùc Layer  

  Caùc Layer cho pheùp chænh söûa töøng phaàn cuûa file aûnh treân moãi Layer 

rieâng bieät.  

*  Caùch laøm aån hoaëc hieän caùc Layer rieâng bieät: 

Bieåu töôïng con maét ôû beân traùi treân Layer, trong 

baûng Layers baùo cho baïn bieát Layer ñoù ñang ñöôïc 

hieån thò. Coù theå laøm aån hoaëc hieän Layer baèng caùch 

click vaøo bieåu töôïng naøy.  

* Baïn coù theå mang aûnh trong moät Layer leân tröôùc 

aûnh hoaëc sau trong moät Layer khaùc baèng caùch 

drag Layer trong baûn Layer treân Layers hoaëc duøng:  

   Menu / Layer / Arrange / Bring to Front  

             Mneu / Layer / Arrange / Bring to Back  

* Khi hoaøn taát coâng vieäc cho moät file aûnh ñeå laøm 

giaûm dung löôïng file baïn coù theå eùp phaúng file aûnh, 

taát caû caùc Layer seõ ñöôïc hôïp nhaát  (Merge) treân 

cuøng moät neàn Background hoaëc Layer choïn hieän 

haønh. 

* Baïn coù theå lieân keát caùc Layer muoán ñieàu 

chænh baèng caùch choïn 1 Layer trong baûng  Layers, 

Click vaøo oâ vuoâng saùt beân traùi cuûa teân Layer maø 

NHAÁP PHAÛI MOUSE 

VAØO LAYER MUOÁN 

COPY CHOÏN 

DUPLICATE LAYER 
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baïn muoán lieät keâ khi lieân keát baïn coù theå cuøng luùc xoay, di chuyeån ñònh kích 

thöôùc moät caùch ñoàng thôøi. 

4. Caùch phoái troän maøu cuûa Layer  

 Blending Mode vaø Opacity (ñoä môø ñuïc)  

Thöïc hieän troän maøu giöõa caùc Layer vôùi nhau, caùc mode troän cho ta 

caûm giaùc aûnh treân Layer naøy ñöôïc hoaø nhaäp vaøo aûnh treân Layer khaùc. 

Baïn coù theå thöû thöïc hieän vôùi caùc Mode trong dang saùch thaû cuûa hoäp 

Show Layer.  

Opacity: ñoä môø ñuïc cuûa aûnh, aûnh treân Layer seõ trong suoát daàn nhìn 

thaáy roõ phaàn aûnh ôû Layer beân döôùi khi nhaäp giaù trò Opadity giaûm daàn.  

5. Lieân keát caùc Layer  

     Moät caùch raát hieäu quaû laø lieân keát 2 hay nhieàu Layer laïi vôùi nhau. 

Vôùi caùc Layer ñaõ ñöôïc lieân keát, baïn coù theå di chuyeån vaø bieán ñoåi chuùng 

moät caùch ñoàng thôøi ñeå duy trì ñöôïc vò trí coá ñònh cuûa caùc phaàn aûnh treân 

Layer.  

Bieåu töôïng lieân keát (Link) hình moùc xích seõ xuaát hieän trong oâ vuoâng keá beân 

bieåu töôïng maét Layer ñang choïn seõ khoâng coù bieåu töôïng lieân keát cho duø noù 

ñaõ ñöôïc lieân keát. 

   

6. Toâ maøu chuyeån saéc cho Layer  

 Coâng cuï Gradient  

Baïn coù theå taïo moät Layer môùi hoaëc taïo moät vuøng choïn löïa tuyø yù ñeå 

ñaët maøu toâ chuyeån saéc tuyø yù.  

 Choïn coâng cuï Gradient trong hoäp coâng cu.ï  

 Thanh tuyø choïn coâng cuï Gradient, Clcik choïn nuùt Linear Gradient 

(chuyeån maøu theo phöông thaúng) Click vaøo nuùt coù muõi teân tam giaùc 

beân phaûi thanh chuyeån maøu (Menu con) ñeå môû Menu choïn. 

 

   OÂ thöù nhaát: Maøu toâ töø maøu Foreground 

to Background  

   OÂ thöù hai traùi ñeám qua: Maøu toâ trong 

suoát Foreground to Transparency 

  

Caùc oâ maøu coøn laïi baïn coù theå tuyø choïn. 

Muoán thay ñoåi daõy maøu khaùc, Double 

Click vaøo oâ daõy maøu tuyø yù. Baïn coù theå 

theâm hoaëc thay ñoåi maøu cuûa daõy maøu 

trong muïc     



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

21 

 

 

 

 

Söû duïng caùc hieäu öùng noåi Style  

Ñaây laø caùc hieäu öùng noåi, baïn coù theå thöïc hieän töøng muïc vôùi caùc 

tuyø choïn thoâng soá rieâng bieät cho hieäu öùng baïn muoán gaùn cho layer ñang 

hieän haønh 

 

 

 

 

Tuyø choïn caùc thuoäc tính töông öùng theo yù thích cuûa baïn. Tam giaùc nhoû cho 

pheùp baïn choïn löïa theâm veà ñoä boùng, maøu saéc, ñoä nghieâng, khoaûng caùch� 

 

  

 

Menu Window / Style  

Aùp duïng caùc oâ laøm noåi naøy cho Layer baèng caùc hieäu öùng coù saün nhö  

Shadow (boùng ñoå), Glow (phaùt saùng), Bevel (vaùt caïnh), Emboss (noåi) vaø 
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caùc hieäu öùng ñaët bieät khaùc. Caùc Layer Style raát deã söû duïng vaø chuùng lieân 

keát tröïc tieáp vôùi Layer.  

     Style bao goàm moät hoaëc nhieàu hieäu öùng.  

 

 
 

 Dropshadow: taïo boùng ñoã beân döôùi 

phaàn aûnh cuûa Layer  

 Inner shadow: Taïo moät boùng ñoã ôû phía 

trong phaàn aûnh treân Layer taïo caûm giaùc 

loõm.  

 Grow vaø Inner Glow: Taïo söï phaùt 

saùng ra beân ngoaøi hoaëc vaøo beân trong 

phaàn aûnh cuûa Layer.  

 Bevel and Embos: Aùp duïng keát hôïp 

giöõa phaàn saùng vaø boùng toái cho Layer.  

 Satin: Taïo boùng phía beân trong phaàn 

aûnh cuûa Layer ñeå loaïi boû söï saéc neùt 

trong Layer.  

 Color, Gradient vaø Pattern  Overlay: Che phuû baèng moät maøu, 

gradient (toâ chuyeån) hoaëc moät pattern (maãu toâ) cho Layer.  

 Stroke: Taïo ñöôøng vieàn bao quanh phaàn aûnh cuûa Layer vôùi maøu ñôn 

saéc, Gradient  hoaëc Pattern. Raát höõu duïng cho vaên baûn khi caàn coù 

ñöôøng bieân roõ neùt. 

Ngoaøi ra trong danh saùch thaû cuaû hoäp taïo hieäu öùng noåi (Styles) baïn 

coøn coù theå choïn theâm caùc daïng hieäu öùng khaùc raát aán töôïng thay vì 

baïn phaûi duøng raát nhieàu thôøi gian ñeå thöïc hieän vôùi boä loïc. 

 

 

 

 

Choïn moät trong caùc muïc 

ñeå coù baûng hoäp noåi töông 

öùng. 
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Khi thöïc hieän choïn moät oâ noåi naøo ñoù trong baûng ñeå gaùn cho Layer, hoäp 

Layer seõ ñöôïc hieån thò ngay caùc hieäu öùng ñaõ hieän ñeå hoaøn thaønh maãu noåi 

cho chöõ. 
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Choïn coâng cuï Type  ( T )  

Click vaøo vò trí aûnh baát kyø ñeå dònh vò trí ñaët chuoãi kí töï. 

Moät Layer vaên baûn môùi (Layer 1) vôùi bieåu töôïng chöõ  �T� keá beân 

treân Layer ñeå thoâng baùo noù laø moät Layer vaên baûn xuaát hieän trong baûn 

Layers.  

 Treân thanh tuyø choïn baïn choïn Font, kích côõ Font, kieåu Font, phöông phaùp 

Anti aliasing, so haøng caùc chuoãi kyù töï, toâ maøu cho chuoãi Text. 

Baïn choïn coâng cuï Move ñeå di chuyeån chuoãi vaên baûn trong aûnh sang vò trí 

tuyø yù neáu noù chöa ñuùng.  

Baïn coù theå choïn moät trong caùc daïng vaên baûn nhö sau trong thanh coâng cu. 

ï  

 

 

  1 .  Daïng Text ñaët theo phöông ngang chuoãi Text töï ñoäng ñaët treân 

Layer rieâng bieät, mang maøu Foreground hieän haønh.  

  2 .  Daïng Text ñaët theo phöông  ngang, hieån thò laø moät chuoãi Text 

choïn, ñöôïc ñaët treân Layer hoaëc Background hieän haønh.  

 3 . Daïng Text ñaët theo kyù töï doïc, naèm treân Layer môùi.  

  4 . Daïng Text ñaët theo kyù töï doïc, naèm treân Layer hay Background 

hieän haønh thuoäc daïng vuøng choïn.  

Ñöa vaên baûn vaøo aûnh ôû cheá ñoä chænh söûa  
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Sau khi ñaõ nhaäp chuoãi vaên baûn baèng coâng cuï Type  -> Neáu muoán 

hieäu chænh laïi vaên baûn, baïn duøng laïi coâng cuï Type click vaøo chuoãi vaên baûn, 

troû sau khi click, seõ thaønh daáu thaúng nhaùy, cho pheùp baïn hieäu chænh noäi 

dung vaên baûn click mouse vaøo kyù töï muoán chænh, Layer vaên baûn seõ töï  ñoåi 

thaønh teân cuûa chuoãi kyù töï vöøa go.õ  

Ñaët chuoãi kyù töï vaøo hình bao coù saün 
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Treân thanh tuyø choïn, click vaøo nuùt  Create Warped Text ñeå môû hoäp thoaïi 

Warp Text trong hoäp Warp Text  choïn daïng töø menu Style, baïn coù theå 

nhaäp giaù trò khaùc ñeå xem keát quaû. Nhaáp ok.  
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Baûng Path coù theå hieän caùc oâ aûnh nhoû (Thumbnail) ñeå theå hieän caùc Path maø 

baïn seõ veõ  

Trong hoäp Tab Path, phía döôùi cuøng cuûa baûng Path coù caùc tuyø choïn duøng ñeå 

toâ maøu vieàn, baïn click vaøo nuùt ñeå choïn. 

 

  

 

Nuùt Fills Path With Foreground Color: Toâ phaàn beân trong cuûa Path baèng 

maøu Foreground  

Nuùt  Strokes Path With Foreground Color: Toâ neùt cuûa Path vôùi maøu 

Foreground  

Nuùt Loads Path As a Selection: Path ñöôïc taïo seõ trôû thaønh vuøng choïn  

Nuùt Make Work Path Fromm Selection: Taïo moät Path töø vuøng choïn löïa  

Nuùt  Create New Path: Taïo moät Path môùi  

Nuùt  Delete Current Path: Xoaù Path hieän haønh . 

 

Caùch veõ Path thaúng   

   Caùc Path thaúng ñöôïc taïo ra khi baïn click mouse baèng coâng cuï Pen. Laàn 

click ñaàu baïn seõ taïo ñöôïc 1 ñieåm (point) ñaàu tieân cho Path, caùc laàn click sau 

seõ taïo caùc ñöôøng path thaúng noái giöõa ñieåm tröôùc vaø ñieåm vöøa click. Khi baïn 

veõ caùc Path, treân baûng Path seõ hieån thò taïm thôøi moät Path coù teân Work Path  

 Khi baïn söû duïng coâng cuï Pen, thanh tuyø choïn cuõng coù caùc thay ñoåi. Tuyø 

choïn Add to Shape  (+ ): Tieáp tuïc theâm caùc Path treân, Path ñaõ taïo baèng 

Pen  
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Ñeå keát thuùc vieäc veõ 1 Path, baïn click laïi coâng cuï Pen. Caùc ñieåm noái 

treân caùc Path ñöôïc goïi laø ñieåm neo (anchor point) Coù theå drag caùc ñieåm neo 

ñeå chænh söûa caùc ñoaïn (Segment)  treân Path coù theå choïn taát caû caùc ñieåm neo 

ñeå choïn tiaøn boä Path.  

 Trong baûng Path, double click vaøo teân Work Path ñeå môû hoäp thoaïi Save 

Path. Baïn coù theå thay ñoåi teân ñeå deã nhôù khi laøm vieäc vôùi nhieàu Path trong 

moät file aûnh Click nuùt Ok vieäc löu Path thaønh teân khaùc ñeå traùnh laøm maát noäi 

dung cuûa noù. Neáu baïn boû choïn moät Work Path maø khoâng löu noù laïi, khi baïn 

baét ñaàu veõ Path môùi thì moät Work Path môùi seõ thay theá cho Work Path tröôùc 

ñoù.  

 Veà caùc ñieåm neo (anchor point) ñieåm ñieàu khieån (direction point) ñöôøng 

ñieàu khieån (drection line). Moät Path goàm coù moät hoaëc nhieàu, ñoaïn thaúng, 

ñoaïn cong. Caùc ñieåm neo ñaùnh daáu ñieåm cuoái cuûa moãi ñoaïn treân Path. Treân 

caùc ñoaïn cong, moãi ñieåm neo ñöôïc choïn seõ theå hieän moät hoaëc hai ñöôøng 

ñieàu khieån, cuoái ñöôøng ñieàu khieån laø caùc ñieåm ñieàu khieån vò trí cuûa ñöôøng 

ñieàu khieån vaø ñieåm ñieàu khieån seõ xaùc ñònh hình daùng vaø kích côõ cuûa ñoaïn.  

 Moät Path kheùp kín (Path ñoùng) khoâng coù ñieåm baét ñaàu vaø keát thuùc (hình troøn). 

Caùc ñöôøng cong trôn Smooth Curve ñöôïc keát noái bôûi caùc ñieåm neon trôn (Smooth Point).

Caùc ñöôøng cong gaõy (Sharp Curve) ñöôïc keát noái baèng caùc ñieåm neo gaõy 

(Correr Point) 

Khi baïn di chuyeån moät ñieåm ñieàu khieån taïi moät ñieåm neo trôn caùc ñoaïn 

cong ôû hai beân ñieåm neo seõ thay ñoåi. Khi di chuyeån moät ñieåm ñieàu khieån 

taïi moät ñieåm neo gaõy thì chæ coù ñoaïn cong ôû cuøng beân vôùi ñieåm ñieàu khieån 

môùi thay ñoåi.  

 

Di chuyeån vaø  hieäu chænh Path  

  Choïn coâng cuï Direction Selection ñeå choïn vaø ñieàu khieån ñieåm neo, 

ñoaïn treân Path hoaëc toaøn boä Path. Nhaán phím A choïn coâng cuï Direct 

Selection, click troû vaøo Path ñaõ taïo ñeå choïn Path. Ñeå ñieàu chænh goùc vaø 

chieàu daøi cuûa path baïn drag moät trong caùc ñieåm neo baèng coâng cuï naøy. 

Muoán choïn toaøn boä caùc ñieåm neo cuøng luùc, baïn nhaán giöõ Alt. Duøng coâng cuï 



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

29 

Direct Selection click vaøo ñoaïn cuûa Path, khi Path ñöôïc choïn taát caû caùc 

ñieåm neo seõ ñöôïc toâ ñen.  

Taïo caùc Path ñoùng  

   Coù theå chuyeån caùc Path thaønh vuøng choïn vaø keát hôïp giöõa vuøng choïn 

naøy vôùi vuøng choïn khaùc. Baïn cuõng coù theå choïn vuøng choïn thaønh Path vaø 

hieäu chænh noù. Veõ Path ñoùng baèng caùch baïn click ñieåm cuoái cuøng truøng vaøo 

ñieåm click ban  ñaàu baèng coâng cuï Pen sau ñoù baïn chænh ñoaïn cong hay hieäu 

chænh thaønh ñoái töôïng naøo baïn muoán vôùi caùc coâng cuï ñaõ giôùi thieäu ôû phaàn 

tröôùc.  

 

Toâ maøu cho Path  

    Vieäc toâ maøu cho Path laø ñöa caùc pixel vaøo Path ñeå Path veõ ñöôïc in 

ra. Baïn toâ ñöôïc maøu  (Fill) hoaëc toâ baèng moät maãu hình aûnh (Pattern) cho 

phaàn trong cuûa Path ñoùng hoaëc coù theå toâ vieàn (Stroke) cho Path. Choïn Path 

baïn muoán toâ maøu. Click choïn maøu tuyø yù trong hoäp Show Swatches ñeå gaùn 

cho oâ Foreground, maøu Foreground naøy seõ ñöôïc toâ cho Path  

Choïn coâng cuï Direct Selection, click vaøo Path ñeå choïn. Menu con (danh 

saùch thaû) cuûa hoäp Path baïn choïn Stroke sub Path (toâ vieàn Path). Choïn coâng 

cuï veõ Airbrush töø  Menu tool  

 Baïn coù theå choïn coâng cuï khaùc trong danh saùch sau khi ñaõ gaùn thuoäc tính 

cho coâng cuï ñoù. Maøu toâ vieàn daøy hoaëc moûng tuyø thuoäc neùt coï Brush baïn 

ñaõ gaùn tröôïc khi toâ Stroke. 

 

Toâ phaàn trong cho Path ñoùng  

Menu con cuûa baûng Paths, danh saùch thaû baïn choïn fill Sub Path  (toâ 

maøu cho Path)  

Choïn maøu Foreground khaùc töø hoäp Swatches tröôùc khi môû hoäp fill 

Sub Path.  

Muïc contents: use: Foreground  Color.  Cho baïn tuyø choïn maøu toâ 

cho path.  

Blending : Söï phoái troän maøu toâ baèng caùc mode maøu.  

Opacity: Ñoä môø ñuïc cuûa maøu toâ töø 0 -> 100% ñoä Opacity giaûm cho 

maøu toâ nhaït trong suoát  

Feather  Radius: Laøm meàm bieân maøu toâ. 

 

Veõ caùc Path cong  

Caùc Path cong ñöôïc taïo baèng caùch click vaø drag, laàn ñaàu Click vaø 

drag, baïn ñaõ xaùc laäp moät ñieåm neo khôæ ñaàu cho path cong. Drag taïi vò trí 
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khaùc, moät ñöôøng cong seõ ñöôïc taïo ra giöõa ñieåm neo tröôùc ñoù vaø ñieåm neo 

hieän haønh.  

Khi baïn drag con troû cuûa coâng cuï Pen Photoshop seõ töï ñoäng taïo caùc 

ñöôøng ñieàu khieån (direction Line) vaø ñieåm ñieàu khieån töø ñieåm neo. Ñöôøng 

vaø ñieåm ñieàu khieån duøng ñeå ñieàu chænh hình daïng vaø höôùng cuûa ñoaïn cong.  

 

Veõ Path xung quanh aûnh  

Baïn söû duïng coâng cuï Pen ñeå taïo vuøng choïn cho aûnh. Baïn seõ veõ caùc 

Path döïa theo caùc phaàn trong aûnh. Khi caùc Path ñaõ ñöôïc taïo baïn seõ chuyeån 

noù thaønh vuøng choïn ñeå theå hieän tieáp caùc coâng vieäc khaùc nhö toâ maøu, aùp 

duïng boä loïc.  

Khi veõ moät Path baát kì baèng coâng cuï Pen baïn duøng ñieåm neo hôïp lyù, soá 

ñieåm neo ít thì hình caøng trôn hôn.  

Chuyeån ñoåi Path thaønh vuøng choïn  

Veõ Path tuyø yù.  

 Menu con cuûa hoäp Show Paths, baïn choïn Make selection, trong danh 

saùch thaû. Ñeå deå daøng söû lyù caùc ñoái töôïng ñoà hoïa treân phaàn meàm Photoshop, 

baïn duøng coâng cuï Pen  ñeå veõ vaø hieäu chænh moät caùch deã daøng, tuy nhieân 

ñoái töôïng veõ daïng naøy chæ laø hình theå Vector neân khoâng cho pheùp baïn thöïc 

hieän, caùc hieäu öùng. Do ñoù vieäc chuyeån ñoåi caùc Path thaønh vuøng choïn cuõng 

raát thuaän tieän vaø khoâng laøm maát thôøi gian nhieàu cuûa baïn.  

Chuyeån vuøng choïn löïa thaønh Path.  

Ñoái vôùi nhöõng hình theå daïng trôn troøn, thay vì duøng Path ñeå taïo neân thì seõ 

raát khoù khaên cho baïn, ta coù theå duøng daïng vuøng choïn löïa vôùi caùc coâng cuï 

choïn coù saün sau ñoù bieán thaønh Path vaø hieäu chænh laïi ñoâi chuùt veà hình theå 

ñoùù  

 Baïn click choïn vaøo Menu con cuûa hoäp Path, choïn Make Work Path, 

hoaëc click vaøo nuùt beân döôùi cuûa hoäp. Baïn duøng caùc coâng cuï Pen ñaõ hoïc ñeå 

chænh söûa laïi caùc ñieåm neo treân Path.  

*  Hoäp tuøy choïn cuûa coâng cuï Pen cho pheùp baïn choïn moät trong hai daïng. 

Create New Shape Layer: Baïn seõ taïo ra caùc hình theå Shape Layer rieâng 

bieät. 

Create New Work Path: Caùc hình theå Shape treân cuøng moät  Layer. 

 

Söû duïng coâng cuï Freeform Pen  

 Khi söû duïng coâng cuï Freeform Pen vaø tuøy choïn Magnetic noù seõ taïo 

ra Path töï ñoäng huùt vaøo caùc phaàn bieân coù ñoä töông phaûn cao. Path seõ huùt 

vaøo ñieåm gaàn nhaát coù ñoä saùng toái hoaëc maøu phaân bieät roõ neùt taïi vò trí bieân 

maø troû cuûa baïn ñang drag treân aûnh. 
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Ñaët troû taïi vò trí bieân baát kì vaø click mouse ñeå taïo ñieåm ñaët Gastening 

Point ñaàu tieân, tieáp tuïc drag mouse (khoâng caàn giöõ mouse) doïc theo bieân 

aûnh. 

Neáu Path khoâng huùt vaøo vò trí bieân mong muoán, baïn coù theå nhaán 

phím Delete ñeå xoùa töøng ñieåm ñaët Fastening Point (theo chieàu ngöôïc laïi) 

vaø tieáp tuïc drag mouse ñeå taïo Path mong muoán. 

 Trong tröôøng hôïp neáu do ñoä saùng toái hoaëc maøu taïi vò trí naøo ñoù khieán 

Path khoâng theå huùt ñuùng vaøo vuøng baïn muoán, baïn coù theå click mouse ñeå 

taïo moät ñieåm Fastening  Point eùp buoäc cho vò trí naøy. 

Fastening Point laø caùc ñieåm ñaït, töï ñoäng taïo ra do quaù trình di 

chuyeån mouse quanh bieân aûnh vôùi coâng cuï Freeform Pen, noù khoâng phaûi laø 

caùc ñieåm neo (an chor Point) sau khi coâng cuï Freeform Pen taïo xong Path, 

chöông trình seõ tính toaùn vaø töï ñoäng taïo ra caùc ñieåm neo.  

*  Baïn coù theå veõ caùc ñoaïn thaúng trong khi söû duïng coâng cuï Freeform Pen 

baèng caùch nhaán giöõ phím Alt (ñeå taïm thôøi chuyeån sang coâng cuï Pen) vaø 

click mouse thaû phím Alt ñeå trôû laïi coâng cuï Freeform Pen.  

 

Caùc thoâng soá cuûa Magnetic Pen  

  Caùc thoâng soá naøy coù taùc duïng khi baïn choïn coâng cuï Freeform Pen 

vôùi tuøy choïn Magnetic. Caùc thoâng soá naøy seõ ñieàu khieån vieäc con troû cuûa 

coâng cuï Freeform pen huùt (snap) vaøo bieân cuûa vuøng aûnh choïn.  

Baïn click vaøo nuùt Magnetic pen treân thanh tuøy choïn ñeã môû baûng Megnetic 

Option  

- Width: Coù giaù trò töø 1-> 40, laø ñoä roäng cuûa phaïm vi ngay döôùi con troû maø 

coâng cuï Freeform Pen seõ xem xeùt khi ñaët ñieåm Fastening Point. Width coù 

giaù trò lôùn thöôøng duøng cho aûnh coù ñoä töông phaûn cao, giaù trò nhoû giuùp cho 

vieäc choïn chính xaùc hôn. Giaù trò maëc ñònh laø 10.  

 Baïn coù theå taêng hoaëc giaûm giaù trò Width baèng caùch nhaán phím môû 

ngoaëc vuoâng treân baøng phím ñeå giaûm vaø phím ñoùng ngoaëc vuoâng treân baøng 

phím ñeå taêng.  

- Contrast: Giaù trò töø 1 -> 100, laø möùc ñoä maëc ñònh caàn thieát cuûa vuøng aûnh 

ñeå coâng cuï Freeform Pen nhaän bieát laø ñöôøng bieân. Giaù trò maëc ñònh laø 10.  

- Frequency: Giaù trò töø 5 -> 40, ñieàu khieån soá ñieåm ñaët Fastening Point 

ñöôïc ñaët khi veõ Path. Giaù trò Frequency thaáp, soá löôïng Fastening Point seõ 

raát nhieàu vaø soá ñieåm neo seõ taêng leân. 

            Coâng cuï  Pen duøng ñeå veõ caùc ñoaïn thaúng hoaëc ñöôøng cong coøn goïi 

laø Path. 
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Coâng cuï Pen duøng nhö moät coâng cuï veõ hoaëc coâng cuï choïn löïa baèng 

Pen seõ taïo ra bieân meàm maïi, chính xaùc khoâng bò raêng cöa. Caùc Path seõ thay 

theá cho caùc coâng cuï choïn löïa chuaån, trong vieäc taïo caùc vuøng choïn nhieàu vaø 

phöùc taïp.  

   Caùc Path coù theå môû hoaëc ñoùng kín. Path môû coù hai ñieåm ñaàu cuoái 

rieâng bieät. Path ñoùng laø Path  lieân tuïc  ñieåm ñaàu vaø cuoái truøng nhau. Kieåu 

Path do baïn choïn ra seõ aûnh höôûng ñeán vieäc choïn vaø chænh söûa chuùng. Caùc 

Path khoâng cho pheùp toâ ñaày maøu trong Fill hoaëc toâ neùt vieàn baèng Stroke.  

Path khoâng ñöôïc in thaønh file aûnh bôûi Path laø ñoái töôïng Vector khoâng chöùa 

pixel naøo caû, noù khoâng gioáng nhö hình theå Bitmap ñöôïc veõ baèng coâng cuï 

pencil  or caùc coâng cuï veõ khaùc. 

*  Nhaán phím P ñeå choïn coâng cuï pen. Tieáp tuïc nhaán phím, Shift ñeå choïn 

laàn löôïc caùc coâng cuï trong nhoùm.  

 Pen tool: Coâng cuï pen, duøng ñeå click töøng ñieåm, taïo neân caùc ñöôøng 

thaúng path.  

 Freefrom Pen tool: Veõ path töï do, drag mouse ñeå taïo ñoái töôïng tuyø 

yù. 

 Add Anchor Point Tool: Theâm ñieåm treân ñoaïn, click vaøo ñoaïn ñeå 

taïo moät ñieåm, baïn tieáp tuïc drag mouse vaøo ñieåm vöøa theâm ñeå taïo 

neân ñoaïn cong.  

 Del Anchor Point  Tool: Huyû nhöõng ñieåm khoâng caàn thieát. 

 Convert Point  Tool: Ñoaïn cong thaønh goùc.  

 

Caùch hieån thò baûng 

 

 

CAÙC HÌNH THEÅ VECTOR TRONG PHOTOSHOP 

 Ñoà hoïa Vector cho pheùp taïo ra caùc hình theå, ñöôïc toâ maøu beân trong 

baèng fill (maøu toâ) hoaëc toâ maøu bieân stroke coù theå duøng caùc hình theå naøy 

laøm Fath caét (clipping fath) ñeå ñieàu khieån söï theå hieän cuûa aûnh. 
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* Phaân bieät ñoà hoïa Vector vaø Bitmap 

  Ñoà hoïa trong maùy tính söû duïng hai daïng chính laø Vector vaø Bitmap, 

moät file aûnh trong Photoshop vaø Image Ready coù theå chöùa caû hai daïng döõ 

lieäu Vector vaø Bitmap. 

 Ñoà hoïa Vector taïo ra caùc ñoaïn thaúng, ñoaïn cong  ñöôïc ñöôïc ñònh  

nghóa baèng caùc ñoái töôïng toaùn hoïc (goïi laø Vector) caùc ñoà hoïa vector  naøy 

vaãn giöõ ñöôïc ñoä roõ neùt, saéc saûo khi baïn di chuyeån, ñònh laïi kích thöôùc hoaëc 

thay ñoåi maøu cho chuùng. Ñoà hoïa Vector thích hôïp cho caùc hình minh hoaï, 

logo vaên baûn ... vaø chuùng coù theå duøng laïi nhieàu laàn vôùi caùc kích côõ khaùc 

nhau.  

AÛnh Bitmap (goïi laø aûnh raster) caùc daïng anûh naøyñöôïc taïo neân bôûi 

moät taäâp hôïp caùc phaàn töû  aûnh (pixe). Moãi pixel xaùc ñònh vò trí vaøø moät giaù trò 

khaùc nhau. Khi laøm vieäc vôùi aûnh bitmap baïn seõ chænh söõa moät nhoùm caùc 

pixel chöù khoâng phaûi vôùi caùc nhoùm ñt hoaëc hình theå. Ñoà hoïa bitmap coù khaû 

naêng dieån taû raát tinh teá möùc ñoä chuyeån daàn cuûa maøu, neâân noù thích hôïp vôùi 

cho caùc aûnh coù toâng maøu chuyeån tieáp cho caùc aûnh chuïp. Tuy nhieân vôùi moät 

File aûnh Bitmap coù nhöõng ñieåm baát lôïi laø chæ chöùa coá ñònh moät soá löôïng 

Pixel vì vaäy chuùng coù theå bò maát ñoä chi tieát vaø theå hieän caùc bieân lôûm chôûm, 

raêng cöa khi baïn phoùng lôùn aûnh treân maøn hình hoaëc in ra vôùi ñoä phaân giaûi 

keùm.  

 

Caùch söûa caùc ñoái töôïng veõ  

     Goàm caùc coâng cuï veõ caùc hình theå, hình (Rectangl) hình chöõ nhaät bo 

goùc. 

 (Rounded Rectangle), hình Elip, hình ña giaùc (Polygon) caùc daïng hình töï 

do.  

(Custom Shape) vaø Line.  

            Baïn taïo moät hình theå treân moät Layer môùi, hình theå vöøa taïo mang 

maøu Foreground hieän haønh hoaëc coù theå thay ñoåi maøu khaùc hay moät maãu 

Pattern khaùc bieân. Cuûa hình theå ñöôïc löu trong Path caét  (Clipping Path) cuûa 

Layer, vaø ñöôïc theå hieän trong baûng Paths . 

 Treân moät File aûnh hoaëc moät File môùi, baïn choïn moät  trong  caùc coâng 

cuï taïo hình theå nhö toâi ñaõ giôùi thieäu ôû treân, baïn ñònh trò soá tuøy yù trong thanh 

tuøy choïn ñeå ñònh daïng laïi coâng cuï caàn veõ Drag mouse ñeå taïo hình theå  

 Hình theå veõ ra mang maøu Foreground ñoàng thôøi trong hoäp Layers 

xuaát hieän moät Layer môùi coù teân maët ñònh laø Shape 1. OÂ aûnh nhoû 

(Thumbnail) beân traùi cho bieát Layer naøy ñaõ ñöôïc toâ maøu OÂ aûnh nhoû beân 

phaûi theå hieän Path  caét cuûa Layer. Caùc Path caét cuõng nhö caùc maët naï, maøu 

traéng laø phaàn theå hieän cuûa aûnh, maøu ñen laø phaàn aûnh bò che khuaát.  
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Caùch caét caùc hình theå trong Layer chöùa caùc hình theå Vector  
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 Sau khi taïo moät Shape Layer (Layer chöùa caùc hình theå Vector) baïn 

coù theå xaùc laäp tuøy choïn caét cho hình theå Vector. Baïn cuõng coù theå duøng 

coâng cuï Path Component Selection vaø coâng cuï Direct Selection ñeå di 

chuyeån vaø hieäu chænh kích côõ cuûa caùc hình theå. Duøng moät ví duï ñeå giaûi 

thích baøi naøy  

 Môû moät File New  kích thöôùc 2 inch x  2 inch  

 Choïn coâng cuï veõ hình theå chöõ nhaät bo goùc Rounded Rectangle veõ 

moät hình theå  -> toâ maøu Foreground  ñaà treân file vöøa môû  

 Choïn coâng cuï veõ hình theå hình chöõ nhaät (Rectangle)  

 Nhaán giöõ  Shift veõ hình vuoâng nhoû  

 Treân thanh tuøy choïn baïn choïn   

     Subtract From Shape Area: Khi caùc hình theå môùi taïo ra seõ caét 

hình theå hình theå ñang coù trong Layer. 
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Hình  vuoâng baïn veõ seõ coù maøu traéng bôûi noù ñaõ caét hænh theå hình vuoâng bo 

goùc vaø hieän ra neàn maøu traéng cuûa neàn. Choïn coâng cuï Path Component 

Selection di chuyeån con troû vaøo trong hình vuoâng nhoû vöøa taïo, nhaán giöõ Alt 

vaø drag mouse ñeå sao cheùp hình theå hình vuoâng môùi sang vò trí keá beân.  

 

            

              

  Choïn moät hình theå vôùi coâng cuï Path Component Selection vaø choïn tuøy 

choïn Intersect Shape Area treân thanh coâng cuï seõ chæ theå hieän vuøng giao 

nhau cuûa hai hình theå.  

 Neáu choïn tuøy choïn Exclide Overlipping Shape Area seõ loaïi boû phaàn 

phuû leân nhau cuûa hai ñoái töôïng.  

 Nhaán giöõ phím Shift vaø click ñeå boû choïn 2 hình theå vuoâng nhoû baèng coâng 

cuï Path Component Selestion  

 Thanh tuøy choïn baïn Click nuùt Align Top Edges  ñeå so haøng theo bieân 

chænh cuûa hai hình theå. 

 Nhaán giöõ Alt vaø drag mouse ñeå taïo theâm caùc hình theå môùi, cho ñeân khi 

baïn coù ñuû caùc hình vuoâng nhö baøi maãu.  

  

Tieáp tuïc so haøng. Toâi giaûi thích trình töï caùc nuùt töø traùi sang phaûi  

 

      

         

  + Nuùt AlignTop Edges: So haøng treân bieân ñænh  

  + Nuùt AlignVertical Centers: So haøng ngay taâm theo chieàu 

ñöùng  

  + Nuùt Align Left Edges: So haøng theo bieân traùi  
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  + Nuùt Align Horizontal Centers: So haøng nagy taâm theo 

chieàu ngang  

  + Nuùt Align Right Edges: So haøng theo bieân phaûi  

  + Nuùt Distribute Top Edges: Daøn ñeàu theo bieân treân ñænh  

  + Nuùt  Distribute Vertical Centers: Daøn ñeàu theo taâm theo 

chieàu ñöùng  

  + Nuùt Distribute Bottom Edges: Daøn ñeàu theo bieân beân döôùi  

  + Nuùt distribute Left Edges: Daøn ñeàu theo bieân traùi  

  + Nuùt Distribute Horizontal Centers: Daøn ñeàu ngang theo 

taâm  

  + Nuùt Distribute Right  Edges: Daøn ñeàu theo bieân phaûi.  

TAÏO HÌNH THEÅ TÖØ PATH ÑÖÔÏC TOÂ MAØU 

  

 Tieáp theo baïn seõ duøng caùc coâng cuï taïo hình ñeå taïo caùc hình theå nhö 

Path.  

 Treân File aûnh hoaëc moät file môùi.  

 Choïn coâng cuï Ellip 

 Treân thanh tuøy choïn, baïn click choïn nuùt Create New Work Path 

 Nhaán giöõ Shift drag mouse ñeå taïo moät voøng troøn lôùn  

 Thanh tuøy choïn baïn choïn nuùt Exlude Overlapping  Shape Area vaø 

giöõ  Shift veõ tieáp moät voøng troøn beân trong voøng troøn thöù nhaát.  

Baïn choïn coâng cuï Selection Path Component ñeå di chuyeån voøng troøn hai 

truøng ñænh vôùi voøng troøn moät.  

Baïn coù theå vaøo Menu Edit / Free Transform Path vaø ñieàu chænh caùc tay 

naéém (Handle) cuûa hình bao ñeå ñieàu chænh kích côõ vaø hình daïng cuûa Path.  

 Choïn coâng cuï Path Component Selection giöõ  Shift Click choïn caû 

hai voøng troøn  

 Treân thanh tuøy choïn baïn click nuùt Combine ñeå keát hôïp hai Path hình 

troøn thaønh moät hình theå duy nhaát.  

 Choïn maøu Foreground tuøy yù  

 Trong hoäp Paths, Drag Work Path vöøa keát hôïp thaû vaøo nuùt Fill Path  

Width Foreground Color ôû cuoái baûng Path ñeå toâ maøu Foreground 

vöøa choïn cho ñoái töôïng Path  

   

TAÏO HÌNH THEÅ TUØY YÙ  

 

 Choïn coâng cuï Custom Shape treân thanh tuøy choïn, click vaøo nuùt muõi 

teân keá beân hoäp shape ñeå môû baûng Custom Shape  
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 Click vaøo nuùt ôû goùc treân beân phaûi baûng Custom Shape ñeå môû Menu 

thaû cuûa baûng. Choïn muïc Custom Shape, xuaát hieän hoäp nhaéc nhôû baïn 

choïn Append ñeå noái theâm caùc hình theå maáu vaøo baûng Custom Shape  

 

 

 

      

 

 Drag oâ tröôït treân baûng danh saùch thaû baïn choïn maãu hình theå tuøy yù  

 Nhaán giöõ Shift veõ theâm hình theå vöøa choïn vaøo beân trong cuûa Path 

hieân haønh (Work Path )  

 Duøng coâng cuï 

Path Component 

Selection ñeå ñieàu 

chænh laïi vò trí cuûa 

hình theå  

 Trong baûng layers, 

click choïn nuùt 

Create  a New 

Layers ôû beân döôùi 

hoäp ñeå taïo moät Layer môùi. Layer naøy seõ chöùa rieâng maãu hình theå baïn 

choïn vaø veõ ñeå deå daøng aùp duïng caùc hieäu öùng khaùc maø khoâng lieân quan 

ñeáân caùc hình theå khaùc.  

 ÔÛ baûng Paths, baïn click choïn Menu thaû ñeå toâ vieàn cho Path  cuûa baïn 

vôùi tuøy choïn  Stroke SubPath. 

 Baïn neân ñònh neùt coï Brush lôùn hoaëc nhoû ñeå toâ vieàn vaø maøu toâ vieàn 

tuøy thuoäc maøu Foreground  
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 Ñeå toâ maøu vôùi hieäu öùng noåi cho hình theå cuûa baïn, Double Click vaøo 

Layer hình theå muoán toâ ñeå môû hoäp thoaïi Layer Style  

 Hoäp Layers Style Click choïn Bevel and Emboss (vaùt caïnh vaø noåi) ñeå 

theå hieän hieäu öùng.  

 

   

 

 

 

TAÏO LAÏI  HÌNH THEÅ VECTOR BAÈNG ACTION VAØ STYLE 

 

 

 

 Söû duïng Action laø moät trong caùc caùch maø Photoshop duøng ñeå töï ñoäng 

hoaù coâng vieäc. Action laø taäp hôïp caùc leänh maø baïn coù theå aùp duïng töï 

ñoäng cho moät File hoaëc moät loaït file  

 Baïn söû duïng Action ñeå ghi trình dieãn laïi, chænh söûa vaø xoùa töøng 

Action rieâng bieät, ngoaøi ra coøn cho pheùp baïn löu, môû laïi caùc File 

Action. Môû  File aûnh môùi coù neàn traéng ñeå taïo moät hình theå  

 Menu Window / Show Action  

 Click vaøo nuùt Create New Set ñeå taïo moät Action môùi trong baûng 

Action. Hoäp thoaïi New Set, muïc Name baïn ñaët teân laø Action 1 vaø nhaäp 

Ok. 

 Ghi 1 Action môùi  

 Khi baïn taïo moät Action môùi caùc leänh vaø caùc coâng cuï söû duïng seõ ñöôïc 

töï ñoäng theâm vaøo Action cho ñeán khi baïn döøng vieäc ghi laïi, trong baûng 

Action, click choïn nuùt Create  New Action xuaát hieän hoäp thoaïi, hoäp 

thoaïi New Action, nhaäp teân cuûa Action laø � taïo logo� ôû hoäp Name click 

nuùt Record ñeå baét ñaàu ghi  

 Baây giôø quaù trình ghi ñöôïc baét ñaàu  
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 Trong baûng Layers , click nuùt Create a New Layers ñeå taïo moät 

Layer môùi  

 (Layer 1)  

 Choïn coâng cuï Custom Shape.  

 Thanh tuøy choïn click vaøo nuõi teân beân phaûi muïc Shape ñeå môû baûng 

Custom Shape  Picker vaø choïn maãu hình vöông nieäm  

 Giöõ Shift vaø drag mouse ñeå taïo hình treân File, duøng coâng cuï Move ñeå 

hieäu chænh vò trí tuøy yù  

 Trong baûng Layers choïn Layers 1, baïn click vaøo nuùt Add a Layer 

Style ôû cuoái baûng vaø choïn hieäu öùng  Bevel and Emboss töø Menu  thaû  

 Choïn coâng cuï Type, treân thanh tuøy choïn baïn choïn Font chöõ vaø kích 

côõ, choïn maøu trong oâ Set the text color .  

Nhaäp chuoãi vaên baûn � Warped Text � 

ÔÛ thanh tuøy choïn click choïn nuùt New Create Warped Text, choïn kieåu 

Shell Lower töø Menu Style nhaäp giaù tò ôû muïc Blend: + 25 giöõ nguyeân giaù 

trò 0 ôû caùc muïc khaùc  

 Vaên baûn cuûa baïn coù theå duøng coâng cuï Move ñeå di chuyeån vò trí vaên 

baûn tuøy yù  

 Baûng Style choïn maãu oâ noåi tuøy ñeå toâ cho chuoãi vaên baûn cuûa baïn  

 Baûng Actions Click nuùt Stop ñeå keát thuùc vieäc ghi Action .  

 File / Save löu laïi keát quûa vöøa thöïc hieän.  

  Söû duïng laïi Action vöøa taïo  

 Khi Action ñaõ ñöôïc ghi, baïn coù theå choïn noù trong baûng Action vaø 

duøng noù ñeå theå hieän laïi caùc taùc vuï moät caùch töï ñoäng  

                                      

       

 

 

      

 Môû moät File aûnh tuøy yù neáu muoán ñaët hình theå vöøa taïo ôû File tröôùc toâi 

vöøa höôùng daãn  
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 Trong baûng Action click choïn teân  � Action 1 � vaø Click nuùt Play ñeå 

thöïc hieän Action naøy  

 Hình theå seõ ñöôïc taïo laïi trong File aûnh naøy  
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NEÂN SÖÛ DUÏNG AÛNH RGB HAY CMYK  

 

Ngöôøi söû duïng Photoshop luoân ñaët ra laø neân laøm vieäc vôùi hoà sô RGB 

hay CMYK. Neáu keát quaû ñöôïc xuaát ra cho Slide hay Video neân chænh maøu 

trong RGB bôûi vì nhöõng Slide vaø Video duøng Mode  RGB color thay vì 

duøng CMYK. Khi xuaát cho nhöõng maùy In thöông maïi ñeå In baùo, neân chænh 

baèng maøu CMYK  nhö vaäy baïn seõ laøm vieäc cuøng vôùi maøu maø nhaø In söû 

duïng. Thaät höõu ích khi chænh maøu CMYK khi chænh vôùi nhöõng maøu ñen treân 

aûnh, baïn chæ caàn thay ñoåi maøu ñen trong hoà sô CMYK baèng caùch ñieàu chænh 

treân keânh (chanel) maøu ñen (trong RGB khoâng coù maøu ñen) Hoà sô CMYK 

luoân luoân hôn RGB .  

 

Trong photoshop coù nhieàu coâng cuï vaø leänh giuùp cho vieäc chænh söûa caùc aûnh chuïp 

  

 

 

Hue _ Saturation _ Brightness 
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 Caùc thuaät ngöõ naøy thöôøng ñöôïc söû duïng trong caùc chöông trình ñoà hoïa khi 

xöû  lí maøu.  

 Hue: laø maøu phaûn xaï laïi maét ngöôøi khi aùnh saùng chieáu treân moät ñoái töôïng, moät 

phaàn ñöôïc haáp thu vaø moät phaàn ñöôïc phaûn xaï laïi. Hue ñöôïc tính toaùn baèng 

caùch xaùc ñònh vò trí treân baùnh xe maøu chuaån (color whell) theo ñoä töø 0 -> 360 

ñoä. Hue ñöôïc nhaän bieát bôûi teân cuûa maøu nhö, maøu ñoû ,cam hoaëc xanh  

 Saturation (chroma) laø ñoä baõo hoøa (ñoä ñaäm ñaëc) cöôøng ñoä maøu  Saturation moâ 

taû söï töôi hoaëc nhaït cuûa Hue, noù ñöôïc tính toaùn theo phaàn traêm 0% -> 100%  

 Brightness : aûnh höôûng ñoä saùng  (Lightness) hoaëc ñoä ñaäm (drakness) cuûa maøu, 

ñöôïc ño baèng phaàn traêm 0% (ñen) ñeán 100% (traéng). Photoshop giuùp baïn chænh 

söûa aûnh, moät coâng vieäc maø tröôùc ñaây chæ daønh rieâng cho caùc chuyeân gia veà lónh 

vöïc naøy. Baïn seõ chuïp aûnh vaø queùt aûnh vaøo maùy tính vaø coù theå chænh söûa maøu 

saéc, saéc ñoä ñaäm nhaït cho aûnh, söï hoøa troän giöõa aûnh vaø moät böùc aûnh gheùp khaùc, 

ñeå taïo neân söï hoaøn myõ cho taùc phaåm cuûa baïn.  

 

Chuùng ta seõ baét tay vaøo vieäc chænh söûa aûnh vôùi caùc böôùc toång quaùt: 

   

 Kieåm tra chaát löôïng aûnh maø baïn Scan vaø ñònh ñoä phaân giaûi phuø hôïp vôùi aûnh seõ 

duïng  

 Xeùn aûnh vôùi kích thöôùc thaønh phaåm  

 Ñieàu chænh ñoä töông phaûn cho toaøn aûnh  

 Xoùa boû söï maát caân baèng maøu Color  

 Ñieàu chænh maøu  

 Khi söû duïng cho trang Web. In treân giaáy khaùc vôùi theå hieän treân maøn 

hình. Maøn hình maùy tính vaø trang In raát khaùc nhau döïa treân caùc ñaët ñieåm 

sau :  

 Maøn hình maùy tính naèm ngang, trong khi trang In thöôøng theo chieàu 

doïc. Ñieàu naøy seõ aûnh höôûng tôùi söï trình baøy vaø ñònh daïng trang cuûa 

baïn  

 Vaên baûn duø nhoû vaãn deã ñoïc hôn khi ñöôïc In treân giaáy vì caùc ñieåm 

möïc In vaãn saéc neùt hôn caùc ñieåm saùng treân maøn hình. Do ñoù baïn seõ 

khoâng nhìn thaáy caùc vaên baûn nhoû hoaëc caùc hình ñoà hoïa quaù chi tieát 

treân maøn hình  

 Maøn hình maùy tính coù kích côõ khaùc nhau, khi thieát keá ñeå In treân 

giaáy baïn caàn bieát kích côõ giaáy ñeå trình baøy phuø hôïp. 

  

Ñoä phaân giaûi vaø kích côõ aûnh  

Caùc loaïi ñoä phaân giaûi  



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

44 

 Soá pixel treân moät ñôn vò chieàu daøi cuûa aûnh ñöôïc goïi laø Image 

Resolution (ñoä phaân giaûi aûnh) thöôøng ñöôïc ño baèng soá pixel treân 1 inch 

(ppi). Aûnh coù ñoä phaân giaûi cao seõ coù nhieàu pixel hôn (dung löôïng file seõ > 

hôn) aûnh coù ñoä phaân giaûi thaáp maëc duø coù cuøng kích thöôùc.  

 Soá pixel treân 1 ñôn vò chieàu daøi goïi laø Monitor Resolution ñoä phaân 

giaûi maøn hình, thöôøng ñöôïc ño baèng soá ñieåm (dot) treân 1 inch (dpi) caùc 

pixel cuûa aûnh ñöôïc chuyeån tröïc tieáp thaønh caùc pixel cuûa maøn hình. Neáu ñoä 

phaân giaûi cuûa aûnh cao hôn ñoä phaân giaûi maøn hình, aûnh seõ theå hieän treân maøn 

hình lôùn hôn kích thöôùc ñöôïc In ra.  

 VD: Baïn theå hieän moät file aûnh 1.1 inch , 144ppi treân maøn hình 72 dpi 

aûnh seõ chieám moät vuøng 2.2 treân maøn hình. 

 

 Caùch söû duïng coâng cuï chænh söûa maøu  

  Coâng cuï chænh söûa maøu laøm vieäc döïa treân aùnh xaï caùc giaù trò cuûa 

phaïm vi toâng maøu hieän taïi sang giaù trò cuûa phaïm vi toâng maøu môùi.  

Ñieàu chænh maøu cho aûnh vôùi leän Curves. 

 

 

    Baïn söû duïng coâng cuï chænh maøu theo 3 caùch :  

AÙp duïng cho moät hoaëc nhieàu keânh (chanel) cho Layer ñieàu chænh hoaëc cho 

Layer bình thöôøng.  

Ñieàu chænh ñoä töông phaûn Contrast trong ñoù aùnh xaï caùc pixel toái nhaát sang 

maøu ñen vaø caùc pixel saùng nhaát sang maøu traéng.  

AÙnh xaï laøm cho phaàn saùng seõ saùng hôn vaø vuøng toái seõ ñaäm vaø saét neùt hôn, 

giuùp baïn hieäu chænh chaát löôïng aûnh chuïp.  

            

Di chuyeån ñoaïn 

thaúng sang vò trí 

tuyø yù vaø xem 

hieån thò maøu 
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THAY THEÁ MAØU TRONG AÛNH  

 Vôùi leänh Replace Color taïo caùc maët naï taïm thôøi döïa treân caùc maøu 

chæ ñònh roài thay theá caùc maøu naøy.  

 Caùc maët naï cho pheùp coâ laäp moät vuøng teân aûnh ñeå thay ñoåi taùc ñoäng 

leân vuøng ñöôïc löïa choïn. Caùc tuøy choïn trong hoäp Replace Color cho 

pheùp baïn ñieàu chænh  Hue (maøu) Saturation (ñoä baõo hoøa) vaø 

Lightness (löôïng maøu ñen traén)  

 Duøng coâng cuï Rectabgular Marquee darg mouse choïn vuøng hình chöõ 

nhaät quanh phaàn aûnh muoán thay theá maøu  

           Menu Image  /Adjust / Replace Color  

 

    

 

Tuøy choïn Select maëc ñònh ñöôïc choïn hoäp thoaïi Replace Color theå hieän moät 

hình chöõ nhaät maøu ñen ñeå ñaïi dieän cho vuøng choïn aûnh hieän haønh  

          Trong hoäp coù 3 coâng cuï hình oáng huùt  
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 Coâng cuï Eyedropper duøng ñeå choïn moät maøu ñôn (trong vuøng choïn) 

vaø thay theá baèng maøu môùi.  

 Coâng cuï Add To Sample coù hình daáu coäng duøng ñeå choïn theâm maøu.  

 Coâng cuï Subtract From Sample hình daáu tröø duøng ñeå bôùt maøu choïn.  

            Caùch thöïc hieän:  

 Choïn coâng cuï Eyedropper trong hoäp thoaïi Replace Color sau khi ñaõ 

choïn vuøng choïn aûnh muoán thay theá. 

 Click cong cuï moät laàn vaøo aûnh choïn (ñeå choïn moät maøu muoán thay 

theá).  

 Choïn coâng cuï Add To Sample, click vaø di chuyeån mouse treân caùc 

phaàn khaùc nhau cuaû oâ aûnh hieån thò trong hoäp thoaïi cho ñeán khi oâ aûnh 

coù maøu traéng  

 Ñieàu chænh dung sai cuûa maët naï baèng caùch di chuyeån thanh tröôït 

Furziness tôùi giaù trò tuøy yù. Furziness ñieàu khieån möùc ñoä lieân quan 

vôùi caùc maøu ñöôïc ñöa vaøo Mask (maët naï).  

 Choïn coâng cuï Subtrast From Sample, click vaøo phaàn maøu ñen xung 

quanh vuøng choïn trong hoäp Replace Color ñeå xoùa baát cöù veát môø maøu 

traéng naøo ôû phaàn maøu ñen.  

 Trong phaàn Transform cuûa hoäp thoaïi baïn drag con  tröôït Hue ñeán 

maøu tuøy yù. 

 Di chuyeån con tröôït Saturation ñeán giaù trò aâm ñeå giaûm cöôøng ñoä baõo 

hoøa giaù trò döông taêng cöôøng ñoä baõo hoøa, Drag tröôït Lightness ñeán 

giaù trò aâm ñeå giaûm ñoä saùng vaø döông ñeå taêng ñoä saùng (maøu seõ saäm 

hôn).  

 Nhaáp Ok ñeå hoaøn taát vieäc thay theá. 

 

Ñieàu chænh ñoä saùng vôùi coâng cuï Dodge  
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Ñieàu chænh ñoä baõo hoøa, cöôøng ñoä maøu (Saturation) vôùi coâng cuï  Sponge 

cho pheùp chænh söûa  Saturation raát tinh teá cho moät vuøng rieâng bieät tong aûnh.  

        Töø Menu Mode cuûa thanh tuøy choïn baïn choïn  Saturation.  

         Pressure:  xaùc laäp cöôøng ñoä cho Saturation töø  0% -> 100%  

         Brush: ñònh neùt coï cho coâng cuï tuøy theo vuøng aûnh muoán ñieàu chænh. 

Drag mouse caøng nhieàu cöôøng ñoä baõo hoøa caøng taêng.  

Baïn duøng phím ngoaëc môû vuoâng vaø ngoaëc ñoùng vuoâng ñeå taêng giaûm ñoä 

lôùn cuûa neùt buùt cho phuø hôïp vôùi aûnh.  

Xoùa boû caùc ñoái töôïng khoâng mong muoán trong aûnh.  

Ñoái vôùi nhöõng aûnh bò loãi vì kó thuaät hay nhöõng phaàn aûnh cuõ bò loám ñoám 

hö hoûng baïn coù theå duøng coâng cuï toâi saép giaûi thích döôùi ñaây ñeå thöïc hieän.  

Tuy nhieân ñeå thöïc hieän caùc thao taùc phuïc cheá aûnh coøn ñoøi hoûi ôû baïn söï 

kieân nhaãn, baïn phaûi laäp ñi laäp laïi coâng vieäc copy vuøng aûnh môùi ñeå copy cho 

vuøng aûnh hö cuõ cho ñeán khi hình aûnh ñeïp maét, khi ngöôøi khaùc nhìn vaøo aûnh 

seõ khoâng nhaän thaáy söï loõm choõm cuûa aûnh.  

Baïn coù theå xoùa boû caùc vuøng aûnh khoâng mong muoán tong aûnh baèng coâng 

cuï Clone Stamp, coâng cuï naøy seõ xoùa ñi vuøng aûnh baèng caùch  Clone (traùi 

laïi) sao cheùp moät vuøng aûnh khaùc treân aûnh vaø ñaët teân vuøng muoán loaïi tröø  

(khoâng phaùt sinh Layer) 

  

AÙp duïng boä loïc  Unsharp Mask  

Sau khi ñaõ thöïc hieän xong caùc böôùc hieäu chænh ôû treân, baïn duøng leänh  

Unsharp Mask trong Menu Fill ñeå ñieàu chænh ñoä töông phaûn cuûa bieân caùc 

chi tieát vaø laøm noåi baät roõ raøng hôn  

  Menu  Filter / Sharper / Unsharp Mask  

Trong hoäp thoaïi tuyø choïn Preview ñang choïn ñeå baïn thaáy ñöôïc keát quaû ôû 

caùc phaàn trong aûnh  
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 Amount: Ñònh giaù trò ñoä saéc neùt cho aûnh. 

 Radius: Xaùc ñònh pixel xung quanh caùc pixel bieân chòu aûnh höôûng taùc 

ñoäng laøm saét neùt. Vôùi aûnh coù ñoä phaân giaûi cao  Radius thöôøng naèm ôû 

phaïm vi töø 1 -> 2, aûnh thöïc haønh cuûa baïn neáu ôû ñoä phaân giaûi 72 dpi 

duøng Radius khoaûng 0.5 pixel  

 Threshold : xaùc ñònh möùc ñoä khaùc bieät veà ñoä neùt caàn phaûi coù cuûa 

pixel xung quanh moät vuøng tröôùt khi chuùng ñöôïc xem nhö laø Pixel bieân  

        Giaù trò  Threshold = 0 laøm saét neùt taát caû caùc Pixel trong aûnh  

  Laøm saéc neùt aûnh vôùi Unsharp Mask laøm saéc neùt ñöôøng bieân trong aûnh, söûa 

chöûa caùc choã nhoeø sinh ra khi chuïp aûnh, Scan aûnh Unsharp raát hieäu quaû cho 

vieäc chænh söûa chuaån bò cho aûnh In hoaëc xuaát tröïc tieáp treân maïng .  

Thöïc hieän thay ñoåi maøu vôùi Channel Mixer. 
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NHÖÕNG CAÂU HOÛI VAØ TRAÛ LÔØI THAM KHAÛO 

 

1.  Ñoä phaân giaûi coù yù nghóa gì? 

Thuaät ngöõ ñoä phaân giaûi (Resolusion) cho bieát soá pixel moâ taû vaø taïo neân caùc 

chi tieát cho aûnh. Coù ba loaïi ñoä phaân giaûi khaùc nhau: Ñoä phaân giaûi aûnh (ñôn 

vò ño laø soá pixel/inch-ppi), ñoä phaân giaûi maøn hình (soá ñieåm(dot)/inch-dpi), 

ñoä phaân giaûi maùy in hoaëc ñoä phaân giaûi keát xuaát (soá ñieåm möïc inkdot hoaëc 

lines/inch). 

2. Caùch ñieàu chænh phaïm vi toâng maøu ra sao? 

Baïn coù theå drag tam giaùc maøu ñen vaø roång ôû phía döôùi bieåu ñoà cuûa leänh 

Levels ñeå ñieàu chænh nôi baét ñaàu ñieåm toái nhaát vaø saùng nhaát cho aûnh vaø 

ñieàu naøy seõ môû roäng phaïm vi cuûa toâng maøu 

3. Laøm caùch naøo ñeå ñieàu chænh söï caân baèng maøu cho moät aûnh chuïp? 

Trong Photoshop baïn coù theå chænh söûa Color Cast (söï maát caân baèng) 

baèng layer ñieàu chænh Color Balance. Layer ñieàu chænh cho pheùp baïn 

thay ñoåi maøu cho aûnh ôû baát kyø thôøi ñieåm naøo baïn muoán, khoâng aûnh 

höôûng ñeán giaù trò goác cuûa caùc pixel. 

4. Saturation laø gì? 

Saturation laø ñoä baõo hoøa, cöôøng ñoäï maøu trong aûnh. Baïn coù theå taêng 

Saturation  cho moät vuøng ñöôïc choïn trong aûnh baèng coâng cuï Sponge 

5. Duøng boä loïc Unshap Mask coù taùc duïng gì cho moät file aûnh chuïp? 

Boä loïc Unshap Mask ñieàu chænh laïi ñoä töông phaûn taïi phaàn bieân cuûa caùc 

chi tieát trong aûnh laøm cho aûnh roõ neùt hôn. 

6. Hai caùch ñeå taïo aûnh trong Photoshop 
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 Coù theå taïo file aûnh tröïc tieáp trong Photoshop 

 Coù theå laáy aûnh baèng caùch Scanning (queùt aûnh chuïp), phim slice, 

capturing (caùt töø video), Import (nhaäp) caùc aûnh veõ töø caùc chöông trình 

veõ khaùc hay caäp nhaät  aûnh kyõ thuaät soá töø maùy aûnh kyõ thuaät soá hoaëc ñònh 

daïng aûnh Kodak photo CD. 

7. Thuaän lôïi gì khi söû duïng layer? 

Caùc Layer cho pheùp chænh söûa töøng phaàn cuûa file aûnh treân moãi layer 

rieâng bieät 

8. Khi ñaõ hoaøn taát coâng vieäc, laøm theá naøo ñeå giaûm dung löôïng file? 

Baïn coù theå Flatter file, taát caû caùc layer seõ ñöôïc  hôïp nhaát (merge) thaønh 

moät Layer backgroud duy nhaát 

9. Phöông thöùc phoái troän maøu (Blending Mode) laø gì? 

Blending Mode seõ ñieàu khieån caùc pixel trong aûnh chòu taùc ñoäng bôûi caùc 

coâng cuï hoaëc caùc layer khaùc nhau. 

Caàn löu yù: 

 Maøu cô sôû (Base Color) maøu goác cuûa aûnh 

 Maøu phoái troän (Blend color) maøu ñöôïc aùp duïng vôùi caùc coâng cuï toâ veõ vaø 

chænh  

 Maøu keát quaû (Result color) maøu sau khi phoái troäân. 
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I . Filter Artistic 

1. Colored Pencil : 

  Laøm cho aûnh hay phaàn ñöôïc choïn gioáng nhö phaàn ñöôïc veõ 

baèng chì phaán  

Trò Pencil Width: Kieåm soaùt kích thöôùc maøu Background xuaát hieän 

treân aûnh Outline trò = 1 aûnh khoâng thay ñoåi maáy vaø xuaát hieän nhöõng 

vaïch chæ ñònh toái thieåu laø 3  

Trò Stoke Pressure:  

  Toái ña 15 nhöõng vuøng nhaát goác seõ ñöôïc daønh rieâng  

Trò paper Brihtness: 

 Baèng 0 : Laøm cho giaáy maøu ñen  

 Baèng 50 : Laáy maøu Background trong oâ tool box 

 Baèng 25 : Hoøa troän hai maøu ñen va Background 

2 . Cutout : 

 Laøm taêng cöôøng cho leänh Posterize chæ ñònh möùc ñoä nhöõng 

maøu treân aûnh theo yeâu caàu. Nhöõng Filter söû duïng nhöõng maøu treân aûnh 

goác thay vì nhö leänh Posterize ñöôïc tieán haønh. Filter naøy khaù thoâng 

minh laøm cho coâng vieäc trôû neân ñôùn giaûn. Noù chaïy khaù chaäm vì phaûi 

tính toaùn maät ñoä Pixel cho aûnh. 

 Trò Edge Simplicity :  

 Cao vieàn seõ ñôn giaûn hoùa nhö khoâng coù vieàn seõ taïo neân moät 

khoái maøu ñoàng nhaát. Neân ñònh khoaûng 5. 

3 . Dry Brush : 

 Vôùi kyõ thuaät coï khoâng caàn sôn nhöng vaãn keùo treân neùt veõ. Trò 

Image Detail baèng 10 seõ nhaän moät keát quaû thaät dòu nhö tranh sôn daàu  

 Chæ ñònh  Brush Size = 10 image Detail = 10 vaø Texture = 3 seõ 

thaáy moät aûnh vôùi moät neùt coï raát dòu vaø tröøu töôïng  

4 . Film Grain: 

 Laø moät daïng noise keát hôïp ñeû laøm cho saùng hôn  caø caùc phaàn 

treân aûnh seõ saéc neùt hôn, Fiter Add Noise coù theå xoùa moät aûnh vôùi caùc 

laám chaám Filter naøy söû duïng toát cho Text, vôùi nhöõng chæ ñònh thaáp seõ 

khoâng chòu aûnh höôûng. Chæ ñònh trò cao seõ cho moät maøu ñeïp maét  
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Trò Highlight Area: Töø 1 � 20 quaûn lyù vuøng saùng  

5. Freseo : 

 Taïo söï töông phaûn maûnh lieät treân aûnh, vuøng saäm seõ saäm hôn. 

Laøm aûnh haáp daãn vì noù taïo ñoä saéc neùt cho nhöõng vuøng töông phaûn, maøu 

saéc röïc rô.õ  

6 . Neon Glow :  

 Tuøy thuoäc vaøo maøu ñöôïc choïn, neáu böùc aûnh coù maøu 

Foreground hay Background laø ñen traéng, aûnh seõ coù daïng Grayscale vôùi 

nhöõng haøo quang  ñaây laø Fiter coù maøu ñoäc laäp . 

 Maøu laù xanh döông saùng (Bright Blue) cho oâ color trò 

Brightness laø 50 size=24 vuøng saäm nhaát hieån thò maøu cuûa oâ trong color, 

vuøng saùng seõ hieån thò maøu cuûa Foreground vuøng trung gian hieån thò 

maøu pha troän cuûa Foreground vaø Background.  

 Trò Brightness laø 50 size=24 vuøng maøu nhaït hieån thò maøu 

Background, vuøng saùng hieän thò maøu Foreground, vuøng trung gian hieån 

thò  maøu pha troän cuûa Foreground vaø Background. 

 

 

7 . Paint Daubs :  

  Laøm aûnh trôû thaønh böùc veõ daïng sôn daàu chæ ñònh loaïi coï trong 

muïc  Brush Type seõ cho aûnh nhieàu keát quaû khaù ñaët bieät.  

8. Paltter Knife: 

 Gioáng böùc veõ daïng sôn daàu ñöôïc veõ baèng dao. Laøm cho moãi 

neùt veõ gioáng nhö coù moät boùng. Vuøng boùng saäm  nhaát seõ trôû thaønh  maøu 
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ñen vaø aûnh nhö coù veû ñaït ñöôïc cheá ñoä thaém maøu, Filter naøy taêng cöôøng 

nhöõng neùt veõ vaø gaây raát aán töôïng coù theå duøng phoái hôïp vôùi Filter Boss 

ñeå taêng cöôøng ñoä noåi cuûa neùt coï. 

 Trò Stioke Detail: Quaûn lyù neùt veõ  

 Trò laø 3 seõ cho böùc veõ haáp daãn hôn  

 Trò Softness: Quaûn lyù ñoä gaõy khuùc cuûa neùt veõ treân vieàn  

9 . Plastic Wrap : 

Cho böùc aûnh nhö ñöôïc veõ treân taám Plastic vaø nhöõng oâ gheá noåi 

treân laøm cho aûnh troâng laï maét Filter naøy chaïy theo vieàn cuûa 

aûnh thay vì ñaûo ngöôïc  

 Trò Detail: Quyeát ñònh phaàn töû noåi treân aûnh  

 Trò Smoothness : Quaûn lyù ñoä daøy cuûa taám Plastic  

10 . Poster Edges : 

 Taïo cho aûnh baèng maøu cuûa chính noù vaø ñöa theâm nhöõng chi 

tieát maøu ñen quanh caùc vieàn  

 Trò Edge Intensity: Quaûn lyù soá löôïng nhöõng vieàn chæ ñinh 0 coù 

yù nghóa chæ yeâu caàu quaûn lyù caùc vuøng saäm chính yeáu nhö nhöõng boùng 

xung quanh caùc ñoái töôïng, chæ ñinh 10 seõ nhaän ñöôïc taát caû caùc vieàn. Chæ 

ñònh thaáp thì chæ nhöõng vieàn roõ neùt hoaëc rieâng reõ môùi ñöôïc choïn . 

11 . Rought Pastels: 

 Taùc ñoäng leân aûnh nhö nhöõng maáu Texture taïo saún giuùp taêng 

cöôøng nhöõõng ñöôøng keû ñôn 

giaûn khi duøng treân Text. Gioáng 

nhö ñöôïc toâ baèng nhöõng chaám 

nhoû vaø vöøa. Thoâng soá trong oâ 

Texture cho ra voâ soá maãu vaø 

nhieàu keát quaû khaùc nhau. 

12 . Smudge Stick: 

 Tieán haønh gioáng nhö duøng 

moät mieáng vaûi chuøi leân aûnh, 

laøm môø ñi neùt phaán hay neùt 

chì. AÛnh troâng gioáng nhö bò 

buïi.  

13. Sponge: 

 Nhö duøng mieáng boït bieån 

(Sponge) voã nheï vaøo aûnh noù 

nhö coù nhöõng veät sôn ñöoäc vaåy 

ñeàu leân aûnh  
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 Trò Brush Size: Quaûn lyù beà roäng cuûa Sponge 

 Trò Denfinition: Cao seõ cho ra nhöõng veät maøu ñaäm hôn maøu 

cuûa aûnh goác  

 Trò Smoothness: Quaûn lyù ñoä gaõy khuùc cuûa vieàn, trò thaáp taïo 

nhieàu neùt gaõy khuùc . 

 

14. Under Painting: 

 Taïo böùc aûnh nhö böùùc aûnh vöøa môùi veõ xong conø öôùt sôn . 

 Trò Brush Size lôùn vuøng bao phuû bôûi neùt coï seõ khoâng hieån thò 

Texture, vuøng naøy seõ coù laám chaám. 

 Trò Texture Coverage vaø Brush thaáp cho gôïn soùng   

15. Water Color: 

 Tìm nhöõng hình vaø maøu ñôn giaûn, taïo moät daõy trò cho nhöõng 

ñoái töôïng  theo phöông phaùp giaûm caùc maøu töø moät aûnh chuïp thaønh aûnh 

veõ. Nhöõng vuøng saäm treân aûnh thöôøng laøm ñaäm nhieàu vaø toâ maøu trôû neân 

cöïc maïnh Filter naøy laøm vieäc  raát naëng neà. 

 

 

 

II. Nhoùm Filter Blur: 

 Söõ duïng ñeå laøm dòu caùc aûnh khi maø vieàn cuûa noù bò saéc neùt vaø 

ñoä töông phaûn cao. Noù seõ laáy ñi nhöõng Pixel treân vieàn coù ñoä töông 

phaûn. Filter naøy cuõng ñeå laøm nhoøe phaàn neàn cuûa aûnh, nhö vaäy maøu cuûa 

Foreground seõ ôû ngoaøi hay taïo moät aûnh höôûng boùng môø khaù dòu. 

1 Blur:  

Taïo aûnh höôûng nhoøe, coù theå laøm giaûm ñoä töông phaûn vaø noù 

loïai tröø nhöõng veät laám chaám  

2 Blur More:   

 Thöïc hieän nhoøe gaáp 3-4 laàn Blur  

3 Gassian Blur:  

Cho pheùp quaûn lyù aûnh höôûng nhoøe taïo vieàn aûnh dòu (nheï 

nhaøng) cho ñeán vieàn daøy nhoøe maø aûnh coù theå nhaän ñöôïc. Trò 

cao ñoä nhoøe nhieàu. Duøng loïai boû nhöõng loám ñoám trong aûnh 

Scan 

4 Motion Blur:  

Taïo caùc chuyeån ñoäng aûo. Thöïc hieän nhö aûnh cuûa maùy chuïp aûnh 

khi chuïp moät ñoái töôïng di chuyeån vôùi toác ñoä môû oáng kính quùa 

laâu. Cho pheùp chæ ñònh höôùng vaø ñoä daøi cuûa aûnh aûo.  
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5 Radial Blur:  

 Taïo böùc aûnh nhö bò xoaùy theo hình troøn hay ñöôïc  phoùng töø taâm 

cuûa hình troøn. 

 

         

 

III. Nhoùm Filter Pixelate 

 Phaù vôû hình aûnh thaønh nhieàu maûnh, nhöõng maûnh naøy laø nhöõng 

khoái vuoâng . 

1Color Halfton:  

Nhö taïo nhöõng chaám Halfton lôùn, Photoshop taïo aûnh höôûng naøy 

baèng caùch chia aûnh thaønh nhöõng oâ hình chöõ nhaät vaø töøng oâ vôùi 

nhöõng Pixel töông töï  

2  Crystallize:  

Laøm aûnh saéc neùt baèng caùch boû nhöõng Pixel ñoâng maøu theo 

nhöõng pixel ñöôøng cheùo goùc kích thöôùc ñöôøng cheùo ñöôïc quaûn 

lyù baèng Trò oâ Cell Size  

3 Facet :  

Taïo böùc aûnh nhö ñöôïc veõ tay, ñöôïc nhöõng pixel gioáng nhau hay 

cuøng maøu vaøo moät nhoùm hay thaønh moät khoái . 

4 Fragment :  

Taïo moät böùc aûnh nhö  khoâng chuïp ñuùng tieâu ñieåm Coppy pixel 

leân 4 laàn, sau ñoù bình quaân nhöõng pixel ñöôïc nhaân leân vaø ñaët 

chuùng vaøo nhau  

5 Mezzotint :  

 Taïo aûnh döôùi daïng laám chaám.  

6 Mosaic : 

 Gioáng nhö nhöõng hoa vaên treân thaûm len.  

7 Pointillize :  

Taùch aûnh thaønh nhöõng chaám moät caùch ngaãu nhieân gioáng nhö 

veõ aûnh baèng moät soá ñieåm. 
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IV. Nhoùm Filter Distort  

 Thöôøng söû duïng ñeå taïo nhöõng bieán daïng  

1 Displace : 

Nhuõng pixel aûnh bò loïc vaø chuyeån ñeán höôùng khaùc Trò thaáp, 

maøu saäm seõ chuyeån dòch xuoáng vaø qua phaûi. Trò trung gian 128 

laøm cho vieäc chuyeån dòch raát nhoû. Trò cao (maøu saùng) seõ 

chuyeån nhöõng pixel leân treân vaø qua beân traùi  

2 Pinch :  

 Duøng ñeå uoán naén hình vaøo trong hay ra ngoaøi  

3 Polar Coordinates  
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Chuyeån hình chöõ nhaät sang daïng ñöôøng cong vaø hình cong, hình troøn 

sang hình chöõ nhaät thöïc hieän laøm cong troøn chuoãi chöõ khi choïn daïng 

Polar to Rectangular hoaëc choïn daïng ngöôïc laïi Rectangular to Polar  

4 Ripple : 

Chuyeån hình aûnh baèng caùch thay theá nhöõng pixel taïo neân ñoä 

duùm hay gôïn  soùng . 

 

5 Shear : 

Uoán hình aûnh thaønh nhöõng ñöôøng cong töông öùng, aûnh höôûng 

filter naøy coù theå keùo daøi ñoái töôïng. Neáu baïn thöïc hieän uoán 

cong chuoãi kyù töï tröôùc khi thöïc hieän baïn xoay chuoãi chöõ theo 

chieàu doïc.  
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Hoäp Shear, click vaø drag mouse treân truïc doïc cuûa kyù töï seõ ñöôïc 

uoán cong theo ñöôøng cong thaønh laäp. Nhaáp nuùt Reset ñeå trôû laïi 

vò trí ñaàu  

6 Spherize :  

Chuyeån phaàn choïn löïa thaønh hình quaû caàu hay laøm ñoái töôïng 

phoàng leân hoaëc loõm vaøo  

7 Twirl :  

 Taïo aûnh höôûng  xoaùy  

8 Wave : 

 Taïo aûnh höôûng gôïn soùng. 

Number of Generator: Kieåm soaùt soá löôïng voøng soùng caøng 

nhieàu soùng ñöôïc taïo ñoä bieán daïng caøng nhieàu bôûi vì ñænh vaø beà 

saâu cuûa ñoä daõi soùng seõ baét ñaàu töøng phaàn caøng gaây nhieàu söï 

taøn phaù treân aûnh  

 Tuøy choïn: Wrap Round aûnh ñöôïc cuoán ôû chieàu ngöôïc laïi treân 

maøn hình  

 Repeat Edge Pixel seõ xoùa nhöõng pixel thöøa treân vieàn aûnh  

 

9  Zigzag : 

 Taïo gôïn soùng laên taên nhö khi thaû moät vieân soûi xuoáng ao  

10 Diffuse Glow : 
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Theâm hay bôùt nhöõng chi tieát taïo nhöõng haøo quang cho vuøng 

saùng. Vôùi trò thaáp toaøn boä aûnh seõ ñöôïc thay theá baêng maøu 

Background. Trò cao nhaát aûnh seõ bò bieán daïng. 

11 Glass : 

AÛnh nhö nhìn qua moät taám göông loaïi oâ vuoâng nhoû. Trò 

Smoothness thaáp, aûnh seõ xuaát hieän laám chaám khoù nhaän daïng 

aûnh. Trò cao caùc soùng trong oâ kính seõ giaûm bôùt laøm cho aûnh coù 

veû sinh ñoäng hôn. 

12 Ocean Ripple  

  Taïo aûnh nhö chìm trong nöôùc  

 Ripple Size: Quaûn lyù kcíh thöôùc cuûa laøn soùng. 

 

VI. Nhoùm filter sketch. 

1. Bas Retief :  

 

Ñôn giaûn hoùa nhöõng hình aûnh phöùc taïp vaø laøm noåi baät nhöõng 

hình aûnh veõ ñôn giaûn trong ñoà hoïa. Filter naøy taïo moät aûnh giaûm 

bôùt chi tieát, phaàn lôùn seõ taïo aûnh nhö daïng noåi (Emboss). Maøu 

Foreground seõ ñöôïc choïn cho vuøng saùng vaø maøu cuûa 

Background seõ söû duïng cho nhöõng vuøng boùng môø. Vì vaäy khi 

choïn nhöõng maøu saéc quaù maïnh hay khoâng thöïc seõ laøm cho aûnh 

coù veû mô hoà vaø roái loaïn.  

2. Charcoal: 
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Taïo böùc aûnh nhö veõ baèng than chì. Chæ söû duïng maøu ñen hoaëc 

traéng, noù taïo cho aûnh nhö moät baûn  veõ ôû daïng phaùc thaûo. Ngoaøi 

ra coøn giuùp laøm nhöõng böùc aûnh phöùc taïp thaønh nhöõng böùc veõ 

ñôn giaûn. 

3. Chalk And Charcoal: 

AÛnh höôûng cuûa caû hai loaïi phaán chì vaø than chì treân aûnh. Chalk 

chæ söû duïng maøu Background vaø Charcoal söû duïng maøu 

Foreground. Maøu ñen traéng vaãn laø hai maøu toát nhaát trong 

nhöõng maøu ñöôïc choïn. 

4. Chrome: 

Giuùp laøm noåi nhöõng hình veõ ñôn giaûn trong ñoà hoïa. Chrome 

chuyeån aûnh thaønh daïng Grayscale nhö bò phaûn aùnh vôùi nhöõng 

nguoàn saùng  

5. Conte crayon: 

Laøm ñoân giaûn nhöõng hình aûnh phöùc taïp khi noù khoâng coù 

Texture. Noù seõ laøm vieäc khaù toát treân nhöõng vuøng aûnh coù nhöõng 

töông phaûn roõ reät giöõa saùng vaø toái  

6. Graphic Pen: 

Traû laïi cho aûnh nhöõng hình veõ gioáng nhö daïng phaùc thaûo baèng 

caùc neùt veõ daøi hay ngaén tuøy thuoäc vaøo chæ ñònh. Chæ ñònh Stroce 

Length thaáp treân aûnh seõ theå hieän nhöõng laám chaám chöù khoâng 

phaûi nhöõng vaïch ngaén  

7. Halftone Pattern:  

Thay ñoåi nhöõng aûnh Bitmap sang daïng Halftone loaïi Circle 

Pattern noù veõ nhöõng voøng troøn ñoàng taâm treân aûnh. Neân choïn 

maøu saäm cho Foreground, neáu choïn hai maøu traéng cho 

Foreground vaø maøu ñen cho Background  hình aûnh seõ ñöôïc gaùn 

Filter Halfton Pattern seõ gioáng nhö phim aâm baûn Nagative 

8. Note Paper: 
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Ñôn giaûn hoùa nhöõng hình aûnh phöùc taïp ñoàng thôøi laøm noåi baät 

caùc hình aûnh  ñoà hoïa daïng Line Art. 

 

VII. Filter Stylize: 

 Taïo nhöõng aán töôïng nhö hình veõ. 

1. Diffuse: 

 Laøm aûnh vôõ ra nhö ñöôïc xuyeân qua moät maûnh kính ñoùng baêng.  

2.  Emboss: 

Taïo ra vieàn saùng noåi leân vaø giaûm nhöõng trò maøu xung quanh 

gioáng nhö taïo moät hình ñaép noåi. Tyû leä Amount thaáp, löôïng maøu 

ít, tyû leä cao nhieàu maøu seõ ñöôïc gaùn cho vieàn. 

3. Extrude 
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Chuyeån aûnh thaønh moät loaït khoái ba chieàu hay daïng hình kim töï 

thaùp.  

Trò trong oâ Size chæ ñònh kích côõ caùc khoái hay caùc hình (2 -> 

255).  

Trò Depth quaûn lyù töøng ñoái töôïng seõ ñöôïc phoùng ra.  

Trò Random neáu muoán beà saâu cuûa töøng ñoái töôïng phoùng ra moät 

trò ngaåu nhieân.  

Trò Level Based neáu muoán phaàn aùnh saùng  hôn cuûa aûnh nhoâ ra 

nhieâu hôn phaàn saäm.  

Trò Solid Font Faces beà maët cuûa khoái seõ toâ baèng coù trò trung 

bình cuûa ñoái töôïng, khoâng phaûi maøu trung bình toøan aûnh choïn 

Mask Incomplete Block ñeå ñaûm baûo nhöõng ñoái töôïng phoùng ra 

ñöôïc toâ maøu. 

4. Find Edges: 

Tìm nhöõng vuøng maøu chính yeáu treân aûnh, thay ñoåi vaø taêng 

cöôøng chuyeån ñoåi caùc Pixel. Taïo cho böùc aûnh gioáng nhö ñöôïc 

phaùt thaûo baèng buùt chì caùc neùt chính  

5. Trace Contour: 

Veõ nhöõng ñöôøng vieàn maûnh hôn naèm xung quanh, ñoàng thôøi 

cho pheùp chæ ñònh toâng maøu cho vuøng chuyeån ñoåi  

6. Solarize: 
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Thöïc hieän nhöõng aûnh höôûng cuûa döông baûn (Positive) hay aâm 

baûn (Negative) pha troän treân beà maët aûnh  

7. Tiles: 

 

    

 
 
 Chia aûnh thaønh töøng maûnh nhö ngoùi lôïp  

Number of Tiles ñöa soá löôïng toái thieåu cuûa haøng vaø coät.  

   Maximum Offset kieåm xoaùt khoaûng caùch tính baèng tæ leä cuûa 

töøng vieân ngoùi.  

 Neáu muoán khoûang caùch töøng vieân ngoùi toâ maøu ta choïn maøu cho 

Background tröôùc khi thöïc hieän boä loïc naøy. 

Choïn Inverse Image seõ ñaûo maøu cuûa aønh goác xuaát hieän quanh nhöõng 

maûnh ngoùi. 

8. Wind 

 Taïo gioù thoåi baèng caùch ñöa nhöõng ñöôøng keû haøng ngang  nhoû vaøo aûnh  

 Choïn Wind: Cho pheùp choïn gioù maõnh vaø höôùng gioù  
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 Blast: Choïn gioù maïnh, ñöôøng keû daøy . 

Stagger: Taïo gioù vôùi caùc ñöôøng keû ñaët lung tung.  

Left vaø Right ñeå ñònh höôùng gioù.  

 

9. Glowing Edges: 

 Töï ñoäng tìm vieàn vaø ñoåi. Coù theå choïn côû vieàn vaø soá löôïng vieàn 

tìm thaáy Trò Smoothness Cao seõ thaáy ít vieàn hôn, nhö vaäy vieàn 

daøi hôn vaø ít gaõy khuùc hôn  

 10. Craqualure: 

Taïo nhöõng texture khaù ñeïp treân nhöõng vuøng troáng cuûa aûnh. Trò 

Crack Brightness cao seõ laøm maát ñi caùc veát nöùt. 

 11. Grain :  

  Taïo nhöõng laám chaám cho aûnh  
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 Duøng maøu Foreground vaø Background ñeå taïo haït. 

 

12. Mosaic Tiles :  

 

  

Taïo nhöõng oâ vuoâng baát ñònh ôû nhöõng khoaûng caùch ñeàu ñaën 

Trò Tile Size thaáp cuõng taïo keát quaû höõu ích.  

Trò Tile Size cao aûnh seõ raát khaùc laï 
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13. Paterwork : 

 Taïo hình klhaù ñôn ñieäu troâng seõ phaúng hôn  

14. Stained Glass : 

 Taïo hình theå keát tinh vôùi nhöõng ñöôøng raûnh noåi baät  

15. Texture : 

 Taïo phaàn noåi vaø nhöõng ñieåm goà gheà cho aûnh  

VIII. Nhoùm Render 

 

 

Söû duïng boä loïc Render ñeå taïo hieäu öùng chieáu saùng. 

Baïn coù theå tuyø choïn vò trí ñaët ñoùm saùng baèng caùch click vaøo muïc Flare 

Center. 
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VII. NhoùmVideo: 

 Duøng cho hình aûnh qua Video hay nhaäp töø baêng  

  NTSC color: Giaûm soá maøu cho aûnh ñeå maøn hình TV coù theå 

hieån thò ñöôïc  

 Deinterlace: Xoùa nhöõng ñöôøng keû ñan xeùo nhau trong aûnh 

Video.  

 Khaù caàn thieát khi Scan moät aûnh nhoøe. 

 

 

Boä nhôù Ram (Random Acess Memory) 

 Neáu kkhoâng ñuû Ram cho coâng vieäc cuûa chöông trình Photoshop, 

chöông trình seõ söû duïng nhöõng khoaûng troáng treân ñóa cöùng ñeå söû duïng 

nhö Ram neân goïi laø vuøng nhôù aûo (Virtural Memory). Trong chöông 

trình Photoshop duøng ñóa cöùng laøm vuøng nhôù aûo ñöôïc goïi laø Scratch 

Disk. Toác doä truy xuaát cuûa ñóa cöùng tính baèng Milisecond (ms), ñóa 

cöùng 10 ms seõ ñoïc nhanh hôn 20 ms . 

- Ñóa cöùng thaùo rôøi (Removable Hard Disk) 

Loaïi ñóa cöùng naøy dung löôïng töø 44MB ñeán 270 MB  

- Neùn hoà sô: 

 PKZIP:Neùn hoà sô ñöôïc choïn  

 STACKER: Töï ñoäng neùn caùc hoà sô treân ñóa cöùng  

 JPEG: Deã maát döõ lieäu 

 LWZ: Ñaùng tin caäy. 

- Maøn hình maøu thích hôïp cho Photoshop 

 Loaïi maøn hình  

 Apple, NEC, Super Mac, Radius, Raster OpsSony.  

Maøn hình 14 inch. Ñoä phaân giaûi 640 x 480 

Maøn hình 19 inch . Ñoä phaân giaûi 1024 x768 pixel 

- Card Video: 

Bit laø phaàn töû nhoû nhaát ñeå thaønh laäp döõ lieäu. Moãi bit coù 2 vò theá taét môû. 

Toång soá keát hôïp cuûa 8 bit chia thaønh  
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 8 bit cho maøu ñoû (256 Saéc ñoû) 

 8 bit cho maøu xanh Blue (256 Saéc xanh) 

 8 bit cho maøu xanh Green (256 Saéc xanh) 

256 x256 x256 = 16,777,216 (16,7 trieäu maøu) 

Card 24 bit coù theå ñuû cho maøn hình 14 inch thöïc hieän 16,7 trieäu maøu. 

Nhöng khoâng ñuû thöïc hieän vôùi maøn hình 19 inch. 

 

 

 

Taïo bieân cho hieäu öùng 

Baïn coù theå dung moät vaøi kyõ thuaät xöû lí bieân cho phaàn aûnh ñöôïc aùp 

duïng hieäu öùng. Khi baïn aùp duïng moät boä loïc thoâng thöôøng ñeå laïi moät 

bieân raát deå nhaän thaáy. Baïn haõy taïo moät bieân meàm hoaëc môø baêng boä 

Feather chobieân roài môùi aùp duïng boä loïc. Taïo moät hieäu öùng trong 

suoát, aùp duïng boä loïc, aùp duïng leänh Fade ñeå hieäh chænh cheá ñoä phoái 

hôïp maøu Blending color vaø ñoä môø ñuïc Opacity cuûa vuøng choïn. 

 

 AÙp duïng boä loïc cho layers. 

Baïn coù theå aùp duïng boä loïc cho layer hoaëc cho vaøi layers ñeå taïo neân 

hieäu öùng. Ñeå boä loïc coù taùc duïng treân 

Layer  thì Layer ñoù phaûi ñang hieån thò (coù bieåu töôïng con maét keá 

beân noù trong baûng layer) vaø phaûi chöùa caùc pixel. 

 

AÙp duïng boä loïc cho töøng keânh (Chanel) 

Baïn coù theå aùp duïng boä loäc cho töøng keânh, aùp duïng boä loïc khaùc nhau 

cho moãi keânh maøu hay aùp duïng cuøng moät boä loïc vôùi caùc xaùc laäp khaùc 

nhau. 

 

Taïo Neàn 

Baèng caùch aùp duøng hieäu öùng cho moät hình daïng coù maøu ñaëc hay maøu 

xaùm baïn coù theå taïo ra neàn vaø caùc daïng neàn Texture ngaãu nhieân khaùc 

nhau. Maëc duø coù vaøi boä loïc taùc duïng hay khoâng thay ñoåi gì khi noù 

ñöôïc aùp duïng cho moät maøu ñaëc chaúng haïn nhö boä loïc Glass. 

 

Keát hôïp nhieàu hieäu öùng vôùi caùc maët naï hay caùc aûnh ñaõ sao cheùp 

Baïn söû duïng caùc maët naï ñeå taïo vuøng choïn, cho pheùp baïn ñieàu khieån 

söø chuyeån tieáp töø hieäu öùng naøy sang hieäu öùng khaùc. 
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Caûi thieän chaát löông vaø ñoä ñoàng nhaát cuûa aûnh. 

Baïn che daáu nhöõng phaàn aûnh noåi, bieán ñoåi hay naâng cao chaát löôïng 

cuûa noù. Hoaëc laø moät loaït aûnh hình gioáng nhau baèng caùch aùp duïng 

cuøng moät boä loïc cho moãi aûnh. Duøng baûng Action ñeå ghi laïi quaù trình 

xöû lyù cho  moät aûnh vaø duøng noù cho caùc aûnh khaùc. 

 

Toái öu aûnh cho web 

Photoshop vaø Image Ready cho pheùp toái öu söï theå hieän cuûa aûnh vaø 

dung löôïng file aûnh cho pheùp xuaát baûn aán phaåm treân web. Caàn dung 

löôïng file nhoû ñeå coù theå môû noù töø web (Web server) vôùi moät  khoûang 

thôøi gian hôïp lyù nhöng noù phaûi ñöû lôùn ñeå hieän chính xaùc maøu vaø chi 

tieát treân aûnh. 

Image Ready cho pheùp baïn söû duïng aûnh nhö moät aùnh xaï, taïo caùc nuùt 

ñeå chuyeån tôùi caùc ñòa chæ khaùc töø caùc aûnh naøy. 

Toái öu aûnh file JPEG vaø GIF ñieàu chænh vaø xaùc laàp toái öu ñeå taïo söï 

töông quan giöõa dung löôïng file vaø chaát löôïng aûnh. 

Photoshop vaø Image Ready cho pheùp caùc ñieàu khieån neùn dung löôïng aûnh 

ñoàng thôøi vôùi vieäc toái öu chaát löôïng theå 

 hieän cuûa aûnh treân maøn hình. Caùc tuøy choïn neùn khaùc nhau tuøy theo caùc ñònh 

daïng ñöôïc duøng khi löu aûnh. 

 

Ñònh daïng JPEG: 

Ñöôïc thieát keá ñeå giöõ phaïm vi maøu roäng vaø giöõ ñöôïc ñoä saùng tinh teá 

cho aûnh coù toâng maøu lieân tuïc nhö caùc aûnh chuïp, aûnh coù  maøu chuyeån 

tieáp. 

 Ñònh daïng naøy coù theå theå hieän vôùi haøng trieäu maøu. 

 

Ñònh daïng GIF: 

Coù taùc duïng neùn caùc aûnh coù caùc maûng maøu ñaëc vaø aûnh coù vuøng maøu 

laëp laïi nhö caùc neùt veõ. Ñònh daïng naøy söû duïng baèng maøu coù theå tôøi 

256 maøu cho vieäc theå hieän aûnh vaø coù hoå trôï neàn trong suoát. 

 

Ñònh daïng PNG: 

Coù taùc duïng neùn caùc aûnh coù caùc maûng maøu ñaëc vaø giöû ñöôïc ñoä saéc 

neùt chi tieát. Ñònh daïng -8 duøng baûng maøu 256 maøu ñeå theå hieän aûnh. 

 Ñònh daïng -24 hoå trôï 24 bit maøu (16.777.216 maøu). Maëc duø vaäy 

nhieàu trình duyeät Web khoâng hoå trôï caùc file PNG. 
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Neùn aûnh Web 

Dung löôïng file laø moät ñieàu raát quan troïng trong xuaát baûn ñieän töû neân 

file phaûi neùn tuyeät ñoái. 

Hai ñònh daïng JPEG vaø GIF cuõng bao goàm caùc chöùc naêng neùn töï 

ñoäng. 

 Hai kieåu neùn cô baûn laø hai kieåu neùn gaây söï suy giaûm vaø neùn khoâng 

gaây söï suy giaûm. 

Kieåu neùn gaây söï suy giaûm seõ laøm maát döõ lieäu ñeå file coù dung löôïng nhoû 

hôn. Kieåu neùn khoâng gaây söï suy giaûm khoâng boû maát chi tieát nhöng chuùng 

tìm caùch ñònh nghóa aûnh coù hieäu quaû hôn. 

 

Caùc loaïi neùn thoâng thöôøng laø: LZW,  ZIP, CCITT, JPEG,  

Caùc phaàn meàm ñieän töû seõ söû duïng baát cöù loaïi naøo toát nhaát cho aûnh.  

Chæ coù loaïi JPEG hoå trôï kieåu neùn suy giaûm vaø cho pheùp choïn moät caáp 

ñoä neùn maø baïn coù theå ñieàu chænh chính xaùc möùc ñoä thay ñoåi dung 

löôïng file.  

Ñònh daïng naøy vôùi möùc ñoän neùn thaáp seõ cho keát quaû gaàn gioáng aûnh 

goác, ñònh daïng JPEG vôùi möùc ñoä neùn trung bình seõ boû bôùt nhöõng chi 

tieát ñöôïc theå hieän roõ treân maøn hình, ñònh daïng JPEG vôùi möùc ñoä neùn 

cao coù khuynh höôùng laøm nhoeø aûnh vaø maát ñi chi tieát nhöng mang laïi 

keát quaû chaáp nhaän ñöôïc cuøng vôùi dung löôïng file aûnh nhoû. 

Quaù trình neùn khoâng laøm giaûm ñoä phaân giaûi, noù chæ coù taùc duïng laøm 

dung löôïng file nhoû hôn.  

Vieäc neùn file cho baïn caùc aûnh coù ñoä phaân giaûi cao vaø noù coù theå in ra 

vôùi chaát löôïng khaù nhöng dung löôïng khoâng quaù lôùn. Vieäc neùn file 

khoâng bao giôø thay theá cho vieäc löu giöõ cho caùc file coù ñoä phaân giaûi 

vaø chaát löông cao. 

 

 Xaùc ñònh phaàn trong suoát cuûa neàn cho trang WEB 

Söï trong suoát cuûa neàn cho pheùp baïn ñaët moät aûnh coù bieân khoâng laø 

hình chöõ nhaät leân treân neàn cuûa trang WEB. Taát caû caùc phaàn beân 

ngoaøi cuûa ñoái töôïng aûnh ñöôïc ñònh nghóa laø trong suoát, cho pheùp 

troâng thaáy maøu neân cuûa trang  Web, baïn coù theå duøng phaàn trong suoát 

cuûa neàn cho aûnh GIF vaø PNG, caùc ñònh daïng naøy löu giöõ ñöôïc caùc 

pixel trong suoát cuûa aûnh.  

Nhöõng pixel naøy seõ phoái troän vôùi neàn cuûa trang Web trong trình 

duyeät. 
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 Neàn vôùi maøu Matte (maøu thay theá cho phaàn trong suoát) ñöôïc hoå trôï 

bôûi ñònh daïng GIF, PNG, JPEG giaû laäp phaàn trong suoát baèng caùch toâ 

hay phoái troän vôùi caùc pixel trong suoát baèng maøu matte. 

Maøu matte laø maøu do baïn choïn ñeå phuø hôïp vôùi maøu cuûa trang Web 

maø aûnh ñöôïc ñaët leân. Baïn coù theå taïo ra moät neàn trong suoát baèng caùch 

taïo ra moät layer môùi. 

 Taïo neàn vôùi maøu Matte cho aûnh GIF vaø JPEG  

 Khi ñaõ bieát ñöôïc maøu neàn cuûa trang Web maø aûnh seõ ñöôïc ñaët vaøo, 

baïn coù theå duøng Matte ñeå toâ vaø phoái troän vôùi caùc pixel trong suoát vôùi maøu 

Matte ñeå phuø hôïp vôùi neàn cuûa trang Web. 

Ñeå coù keát quaû toát neân trang Web thöôøng coù maøu ñoàng nhaát ( solid color) 

chöù khoâng phaûi laø maãu toâ nhieàu maøu. 
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Chöông naøy seõ cung caáp cho baïn baûn ñoà chæ ñöôøng ñeán moät soá ñaëc 

tính maïnh hôn. Moät trong nhöõng nguyeân nhaân kieán baïn yeâu thiùch 

Photoshop laø vì giao dieän cuaû noù raát roõ raøng. Tuy nhieân cuõng coù nhieàu 

ngöôøi cho raèng khoâng ñoïc taøi lieäu hoã trôï cuõng gioáng nhö ngöôøi saép khôûi 

haønh moät chuyeán ñi xa maø khoâng coù baûn ñoà chæ ñöôøng. 

Chöông naøy seõ cung caáp cho baïn nhöõng ñaëc tính töôûng chöøng nhö mô hoà 

nhöng cöïc kyø maïnh meõ, bao goàm caùc phaàn sau: 

 Coâng cuï Smudge vôùi caùc tuyø choïn 

 Laøm môø maãu keát caáu vôùi coâng cuï Burn. 

 Toâ veõ baèng coâng cuï Clone. 

 Taïo maãu keát caáu phöùc taïp thoâng qua phaân hình. 

Vaán ñeà duy nhaát laø veõ baèng mouse chaúng khaùc gì veõ baèng hoøn ñaù cuoäi. Baát 

kyø moät hoaï syõ naøo neáu buoäc phaûi hoïc veõ baèng ñaù cuoäi thì neáu kieân trì moät 

chuùt thì seõ thaønh coâng thoâi. Baûng veõ trong photoshop giuùp taïo ñöôøng neùt 

mòn hôn nhieàu, noù goùp phaàn laøm cho quaù trình toâ veõ baèng kyõ thuaät soá töï 

nhieân hôn nhieàu. 

 

1.  Coâng cuï Smudge vôùi caùc tuyø choïn 

Coâng cuï naøy theå hieän caûm xuùc töï nhieân vaø mang tính nhôn baûn cao, 

giuùp hoaït ñoäng toâ veõ baèng ñieåm aûnh ñaït ñöôïc keát quaû thuù vò hôn. Coâng cuï 

Smudge cho pheùp troän, xoaù, vaø thaäm chí coù theå toâ leân nhöõng vuøng veõ voán 

raát khoù hoaëc khoâng theå toâ veõ baèng phöông phaùp truyeàn thoáng.  

Duøng coâng cuï Smudge coù bieåu töôïng ngoùn tay troû trong hoäp coâng cuï. 

Theo maëc ñònh, Coâng cuï smudge ñöôïc aán ñònh ôû cheá ñoä Normal, cheá ñoä 

naøy cho pheùp keùo hoaëc ñaåy ñieåm aûnh naèm ngay beân döôùi coâng cuï khi baïn 

nhaáp giöõ mouse. Xaùc laäp normal laøm vieäc chaúng cheâ vaøo ñaâu caû nhöng ñoâi 

kho baïn muoán khoáng cheá khaû naêng cuûa coâng cuï naøy. Khi baïn nhaáp ñuùp leân 

bieåu töôïng  Palette Smudge tool option môû ra. 
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Taïi ñaây baïn coù theå choïn nhieàu tuyø choïn  nhö: Normal, Darken, Lighten, 

Hue, Saturation, color, Luminosity. Neáu böùc hình phaùt thaûo cuaû baïn laø aûnh 

traéng ñen thì tuyø choïn Hue, Saturation, color, Luminosity khoâng khaû duïng 

trong vuøng choïn naøy.  

Thöû nghieâm vôùi Smudge baïn coù theå kieåm soaùt nhöõng vuøng cuï theå trong aùnh 

xaï aûnh. Coù theå öùng duïng coâng cuï Smudge töông töï nhö coï veõ, nhöng thoâng 

qua moät vaøi tuyø choïn khaû duïng, baïn coù theå taïo hieàu hieäu öùng khoù loøng 

töôûng töôïng vôùi coï veõ thoâng thöôøng voán khoâng phaûi laø coâng cuï kyõ thuaät soá 

coù theå taïo ñöôïc  

 

2.  Laøm môø maãu hoaï tieát baèng coâng cuï Burn 

Coâng cuï Burn laáy teân töø thuaät nhieáp aûnh coå ñieån. Trong thuaät nhieáp 

aûnh neáu muoán laøm saäm maøu vuøng aûnh cuï theå naøo, baïn phaûi phôi vuøng ñoù 

laâu hôn trong phoøng toái. Thoâng thöôøng, baïn thöïc hieän baèng caùch khoeùt moät 

loã treân giaáy cöùng roài so leân vuøng giaáy in cuoái cuøng maø baïn muoán laøm saãm 

maøu trong khi phôi aûnh. Photoshop goùp phaàn laøm cho quaù trình naøy deã thöïc 

hieän hôn ñoâi chuùt bôûi leõ baïn coù theå toâ veõ chæ trong vuøng caàn laøm saäm maøu 

baèng coâng cuï Burn. Tuy nhieân, ñöøng cho raèng coâng cuï Burn chæ laøm moät 

coâng cuï taïo neân vuøng toái maø thoâi. Khi laøm vieäc vôùi aûnh maøu, coâng cuï burn 

coøn laøm cho maøu saéc baõo hoøa hôn taïi nôi baïn ñang öùng duïng coâng cuï naøy. 

  Môû moät file aûnh tuyø yù 

 Nhaáp ñuùp leân coâng cuï Burn ñeå môû hoäp Option. 

 

 

 

 Xaùc laäp cho coâng cuï: Midtone, Exposure, Diameter, Hardness, 

Spacing, Angle vaø Roundness. 

 Drag mouse treân vuøng aûnh muoán thöïc hieän laøm toái 

Söû duïng coâng cuï naøy laø phöông phaùp lyù töôûng ñeå ñieåm theâm lôùp buïi môø 

cho töôøng voâi, vaûi voùc, taøu vuõ truï, haàu nhö baát cöù ñoái töôïng naøo baïn muoán 

aùp duïng bieán theå maøu hoãn hôïp. 

 

3.  Caùch taïo maãu Pattern 

Veõ vuøng choïn treân aûnh muoán laøm maãu Pattern baèng coäng cuï choïn hình chöõ 

nhaät, muïc Feather cuaû coâng cuï naøy phaûi baèng 0, leänh taïo Pattern môùi ñöôïc 

thöïc hieän. 
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Menu Edit / Define Pattern 

 

 

Ñaët teân cho maãu tuyø yù 

Treân vuøng choïn khaùc (layer môùi hay moät file môùi muoán taïo hieäu öùng maãu 

toâ neàn. 

Menu Edit /Fill 

Choïn pattern trong muïc Use. Nhaáp Ok 

 

4.  Toâ veõ baèng coâng cuï Clone Stamp 

Coâng cuï Clone Stamp khoâng nhöõng tieát kieäm ñöôïc thôøi gian, maø coøn 

ruùt ngaén hoaït ñoäng p ñi laëp laïi. 

 Choïn coâng cuï Clone, giöõ phím Alt, nhaáp vaøo phaàn aûnh baïn muoán 

copy löu tröõ vaøo boä nhôù cuûa coâng cuï clone. 

 Sang vò trí khaùc baïn muoán thöïc hieän toâ veõ laïi maãu copy vöøa löu tröõ, 

baïn chæ drag mouse laø ñöôïc. 

 

 

Phaàn vöøa ñöôïc 

toâ veõ laïi 
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5.  Taïo maãu hoaït tieát phöùc taïp baèng phaân hình 

Maëc duø boä loïc Clouds raát lyù töôûng trong vieäc taïo maây cho maãu hoaï 

tieát, nhöng thöïc teá noù coøn raát höuõ duïng. Boä loïc Clouds coù lôïi nhaát cho vieäc 

taïo maãu hoaï tieát phaân hình coù theå duøng laøm cô sôû ñeå aùp duïng nhöõng hieäu 

öùng boä loïc khaùc hình thaønh neân nöôùc, ñaù, buïi, gæ saéc vaø haàu nhö baát kyø maãu 

hoaï tieát naøo toàn taïi treân ñôøi.  

 

 

6.  Chi phoái hieäu öùng phaân hình 

Caùch thöïc hieän 

 Taïo moät taäp tin môùi vôùi kích thöôùc 400 x 400 pixel, coù maøu traéng cho 

Backgroud 

 Nhaán phím Ñoái töôïng treân baøn phím ñeå trôû veà maøu maëc ñònh. Neáu 

Backgroud cuaû baïn ñang laø maøu ñoû thì maây cuûa baïn seõ mang maøu ñoû. Baét 

ñaàu laøm vieäc vôùi maøu ñen traéng roài ñieàu chæh maøu hình aûnh sau ñoù seõ ñôn 

giaûn hôn. 

Choïn Menu Filter / choïn Render / choïn Clouds, taïo maãu phaân hình 

daïng maây. 

Ñeå kieåm soaùt quaù trình hình thaønhcaùc maãu phaân hình ban ñaàu, haõy 

duøng maøu trong lôùp Foregroud vaø söû duïng hieäu öùng trong Filter / Render / 

Difference Clouds, nhaäp thoâng soá maøu baïn muoán choïn. 

Choïn Menu Image / Adjustment / Hue- Saturation, keùo thanh tröôït 

ñeå thay ñoåi giaù trò aùnh xaï aûnh. 

Söû duïng phaân hình laø giaûi phaùp lyù töôûng ñeå boá trí aûnh neàn voán coù theå 

thay ñoåi thoâng qua nhieàu hieäu öùng xöû lyù aûnh cuûa photoshop.  

 Duøng nhöõng phaân hình hình thaønh aùnh xaï aûnh troâng nhö aûnh chuïp 

Duøng maãu phaân hình vöøa thöïc hieän ôû treân laøm hình aûnh cô sôû taïo 

maãu hình ñaù vôõ vuïn töïa nhö aûnh chuïp. 

Choïn Filter / Stylize / Find Edges. Boä loïc naøy laøm cho aûnh troâng 

gioáng nhö loâng hay toùc. 

Choïn Menu Image / Adjustment / Brightness( -2)- Contrast( +95). 

Laøm aûnh ñöôïc taåy saïch hôn moät chuùt. 
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Choïn Filter  / Noise / Add Noise, aán ñònh Amount laø 45, nhaáp choïn 

uniform, choïn oâ Monochromatic. 

Choïn Filter / Texture / Craquelure, aán ñònh Spacing laø 8, Crack 

Depth laø 3, vaø Crack Brightness laø 3. 

Choïn laïi mode maøu laø RGB. 

Menu Image / Adjustment / Hue- Saturation, thöïc hieän chænh laïi 

maøu laàn cuoái 

  Hue: 32, Saturation: 40, Lightness: -50. 

 

7.  Kyõ thuaät hieäu chænh ñaëc bieät 

Bôûi vì haàu nhö baïn ñeàu raát thích taïo maãu phaân hình 3D, neân maùy 

queùt aûnh laø moät trong nhöõng coâng cuï höõu duïng nhaát baïn caàn phaûi coù 

Maùy queùt cho pheùp baïn ñöa hình töø theá giôùi hieän thöïc vaøo maùy vi 

tính vaø aùp duïng aûnh ñöôïc queùt treân ñoái töôïng 3D baát kyø naøo baïn muoán. 

Ñaây cuõng laø moät vaán ñeà quan troïng lieân quan ñeán maùy queùt vaø söï hoã 

trôï voâ giaù maø chuùng mang ñeán khi baïn taïo aûnh ngheä thuaät hoaëc hoaït hình 

3D. 

YÙù nghiaõ cuaû vieäc duøng maùy queùt khoâng heà giaûm suùt, ñaëc bieät neáu 

baïn caàn taïo aùnh xaï aûnh thöïc trong moät khoûng thôøi gian cöïc ngaén, 

Maùy queùt coù muoân hình vaïn traïng vaø nhieàu gía caû khaùc nhau. Maùy 

queùt khaùc nhau chuû yeáu laø soá löôïng ñieåm aûnh maø chuùng coù theå öùc tính. 

Maùy queùt ñeå baøn phoå bieán nhaát coù hình daïng nhö maùy sao chuïp trong 

ñoù khoaûn muïc ñöôïc queùt coá ñònh treân taám kính trong khi queùt ñaàu queùt di 

chuyeån beân döôùi khoaûn muïc. Maùy queùt haøng ñaàu laø maùy queùt kieåu troáng. 

Loaïi ñöôøng vieàn naøy giaù raát ñaét nhöng cung caáp ñoä phaân giaûi cao nhaát 

trong taát caû caùc loaïi maùy queùt. 

 

8.  Ñoä phaân giaûi quang (Optical resolusion) 

Ñoä phaân giaûi quang cuûa maùy queùt ñònh soá löôïng ñieåm aûnh maùy thöïc 

söï nhìn thaáy. Ví duï maùy queùt saøn phaúng söû duïng ñaàu queùt 300 boä caûm bieán/ 

inch, vì theá coù theå laáy thöû maãu 300 dpi ôû moät höôùng. Ñeå queùt theo höôùng 

khaùc, maùy di chuyeån ñaàu queùt doïc theo trng giaáy, döøng 300 laàn / inch, vì 

vaäy maùu cuõng coù theå queùt 300 dpi ôû höôùng khaùc. Ñöøng quaù quan taâm ñeán 

soá lieäu naøy maø queân raèng ñieàu quan troïng thaät söï laø soá löôïng nhoû nhaát 

trong löôùi. 

9.  Ñoä phaân giaûi noäi suy (Interpolated Resolusion).  

Khaùc vôùi Ñoä phaân giaûi quang hoïc, tính soá löôïng ñieåm aûnh coù theå nhìn 

thaáy, Ñoä phaân giaûi noäi suy tính soá löôïng ñieåm aûnh queùt coù theå ñoaùn bieát. 
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Qua quaù trình ñöôïc goïi laø noät suy, maùy queùt bieán laàn queùt 300 x 30 dpi 

thaønh laàn queùt 600 x600 dpi baèng caùch cheøn ñieån aûnh môùi vaøo giöõa caùc 

ñieåm aûnh cuõ, ñoàng thôøi ñoaùn tröôùc ñöôïc laàn ñoïc aùnh saùng naøo noù seõ laáy thöû 

maãu taïi veät maøu noù ñi qua. Cuï theå hôn maùy queùt cheøn giaù trò vaøo giöõa döïa 

treân maøu cuûa hai ñieåm aûnh keá caän. Keát quaû hieám khi thoaû ñaùng neân traùnh 

duøng quaù trình noäi suy. 

Khi döï ñònh mua mayù queùt baïn caàn löu yù giaù tieàn taêng theo ñoä phaân giaûi. 

Neáu muoán queùt hình aûnh voán seõ xuaát hieän baûn in, baïn caàn ñeán maùy queùt coù 

ñoä phaân giaûi khaù cao (khoaûng 600x1200dpi). 

 

10.  Caùc loaïi aùnh xaï hình aûnh  

Caùch toát nhaát ñeå taïo aûnh 3D gioáng aûnh chuïp laø söû duïng phöông phaùp 

aùnh xaï aûnh. Khoâng ít ngöôøi ñaõ thöû taïo maãu hoaï tieát döïa vaøo thuû tuïc, nhöng 

keát quaû vaãn khoâng khaùc xa chaát löôïng maø hoaï syõ veõ ñöôøng vieàn hoaï tieát 

baèng phöông phaùp thuû coâng ñaït ñöôïc. 

AÙnh xaï aûnh maøu ñoäc laäp thöôøng khoâng thöïc laém. Chöông trình öùng 

duïng boå sung thuoäc tính hình theå khaùc, nhö ñöôøng vieàn phaûn quang, aùnh xaï 

khuyeát taùn, aùnh xaï loài loõm, phaûn chieáu vaø phaùt saùng baét buoäc coù ñeå taïo 

hình theå 3D troâng gioáng nhö aûnh cuïp thöïc söï. 

 

11.  AÙnh xaï aûnh maøu  

Thoâng thöôøng, hoaï syõ 3D seõ taïo aùnh xaï maøu vaø goïi noù döøng taïi ñieåm 

ñoù. Giaû söû nhö ñoái töôïng ñöôïc quan saùt töø xa, söû duïng chì aùnh xaï maøu thì 

khoâng thaønh vaán ñeà. Tuy nhieân, neáu ñoái töôïng hay nhaân vaät quaù noåi baät thì 

tính thöïc hieän cuaû noù nhanh choùng maát ñi khi baïn di chuyeån ñeán gaàn. Cuõng 

töông töï nhö nhieàu loaïi hình ngheä thuaät khaùc, ñoái töôïng 3D döïa treân tö 

töôûng hoaøi nghi. 

AÙnh xaï maøu (Color map) chöùa taát caû thoâng tin maøu daønh cho moâ hình 

nhö baïn döï ñoaùn. Bôûi maøu saéc coù söùc maïnh taâm lyù raát lôùn, neân aùnh xaï maøu 

thu huùt nhieàu söï chuù yù. Daãu sao baïn cuõng neân traùnh ñöa ñoä boùng hay vuøng 

toái naøo vaøo aùnh xaï maøu. 

Ñeå hoaït ñoäng thieát laäp hình theå trôû neân deã daøng hôn, toát nhaát neân baét 

ñaàu töø moät maøu ñôn leõ vaø noåi baät. Maøu naøy hoaït ñoäng ôû daïng toâng maøu cô 

sôû maø baïn laøm vieäc treân ñoù- chuaån bò böùc veõ cho taùc phaåm ngheä thuaät. Sau 

khi tìm xong maøu chính, nhôù ghi nhaän giaù trò RGB cuaû noù. Maøu cô sôû naøy 

seõ laø maøu chính ñoái vôùi taát caû aùnh xaï maøu daønh cho moãi phaân muïc noái keát 

vôùi noù.  

Vôùi phöông phaùp ñôn giaûn naøy, baïn coù theå traùnh ñöôïc nhöõng ñieåm 

tieáp giaùp maøu do söï khaùc bieät maøu taïo neân trong aùnh xaï maøu trong aûnh. 
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Maëc duø khoâng neân toâ veõ caùc saéc thaùi maøu nhö vuøng toái beân döôùi muõi 

nhaân vaät hình thaønh töø vuøng toái vaø vuøng saùng trong aùnh xaï maøu, nhöng 

naâng caáp chi tieát nhö meùp gaáp, loã chaân loâng, neáp nhaên vaø ñöôøng cong coù 

theå raát höõu duïng. Nhöõng chi tieát nhoû beù naøy, ñích thöïc laø keát quaû cuûa vuøng 

toái, ñoâi khi caàn trôï giuùp nhieàu hôn caû nhöõng gì aùnh xaï loài loõm coù theå cung 

caáp ñöôïc.  

Moät trong nhöõng lôïi ích cuaû vieäc daëm theâm chi tieát nhoû naøy laø ñeán 

luùc taïo aùnh xaï loài loõm, baïn coù theå nhôn baûn aùnh xaï maøu roài taùi söû duïng chi 

tieát ñoù maø khoâng phaûi toâ veõ laïi laàn nöõa. 

 

12. AÙnh xaï loài loõm 

AÙnh xaï loài loõm (Bump map) coù gí trò raát lôùn khi baïn taïo hình aûnh 

troâng nhö aûnh chuïp. AÙnh xaï loài loõm khaù lyù töôûng cho vieäc taïo maãu tieát da, 

veát nhaên, veát roå, seïo vaø nhieàu thuoäc tính hình theå nhoû nhaén ñaùng tin caäy 

voán raát khoù hoaëc raát maät thôøi gian laäp kieåu hình. 

Maëc duø aùnh xaï loài loõm khoâng thaät söï thay ñoåi hình theå cuaû moâ hình, 

nhöng chuùng khieán aùnh saùng phaûn öùng laïi hình theå moâ hình nhö theå chính 

aùnh xaï thay ñoåi. 

Nguyeân taéc aån sau aùnh xaï loài loõm khaù ñôn giaûn: vuøng toái cuaû aùnh xaï 

baèng ñoä cao thaáp, coøn vuøng saùng baèng ñoä cao cao � maøu ñen thaáp nhaát vaø 

maøu traéng cao nhaát. 

Menu Image / Adjustment / Hue- Saturation 

Tröôït thanh tröôït ñeán 100 cho Saturation. 

 

 

 

13. AÙnh xaï phaûn quang 
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AÙnh xaï phaûn quang (Specularity map) baùo cho hình theå bieát thaønh 

phaàn naøo saùng vaø thaønh phaàn naøo môø ñuïc. AÙnh xaï phaûn quang töông töï nhö 

aùnh xaï loài loõm trong ñoù aùnh xaï thöôøng laø aûnh grayscale.  

Khoâng phaûi vuøng da naøo cuûa nhaân vaät cuõng ñeàu ñaùp laïi aùnh saùng 

theo caùch thöùc ñoàng loaït gioáng nhau. Ngay caû nhöõng nhaân vaät bieån cuõng coù 

thaønh phaàn da toái saùng khaùc nhau. So saùnh giöõa vaây caù vaø vaûy caù cuõng ñuû 

bieát ñöôïc. Ñoái vôùi maët ngöôøi thöôøng vuøng traùn vaø muõi seõ saùng hôn bôûi 

nhöõng vuøng naøy thöôøng thaûi ra chaát nhôøn vaø moà hoâi hôn laø vuøng tai.  

Coù moät nguyeân taéc khaù hay baïn caàn tuaân thuû laø khi baïn quyeát ñònh 

chieáu saùng cho moät vuøng cuï theå, ñoù laø caân nhaéc hình theå ñoù khoâ cöùng nhö 

theá naøo. Phaân töû neùn chaët ñeán ñoä naøo ñeå hình thaønh hình theå ñoù? Ví duï so 

saùnh moùng tay vaø da cuaû mu baøn tay baïn. Da seõ meàm hôn vaø ñen hôn nhieàu 

(khoâng coù nhieàu tia saùng töø vaät theå da), coøn moùng tay coù ñoä cöùng neân noù 

saùng hôn. 

 

14. AÙnh xaï khuyeát taùn 

 Taïi sao aùnh xaï khuyeát taùn laïi khoù hieåu nhaät trong caùc loaïi aùnh xaï? 

Ñoù laø do aùnh xaï raát khoù ñònh nghiaõ. Khoâng coù ñònh nghiaõ roõ raøng veà chöùc 

naêng aùnh xaï thì vieäc thöû nghieäm cuõng trôû neân khoù khaên bôûi baïn khoâng theå 

naém chaéc phöông thöùc aùnh xaï thi haønh coâng vieäc. 

Cöù cho raèng aùnh saùng laø thaønh phaàn ma thuaät mang mau saéc ñeán cho 

ñoái töôïng. Aùnh saùng chieáu xuoáng nhaân vaät cuaû baïn noù haéc vaøo hình theå 

nhaân vaät, nhöng maøu saéc cuaû nhaân vaät khoâng phaûn xaï troïn veïn trôû laïi ngöôøi 

xem. 

 Haàu heát moïi ñoái töôïng ñeài coù khuyeát taùn. Göông soi coù 0% khuyeát 

taùn, keát quaû laø khoâng maøu saéc naøo cuaû göông phaûn xaï laïi phía ngöôøi xem. 

Nöôùc sôn töôøng phaúng coù khoaûng 98% khuyeát taùn. Da cuaû ñoäng vaät coù vuù 

treân caïn coù khoaûng 90% khuyeát taùn. Khi aùnh saùng chieáu vaøo da nhaân vaät, 

haàu heát maøu cuaû noù ñeàu truyeàn ngöôïc heát cho ngöôøi xem, nhöng 10% coøn 

laïi thì khoâng. 

 

15. AÙnh xaï trong suoát 

AÙnh xaï trong suoát (transparency map) hay coøn goò laø aùnh xaï caét xeùn. Cung 

caáp moät phöông caùch huyû boû hình daïng maø thöïc teá khoâng caàn thieát laïi mo 

hình. AÙnh xaï trong suoát cho pheùp bieán caùc vuøng treân moâ hình 3D thaønh 

trong suoát hoaëc baùn trong suoát thoâng qua aûnh grayscale. Trong haàu heát 

chöông trình 3D, aùnh xaï traéng khoâng taïo ñöôïc vuøng ñoái töôïng 3D trong suoát 

trong khi aùnh xaï aûnh ñen hoaøn toaøn laïi trôû neân trong suoát tuyeät ñoái hoaëc cuï 
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theå hôn. Vôùi nhieàu saéc ñoä xaùm khaùc nhau, baïn coù theå laøm cho caùc vuøng cuûa 

ñoái töôïng trôû thaønh nöûa trong suoát. 

 

16. AÙnh xaï phaùt saùng 

AÙnh xaï phaùt saùng (Luminosity map) cung caáp phöông thöùc truyeàn 

aùnh saùng ñeán ñoái töôïng raát lyù töôûng khi ñaët aùnh saùng vaät lyù leân ñoái töôïng 

3D, thaønh phaàn maøu ñen cuaû aùnh xaï khoâng cung caáp aùnh saùng, vuøng saùng 

hôn seõ taïo aùnh saùng. 
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Thieát keá trang Web vôùi chöông trình Photoshop vaø ImageReady. 

 

Khi thieát keá trang Web vôùi chöông trình Photoshop vaø ImageReady 

haõy ghi nhôù caùc coâng cuï vaø caùc tính naêng coù saün trong moãi trình öùng duïng. 

ImageReady ñöôïc thieát keá cho caùch trình baøy caùc trang Web. Baïn coù theå 

laøm vieäc vôùi caùc lôùp nhö theå laø ñoái töôïng ñoäc laäp: löïa choïn, gom nhoùm, 

canh chænh vaø saép xeáp chuùng. Ngoaøi ra ñöôøng vieàn coøn coù caùc coâng cuï vaø 

caùc palette daønh cho vieäc xöû lyù Web cao caáp vaø taïo ra caùc aûnh Web ñoäng 

nhö hoaït hình. 

Thieát keá trang 

  Trong ImageReady caùc kích côõ taøi lieäu ñöôïc xaùc laäp saün cho trang vaø 

caùc bieåu ngöõ, caùc löôùi, caùc ñöôøng höôùng daãn, vaø caùc smart guides ñôn giaûn 

hoaù vieäc trình baøy trang. Caû Photoshop vaø ImageReady cho pheùp baïn ñöa 

noäi dung vaøo trong caùc kieåu trình baøy baèng caùch söû duïng Text, coâng cuï veõ 

vaø coâng cuï toâ. Trong ImageReady, baïn coù theå saép xeáp vaø canh chænh noäi 

dung baèng caùch söû duïng caùc lôùp, caùc taäp hôïp layer vaø caùc lôùp ñöôïc gom 

nhoùm. 

Slices 

Khi boá cuïc trang cuûa baïn ñaõ saün saøng ñeå xuaát sang web, caû 

photoshop vaø ImageReady ñeàu cung caáp coâng cuï Slice ñeå cho pheùp phaân 

chia kieåu trình baøy trang hoaëc caùc aûnh phöùc taïp thaønh caùc vuøng vaø xaùc ñònh 

caùc xuaát hieän xaùc laäp neùn ñoäc laäp vaø kích côõ file nhoû hôn. 

 

 

Taïo vaø xem caùc Slice  

Moät Slice laø moät hình chöõ nhaät cuûa moät aûnh maø baïn coù theå söû duïng 

ñeå taïo ra caùc lieân keát, caùc hieäu öùng Rollover, vaø caùc hoaït hình trong trang 

Web. Vieäc phaân chia caùc Slice seõ cho pheùp baïn ñieàu khieån vaø toái öu hoaù 

kích côõ file cuaû aûnh. 
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Baïn coù theå söû duïng caùc slice ñeå chia moät aûnh nguoàn thaønh caùc vuøng 

hoaït ñoäng. Khi baïn ñoàng thôøi löu aûnh vaø moät file HTML, moãi Slice ñöôïc 

löu döôùi daïng file ñoäc laäp cuøng vôùi caù xaùc laäp rieâng vaø baûng maøu, caùc lieân 

keát thích hôïp, caùc hieäu öùng Rollover, vaø caùc hieäu öùng ñoäng ñöôïc duy trì. 

Caùc slice cuõng raát coù ích trong khi laøm vieäc vôùi caùc aûnh voán chöùa caùc 

loaïi döõ lieäu khaùc nhau. Chaúng haïnh nhö  moät vuøng cuaû moät aûnh caàn ñöôïc 

toái öu hoaù daïng GIF ñeå hoã trôï aûnh ñoäng,  nhö ng phaàn caøo laïi cuaû böùc aûnh 

ñöôïc toái öu hoaù toát hôn ôû daïng JPEG, baïn coù theå taùch moät aûnh ñoäng baèng 

vieäc söû duïng moät Slice. 

Caùc loaïi Slice 

Ñeå taïo moät Slice töø ñöôøng daãn 

 Theâm caùc ñöôøng daãn vaøo moät aûnh 

 Thöïc hieän moät trong caùc ñieàu sau: 

 Trong  photoshop, choïn coâng cuï Slice, vaø nhaáp vaøo Slice From Giuders 

trong thanh Option. 

 Trong ImageReady choïn coâng cuï Slice, vaø nhaáp vaøo Create From 

Giuders trong thanh menu. 

Ñeå taïo moät Slice töø vuøng choïn 

 Choïn moät phaàn cuaû aûnh 

 Choïn menu Select / Choïn  Creat Slice from Selection. 

Image Ready taïo moät User slice döïa treân moät vuøng choïn Marquee. Neáu 

vuøng choïn ñöôïc laøm mòn Feather thì Slice seõ bao phuû heát vuøng choïn keå caû 

ñöôøng meùp laøm mòn. Neáu vuøng choïn khoâng coù daïng hình chöõ nhaät, thì Slice 

bao phuû leân moät vuøng hình chöõ nhaät ñuû lôùn  ñeå bao quanh toaøn boä vuøng 

choïn. 

Taïo Slice töø caùc lôùp 
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Khi baïn taïo moät Slice töø Layer, thì vuøng Slice bao boïc taát caû nhöõng 

döõ lieäu pixel trong layer. Neáu baïn di chuyeån layer hoaëc hieäu chænh noäi dung 

cuaû layer thì vuøng slice töï ñoäng ñieàu chænh ñeå bao quanh caùc pixel môùi. 

Caùc layer based slice thaät söï höõu ích khi laøm vieäc vôùi caùc hieäu öùng 

Rollove. Neáu baïn öùng duïng moät kieåu hieäu öùng vaøo layer chaúng haïnnhö 

boùng ñoå hay hieäu öùng saùng röïc � ñeå taïo ra moät traïng thaùi hieäu öùng 

Rollover, Slice töï ñoäng ñieàu chænh ñeå chöùa caùc pixel môùi. Tuy nhieân khoâng 

söû duïng moät Slice based khi baïn döï ñònh di chuyeån Layer treân moät vuøng 

lôùn cuûa aûnh trong quaù trình taïo ra moät aûnh ñoäng, bôûi kích thöôùc cuûa slice coù 

theå vöôït quaù moät kích côõ höõu ích. 

 Choïn moät Layer. 

 Choïn menu Layer / New layer Based Slice. 

Ñeå taïo söï haáp daãn cho trang WEB cuûa mình, baïn coù theå duøng Adobe  

Image Ready  ñeå taïo caùc aûnh GIF hoaït hình töø moät aûnh ñôn giaûn. Do dung 

löôïng file ñöôïc neùn nhoû hôn neân caùc aûnh hoaït hình GIF ñöôïc theå hieän vaø 

hoaït ñoäng treân haàu heát caùc chöông  trình duyeät WEB. Image Ready giuùp 

baïn taïo caùc ñoaïn hoaït hình moät caùch deå daøng vaø tieän lôïi. 

Taïo hoaït hình döïa treân layer. 

 - Laøm vieäc vôùi layer laø moät giaûi phaùp ñeå taïo hoaït hình trong Image Ready. 

Moãi Frame môùi baét ñaàu töø moät baûn sao cuûa Frame tröôùc ñoù, baïn seõ chænh 

söûa Frame baèng caùch  ñieàu chænh caùc Layer. Baïn aùp duïng söï thay ñoåi trong 

caùc layer cho moät Frame ñôn, moät nhoùm Frame hay caû ñoaïn hoaït hình. 
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- Khi laøm vieäc vôùi caùc Layer môùi trong moät Frame, baïn coù theå taïo hay sao 

cheùp caùc vuøng choïn trong layer, ñieàu chænh maøu vaø toâng maøu, thay ñoåi doä 

môø ñuïc (Opacity), phöông phaùp phoái trôn maøu vaø vò trí cuûa layer, thöïc hieän 

caùc coâng vieäc chænh söûa, nhö baïn ñaõ laøm vôùi layer trong moät aûnh baát kyø. 

- Söû duïng caùc thuoäc tính cuûa Layer ñeå taïo hieäu öùng hoaït hình raát deå daøng 

noù cho pheùp baïn löu file hoaït hình theo ñònh daïng Photoshop ñeå chænh söûa 

laïi sao naøy. 

Chuù yù: 

 - Moät vaøi thay ñoåi treân Layer chæ coù taùc ñoäng cho 1 Frame hieän haønh, trong 

khi moät soá thay ñoåi khaùc seõ aûnh höôûng ñeán toaøn boä Frame nhö: 

 * Caùc Frame thay ñoåi rieâng bieät: 

    Chæ coù taùc ñoäng cho caùc frame ñang choïn trong baûn Animation. 

 Caùc thay ñoåi baïn laøm cho Layer baèng caùc leänh vaø caùc tuøy choïn cuûa  baûng 

Layer bao goàm ñoä môø ñuïc, phöông phaùp trôn maøu, söï hieån thò, vò trí vaø hieäu 

öùng Layer seõ ñöôïc aùp duïng cho Frame ñang choïn. 

 * Caùc thay ñoåi toaøn cuïc (Global) 

Taùc ñoäng vôùi taát caû caùc Frame trong ñoaïn hoaït hình. Söû duïng coâng 

cuï toâ veõ vaø chænh söûa, caùc leänh ñieàu chænh söûa  aûnh khaùc seõ taùc ñoäng leân taát 

caû caùc Frame maø Layer ñoù theå hieâïn. 

Khi laøm vieäc vôùi Mask, thay ñoåi vò trí, traïng thaùi vaø lieân keát, caùc 

traïng thaùi seõ ñöôïc aùp duïng cho Frame chæ ñònh, trong khi thay ñoåi noäi dung 

cuûa Pixel hay Vector seõ taùc ñoäng leân taát caû caùc Frame. 
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Làm việc với các table trong Image Ready 
Khi bạn chuyển ðổi một tài liệu có chứa các Slice sang HTMLậ nó 

ðýợc xuất dýới dạng một Tableậ mổi slice riêng lẻ ðýợc ðặt trong các 

table riêng lẻủ Các Slice thật sự là các ô của tableủ 
Bạn có thể chọn gom nhóm các slice thành chính các table mà 

sau ñó nó có thể ðýợc xếp lồng trong Table chínhủ Tuy nhiênậ bạn chỉ 

có thể xếp lồng xuống dýới một cấpủ Bạn có thể ðịnh lại kích thýớc 

table ðể phù hợp với các thành phần của lớpủ 
Tạo các table 

Bạn có thể chọn và gom nhóm các Slice ðể xuất dýới dạng các 

table ðýợc xếp lồng riêng lẻ khi chuyển ðổi một tài liệu sang HTMLủ 
Ðể tạo một Table 
 

 
 

Thực hiện một trong các thao tác sau: 
Chọn nhiều Slice và nhấp nút Group Slice Into Table trong palette 

Web Content 
Chọn nhiềi các table và sau ñó chọn Slice / Groud Slices Into 
table 
Chọn một Slice và thay ðổi loại Slice từ dạng Image sang Table trong 

palette Slice. Chuyển sang palette table ðể xác lập các thuộc tính của 

nóủ 
Tạo các thý viện ảnh Web ( Photoshop) 

Bạn sử dụng lệnh Web Photo Gallery ðể tự ðộng tạo ra một thý 

viện ảnh  Web từ tập hợp các ảnhủ Một thý viện ảnh Web làm một 

Web Site có một trang chủ với các ảnh ở dạng thumbnail và các trang 

với các ảnh có kích th ýớc tối ðaủ  
Mỗi trang chứa các liên kết cho phép khách viếng thãm ð ịnh hýớng 

site. 
Photoshop cung cấp nhiều kiểu cho thý viện của bạn mà bạn có 

thể sử dụng bằng lệnh Web Photo Galleryủ 
Mỗi template cho các kiểu thý viện ði kèm với các tuỳ chọn khác 

nhau. Nếu bạn ðang chọn một kiểu xác lập sẵnậ một số tuỳ chọn có 

thể mờ ðiậ hoặc không có sẵn trong Style riêng biệtủ 
Taïo moät thö vieän aûnh Web 
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Khi taïo moät thö vieän trong boä trình duyeät file, caùc aûnh cuûa baïn seõ ñöôïc 

trình baøy theo moät thöù  töï maø chuùng ñaõ ñöôïc hieån thò trong boä trình 

duyeät file. Neáu baïn muoán xem moät thöù töï khaùc, thay ñoåi thöù töï trong boä 

trình duyeät file vaø sau ñoù choïn Web Photo Gallery. 

1/ Choïn caùc file hoaëc caùc folder maø baïn muoán söû duïng boä trình duyeät 

file 

2/ Choïn menu File / Automate / Web Photo Gallery. 

 

 

3/ Beân döôùi site thöïc hieän caùc böôùc sau: 

 Choïn moät Style cho thö vieän töø menu Styles baät leân. Moät 

khung xem tröôùc cuûa trang chuû xem tröôùc cho Style ñöôïc choïn 

xuaát hieän trong hoäp thoaïi. 

 Nhaäp vaøo ñòa chæ mail maø baïn muoán hieån thò döôùi daïng thoâng 

tin lieân laïc cho thö vieän. 

 Choïn phaàn môû roäng cho caùc file ñöôïc taïo ra töø  menu 

Extension baät leân. 

4/ Beân döôùi Source Image, thöïc hieän caùc böôùc sau: 

*  Trong menu Use baät leân, choïn Folder hoaëc select Image from Web 

browser. 

*  Neáu baïn choïn Folder, nhaáp choïn Browse, sau ñoù choïn thö muïc 

chöùa caùc aûnh maø baïn muoán xuaát hieän trong thö vieän. 

5/ Ñeå xaùc laäp tuyø choïn chung cho caùc thö vieän aûnh, choïn General töø 

trong Menu option baät leân, sau ñoù thöïc hieän caùc böôùc sau: 

*  Choïn moät phaàn môû roäng cho file (HTM hoaëc HTML) 
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*  Choïn Use UTIF 8 Encoding for URL neáu baïn muoán phöông phaùp maõ 

hoaù ñoù. 

*  Choïn Add Width vaø Height Attributes for Images ñeå gia taêng toác 

ñoä taûi xuoáng. 

 

 

 

 

 

 

 

 

 

 

 

BAØI 1:  CHUYEÅN ÑOÄNG ÑÔN GIAÛN 

(Image Ready) 

ÑOÁI TÖÔÏNG CHUYEÅN ÑOÏÂNG 

 

 Môû  File/New         W:10 inch 

  H :10 inch RE:  72 

  Content: white 

  Mode: RGB 

1. Taïo neàn 

 Foreground : xanh döông 

 Backgrohnd : traéng 

 Menu Filter / Render / Clounds: maây 

Choïn coâng cuï Aribrush neùt coï meàm 25 

Choïn maøu Foreground, drag mouse treân neàn maây, vaø thay ñoåi maøu lieân tuïc 

vaø veõ caùc veát maøu töø ngoaøi vaøo taâm cuûa aûnh. 

 Menu Filter/ Distort / Twril 

 

2. Veõ moät ñoái töôïng hình tim laøm ñöôøng daãn 

       New/ Layer 

       Choïn coâng cuï Pen click mouse ñeå taïo vaø hieäu  chænh hình tim 

 - Menu con cuûa Path -> Make Selection, bieán  thaønh vuøng choïn 

 - Menu Select / Save Selection: ñaët teân vuøng choïn 

 - Ctrl + D huûy choïn 

 - Menu con cuûa Path -> choïn Stroke path 



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

89 

 - Choïn coâng cuï Paintbrush maøu Foreground tuøy yù ñeå toâ vaø hieäu cho chænh 

hình tim. 

   * AÁn hai laàn Del ñeå huûy Path 

   * New / Layer 

   * Menu Seclect / Load Seclection 

   * Menu Seclect / Transfrom 

   * Menu Seclect / Scale(vuøng choïn) 

   Foreground: ñoû -> Alt + Del 

Double click vaøo coâng cuï Gradient Fill. 

Foreground: traéng 

Muïc Type: choïn maøu chuyeån :  Foreground-> Transparency 

Drag mouse treân hình tim toâ maøu ñoû ñeå taïo hieäu öùng noåi  

 - Ctrl + D huûy choïn 

 - Duplicate Layer 

 - Di chuyeån  hình tim theo chieàu kim ñoàng hoà, moät khoaûng caùch -> 

Duplicate Layer 95% 

   * Duplicate Layer 

   * Dòch chuyeån vaø giaûm Opacity 90% 

   * Thöïc hieän laëp laïi cho ñeán giaùp voøng hình tim vôùi  

   ñoä Opacity giaûm daàn. 

   Menu File/ Save 

   Choïn teân  

   Choïn ñuoâi : .PSD 

 AÛnh goàm coù: nhaân baûn 4 Background neàn vaø duøng Twil, moät Layer hình 

tim vieàn daày lôùn vaø 12 Layer hình tim nhoû. 

 - Khôûi  ñoäng  chöông trình Image Ready 

  - Menu File/ Open 

- Choïn file ñaõ thöïc hieän töø Photoshop. Môû hoäp Layer -> cho hieån thò 

heát taát caû caùc Layer. 

- Hoäp Animation hieån thò  

 

 

- Set: Frame: khung maëc ñònh ban ñaàu khi aûnh ñöôïc xuaát hieän treân 

maøn hình 
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- Forever: Chuyeån ñoäng lieân tuïc cho ñeán khi nhaán oâ Stop. 

- Once: chuyeån ñoäng moät voøng. 

- Other: ñònh soá laàn chuyeån ñoäng. 

 

 

   Trôû veà khung ñaàu tieân. 

   Trôû veà tröôùc moät khung. 

   Thöïc hieän chuyeån ñoäng. 

   Trôû laïi Frame cuoái cuøng 

   Trôû laïi Frame keá tieáp 

   Ngöng chuyeån ñoäng 

    Duplicate current frame : nhôn baûn Frame ñang choïn 

    Del Frame 

  Tween : Taïo caùc Frame trung gian. 

 Baét ñaàu: 

 Taét maét taát caû caùc Layer (laøm aån Layer). Chæ ñeå laïi Background. 

 Nhaáp nuùt Duplicate Current Frame Click môû maét nuùt Layer vieàn tim. 

 Duplicate Current Frame 

 Môû maét Layer tim (1) 

 Taét maét Layer vieàn tim 

 Duplicate Current Frame 

 Môû maét Layer tim (2) 

 Taét maét Layer vieàn tim (1) 

Thöïc hieän laëp laïi vaø nhaân baûn caùc böôùc nhö treân cho ñeán hình tim (12) 

Click trôû veà Frame ban ñaàu 

Click Play, Choïn Forever.  

 

Baøi 2:  TAÏO MOÄT CHUOÃI AÛNH 

Taïo moät file aûnh coù chöùa caùc Layer traùi caây baèng caùch laøm aån hieän caùc 

Layer lieân tieáp 

Menu con cuûa hoäp Animation 

Choïn Make Frame From Layers. 

Caùc Layer trong File seõ theå hieän treân (caùc) Layer Frame rieâng bieät trong 

baûn Animation (moãi Frame seõ chöùa moät loaïi traùi caây). 

 - Trong baûn Animation nhaán Shift click vaøo caùc oâ aûng cuûa töøng Frame ñeå 

choïn taát caû caùc Frame. 

 - Hoaëc trong baûn Animation choïn Select All Frame 

 - Xaùc laäp thôøi gian. 
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 - Click vaøo 0 sec ôû baát kyø Frame naøo ñeå môû menu Delay, choïn muïc 

Other... 

 - Choïn 0.25 sec/ OK 

 - Save / File 

* Laøm trôn söï chuyeån tieáp: 

 Taêng cöôøng chuoãi aûnh baèng caùch theâm vaøo caùc Frame trung gian ñeå 

laøm trôn söï chuyeån tieáp giöõa quaû Daâu vaø quaû Cam. 

* Hoäp Animation 

Click choïn Frame quaû Daâu. 

Click vaøo nuùt Duplicate Current 

Layer Frame ñeå taïo Frame môùi sau Frame quaû Daâu. 

Trong baûn Layer click choïn Frame quaû Daâu, ñoä môø ñuïc Opacity: 1% 

Choïn muc Tween 

Muïc Layer -> Choïn All Layer 

Huyû choïn Position vaø Effects 

Choïn Opacity 

Muïc treân Width : 4 Add to Frames/ OK  

 Previous Frame 

Coù theå thöïc hieän cho caùc Frame khaùc 

Thöïc haønh quaû cam 

Baûng Animation 

Click choïn Frame quaû Cam 

Trong baûn Layers, Drag Layer quaû Cam thaû vaøo nuùt New Layer ñeå sao 

cheùp Layer quaû Cam. 

Chuù yù: Khi baïn taïo moät Layer môùi trong moät Frame, Layer naøy seõ ñöa vaøo 

taát caû caùc Frame trong ñoaïn hoaït hình nhöng noù chæ ñöôïc hieån thò trong 

Frame hieän haønh. Sao cheùp laëp laïi ñeå taïo 3 baûn sao nöõa cuûa Layer Orange. 

Choïn layer Orange 20% vaø laøm aån caùc Layer khaùc 

Menu Edit/ TRansfrom/ Numeric 

Muïc Scale 

 Pescent: 20% 

   Contrain Proportions 

Thöïc hieän laïi caùc böôùc keá sau:  

 + Baûng Animation chöùa quaû Cam ñang choïn -> Click nuùt Duplicate Current 

Frame ñeå taïo Frame môùi 

 + Trong baûn Layers, laøm aån Layer Orange 20%, choïn maø môû maét Layer 

40% 

 + Menu Edit/ Transfrom/Numeric 

  Thay ñoåi kich thöôùc quaû cam trong muïc Scale / Percent: 40% 
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 Thöïc hieän caùc böôùc treân cho Layer Orange 60% , 80% 

 Click nuùt Duplicate Current Frame ñeå taïo Frame cuoái. 

 Trong baûng Layer -> Click choïn vaø laøm theå hieän Layers Orange. 

- Laøm aån taát caû caùc Layer khaùc. 

 

 

 

(maãu baøi taäp löu treân ñóa) 

Baøi 1 

HIEÄU ÖÙNG CHÖÕ CHAÙY 

( thöïc hieän baèng boä loïc ) 

 

 Môû trang giaáy neàn traéng, maøu Foreground vaø Background maëc 

ñònh  

 Choïn maøu Foreground: nhaán Alt + Del toâ cho neàn giaáy maøu ñen 

 Choïn maøu Foreground: Ñang hieån thò maøu traéng,  

 Duøng coâng cuï Text nhaäp  hai kyù töï  BOÁC LÖÛA  

 Duøng coâng cuï MagicWand  choïn moät kyù töï      

Menu Select / Similar: Vuøng Text ñoàng maøu ñöôïc choïn  

 Menu Select / Save selection : Löu vaø ñaët teân cho vuøng choïn / 

Nhaáp Ok  

 Menu Select / Deselection (Ctrl + D): huûy choïn  

 Menu Image  / Rotate Canvas / 90 Cw  (xoay toaøn aûnh theo chieàu 

kim ñoàng hoà)  

 Menu Layer / Rasterize / Type (chuyeån Text sang daïng layer) 

 Menu Filter / Stylize / Wind:  hieäu öùng gioù  

 Ñònh Brush: Gioù trung bình        

     From Right: Höôùng gioù sang phaûi  

 Nhaán Ctrl + F  thöïc hieän laïi hieäu öùng gioù laïi hai laàn  

 Menu Image / Rotate Canvas / 90 CCW (Xoay toaøn aûnh ngöôïc 

chieàu kim ñoàng hoà)  

 Menu Filter / Distort / Ripple: laøm duùm 200 

 Menu Filter  / Blur / Graussian Blur: choïn 0.8 pixel (laøm môø). 

 Menu Image / Mode / Indexed Color  

 Menu Image / Color Table / Back body. Choïn maøu ñoû / Ok / Ok  

 Menu Image / Mode / RGB traû laïi cheá ñoä heä ba maøu 

 Menu Select / Load Selection: Daùn laïi teân vuøng choïn ñaõ löu Ok  
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 Menu Select / Modify / Contract: Thu toùm vuøng choïn ñang hieän 

haønh 2 Pixel  

 Menu Select / Feather: ñònh vuøng lan toaû quanh choïn 3 Pixel (Khi 

söû duïng cheá ñoä naøy maøu yoâ quanh vuøng choïn seõ meàm hôn.  Maët 

tröôùc chöõ troâng coù veû  noåi hôn)  

 Menu Select / Load Select  

Menu Edit  / Copy (Ctrl + C) 

Menu Edit  / Paste ( Ctrl+ V) 

Menu Filter / Distort / Ripple: 250 laøm hieäu öùng gôïn 

soùng, tuøy choïn ñoä gôïn soùng lôùn nhoû. 

Menu Layer / Layer Style / Satin: taïo hieäu öùng noåi 

 Contour / Ok . 

Baïn coù theå söû duïng boä loïc (Boä Plugin) phuï trôï cuûa 

Photoshop ñeå thöïc hieäân caùc hieäu öùng treân moät caùch raát 

nhanh choùng. 

Trong boä loïc phuï trôï naøy coù nhieàu caùc hieäu öùng nhö: laøm 

chaùy (Fire), khoùi (Smoke), noåi vôùi bieân gôø (Carve), phaùt 

saùng (Drop Shawdow) vôùi nhieàu tuøy choïn vaø maøu saéc 

khaùc nhau, laøm veät maøu (Motion trail), ñan nan (weave), 

taïo boït nöôùc (water drop), hieäu öùng goã (Wood), taïo caùc 

ngoâi sao vôùi soá löôïng caùnh tuøy yù, choïn ñöôïc maøu hoøa 

troän (Star) vaø nhieàu hieäu uùng khaùc�.. 

 

   Baøi 2 

                            DAØN HOA CHAÙY VAØ HIEÄU ÖÙNG KHOÙI 

 
 Môû File New  

 Taïo Layer môùi. Duøng coâng cuï Pen veõ hình traùi tim, hoaëc baïn coù 

theå duøng coâng cuï Custom Shape choïn maãu hình tim, sau ñoù hieäu 

chænh laïi.  

 Menu con cuûa hoäp Show Path / Make Selection, bieán Path thaønh 

vuøng choïn löïa. 

 Menu Select / Save Selection / löu vuøng choïn ñaët teân / Ok  

 Menu con cuûa hoäp Show Path / Make Work Path , bieán vuøng 

choïn thaønh Path  

 Huûy choïn Path (Del path). Duøng Pen Click troû ra vuøng ngoøai Path  

 Môû File (hoàng vaøng) thu nhoû (scale), copy sang File coù Path ñang 

hieån thò  
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 Choïn boâng hoàng, duøng  coâng cuï Magic Wand click vuøng ngoøai 

boâng hoàng  

 Menu Select / Invert ñaûo choïn vaøo vuøng trong boâng hoàng ñöôïc 

choïn  

 Nhaán Alt, ñaët troû Move vaøo boâng hoàng, choïn vaø drag sang vò trí 

khaùc cho ñeán khi ñaày vaøo ñöôøng Path, Taát caû caùc boâng hoàng copy 

ñeàu naèm treân cuøng moät Layer duy nhaát  

 Ctrl + D: huûy choïn moät boâng hoàng  

 Duøng Pen click vaøo Path vaø nhaán Del ñeå huûy path.  

 Choïn taát caû caùc boâng hoàng  

 Nhaán Ctrl + C copy caùc boâng hoa ñang choïn vaøo boä nhôù ñeäm Ctrl 

+ D huûy choïn  

 Menu filter / Eye Candy / Fire (löûa) Click vaøo danh saùch thaû cuûa 

caùc daïng löûa tuøy yù. Nhaán Ctrl + V daùn caùc boâng hoa ñang choïn. 

Trong boä loïc Eye Candy 4000 cho pheùp baïn xöû lyù daïng löûa vaø 

khoùi theo höôùng tuyø yù 

 Taïo Layer môùi, Load vuøng choïn hình tim ñaõ löu, bieán vuøng choïn 

thaønh Path (Menu con cuûa hoäp Show Path / choïn Make Work 

Path) choïn maøu Foreground tuøy yù ñeå toâ cho Path  

 Menu con cuûa Path / Stroke Path: toâ vieàn cho Path, choïn coâng cuï 

toâ trong danh saùch thaû vaø neùt coï. Vieàn toâ phuï thuoäc vaøo neùt coï 

baïn ñònh tröôùc. 

 

             

Baøi 3 

VOØNG NOÅI 

 

 Môû File aûnh tuøy yù  

 Taïo New layer  

 Choïn coâng cuï hình Elip veõ voøng troøn lôùn treân aûnh.  

 Choïn maøu Foreground, nhaán Alt + Del toâ maøu cho vuøng choïn 

voøng troøn.  

 Menu Select  / Transfrom Select, Nhaán Alt + Shift ñaët troû vaøo 1 

trong 4 nuùt goùc thu nhoû vuøng choïn vaøo trong 1 laàn nöõa nhaán Enter, 

nhaán toå hôïp phím Alt + Del ñeå toâ nhanh baèng maøu Foreground. 

 Duøng coâng cuï Text daïng vuøng choïn, nhaäp moät kyù töï treân vuøng 

choïn nhaán Del, laøm roãng  

 Menu Layer / Effects / Bevel and Emboss. Vaøo danh saùch thaû 

Style choïn daïng Ok. 
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Baøi 4 

VUØNG BORDER PHAÙT SAÙNG QUANH CHUOÃI KYÙ TÖÏ 

                                              

 Môû File new  

 Duøng Text 3 goõ chuoãi kyù 

töï mang maøu Foreground  

 Duøng coâng cuï 

MagicWand  choïn toaøn 

Text  

 Menu Select / Modify / 

Border: 64 Pixel  

 Menu Select / Modify / Border: 30 

 Menu select / modify / Border: 15  

 Choïn Layer Text trong hoäp Show Layer  

 Menu Layer / type / Render layer  

 Choïn maøu toâ chuyeån saéc, drag mouse theo höôùng baát kyø treân vuøng 

choïn. 

  

Baøi 5 

DAÏNG CHÖÕ GLOW 

 Môû File New, trang giaáy traéng  

 Maøu foreground laø vaøng  

 Choïn coâng cuï Text goõ chuoãi kyù töï Font: Hel  

 Choïn vuøng choïn cho Text. Menu Edit / Copy  

 Menu Layer Type / Render Layer  

 Menu Select / Modify / Border: 20  

 Menu Select / Feather: 6 (Leänh Feather laøm cho 6 Pixel beân trong 

vaø 6 Pixel beân ngoaøi). 
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 Foreground choïn maøu Ñoû  

 Menu Edit / Fill. Ñònh Opacity: 100% 

         Mode: Normal  

 Menu Edit / Pasts Text maøu vaøng ñöôïc ñaët treân vuøng phaùt saùng 

maøu ñoû  

 Menu Filter / Distort / Sherize: 50  

 Menu Filter / Stylize / Tiles       

     Xeáp oâ treân Text 10/ 10 / Ok . 

 

Baøi 6 

CHÖÕ GEL 

 
 File / New Background Color: ñen  

 Coâng cuï type nhaäp chuoãi kyù töï       

   Neáu Font coù caïnh cöùng -> choïn Modify  -> 

Smooth, 5 Pixel. Neáu khoâng laøm troøn choïn Smooth 

 Toâ maøu traéng cho Text  

 Ctrl + O vuøng choïn hoaït ñoäng  

 Select -> Feather = nhaäp 5 Pixel  

 Foreground: Magenta 100%  -> Ctrl + Del     

   Ctrl + D huyû choïn 

 Choïn Feather          

  Neân aùp duïng cho töøng kyù töï moät baèng caùch. Choïn Lasso 

-> Filter -> Gallery Effects  

Classic Art 3 GE Plastic Warp       

 Highlight + Strength: 15  Detail: 9   Smooth: 7   

   Ctrl + F  thöïc hieän laäp laïi hieäu öùng cuûa boä 

loïc naøy 7 laàn. 

Menu Select -> Load vuøng choïn ñaõ löu 

 Menu Select -> Modify -> Expand: Môû roäng vuøng choïn löïa 4 

Pixel  

 Copy Text vaø vuøng choïn sang file khaùc thöïc hieän    

  1/ Menu Select -> Modify -> Contrast: 8 Pixel  

Toâ ñaày vuøng choïn maøu ñen  

  2/ Sao cheùp chuoãi Text sang neàn vaøng     

     Filter -> Sharpen -> Unshap Mask: laøm môø 

        55%, 3 pixel, 0  level  

  3/ Sao cheùp Text sang neàn khaùc  

   Filter -> KTP  -> Gradient Designer 



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

97 

    Choïn Tacky, Wacky  

   Choïn maøu tuøy yù trong Palatte color. 

 

Baøi 7 

CHÖÕ PHALEÂ 

 

 Choïn moät file aûnh tuøy yù vôùi Re: 150 Pixel  

 Nhaäp chuoãi kyù töï, Chöõ thöôøng daïng Italic, thöïc hieän treân keânh môùi 

(keânh khaùc 4) hoaëc moät layer môùi  

  Duplicate keânh 1 thaønh Blur 1  

  Filter ->  Blur -> Gaussian Blur  3 Pixel  

  Nhôn ñoâi keânh khaùc  Blur 1 Thaønh Blur 2  

  Filter  -> Other -> Offset     H : -4          V : -3  

 Warp  

 Menu Image -> Calculation  

 Source 1: Glass Source:   

  Layer   Background  

  Chanel: Blur khac 1  

   Blending: Difference  

   Opacity: 100%  

 Invert,  Mask  

 Menu Image -> Map -> Invert (keânh khaùc 7)  

 Menu Image -> Adjust -> Level, Ñaùnh daáu muïc Auto. 

 

  

Baøi 8 

CHÖÕ PILLOW COÙ NEÀN RAÊNG CÖA 

 
File / new -> Foreground maøu ñen  

            Background maøu traéng  

 Nhaäp Text leân neàn aûnh maøu ñen  

 Menu Select / Modify / Smooth: laøm meàm bieân choïn 5 Pixel  

 Nhaán daáu ñeå thay ñoåi maøu Foreground vaø Background, choïn vuøng 

choïn Text  

 Menu Edit / Stroke (2 Pixel)  Outside   Opacity: 50  

   Alt + Del toâ maøu cho Text  

 Filter -> Blur -> Gaussian Blur      8 Pixel  

 Menu Image -> Adjust -> Bright: 0        Contrast: 25  
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 Menu Image -> Adjust -> Levels   drag con tröôït sang phaûi (traéng) 

200 Pixel  

 Filter -> Stylize -> Find Edges taêng ñoä töông phaûn. 

Menu Image-> Adjust -> Levels  

 Menu Image -> Adjust -> Variation  

   Image -> Brigh : 40 

Caùch 2 : 

  Thöïc hieän xong caùc böôùc treân  

  Taïo ñoä boùng möôït cho kyù töï vuøng choïn ñang hoaït ñoäng  

  Menu Edit / Stroke  2 Pixel Opacity: 50 Out side  

  Filter -> Stylize -> Wind  Wind � Left  

   Thay ñoåi thieát laäp tuøy yù. 

 

Baøi 9 

FOAM CHÖÕ SUÛI BOÏT 

 

File / New -> Type nhaäp chuoãi Text -> löu vuøng choïn Text vöøa nhaäp 

   Font  Thickhead    Size:  100,  Spacing: 5  

 Menu Filter / Noise / Add Noise, Ñònh muïc  Amount: 240 

   Ctrl + D huûy choïn vuøng  

 Menu Filter / Stylize / Diffuse  Normal / Ctrl + F: 8 laàn laëp laïi hieäu 

öùng Diffuse  

  Duplicate layer  

  Menu Select / Load, vuøng choïn  ñaët teân Layer 2  

  Filter Blur / Gaussian Blur  0.5 Pixel  

  Trôû veà Layer 1 Load vuøng choïn 1  

  Menu Seclect Feather = 1  

  Color  C: 100   M: 75    Y: 0     K : 40 

   Hoaëc heä ba maøu :     R: 0    G: 40    B: 86  

  Menu Edit / Stroke: Toâ vieàn  

   W: 4 center, Opacity: 100  Mode: Normal  

     Huyû choïn Resever  Transparency  

  Load vuøng choïn  

  Image ->  Brigh / + 100 

     Contrast: 0  

Chöõ phaùo boâng 
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Baøi 10 

CONFETTI  CHÖÕ BOÂNG GIAÁY 

 
 File / New -> coâng cuï Type nhaäp chuoãi Text, Font   Brich    Size: 90 

 Foreground: ñen -> Alt + Del  

 Filter / Noise / AddNoise   Amount: 560 

     Gaussian  

     Huûy choïn Mono  

 Ctrl + D huûy choïn  

 Filter / Pixdate -> Crystallize       Cell  size: 5  

 Menu Image -> Adjust -> Selective Color: Blacks  

    Black Drag mouse sang traùi �100%  

  Thöïc hieän nhö vaäy vôùi muïc  

   Nevitrals  vaø Whties , vuøng ñen xaùm seõ maát  

 Menu Image /Adjust / Replace  Color  

  choïn coâng cuï Eyedropper nhaáp vaøo moât maøu naøo ñoù trong cöûa 

soå hình aûnh  

 Ñieàu khieån con tröôït  Fuzziness: 200  

  môû roäng vuøng choïn ñeå chöùa caùc maøu saéc töông töï nhau  

 Thay ñoåi Hue, Saturation, Lightness sau khi haøi loøng vôùi maøu saéc, 

nhaáp Ok  

 Laäp laïi trình töï choïn maøu ñeå thay ñoåi maøu tieáp theo. 

 

 

 

Baøi 11 

SEING   CHÖÕ ÑOÙNG BAÊNG 

 File / New  

 Choïn coâng cuï Type Mask nhaäp kyù töï , Font daøy 100  

 Filter / Render / Difference Clouds : treân vuøng choïn  

 Ctrl+ F  thöïc hieän laäp laïi boä loïc naøy 4 laàn  
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 Filter / Noise / Median        Radius : 5   Caùc vaân maây hôi bò môø ñi  

 Filter / Stylize / Find Edges  

 Menu Image / Adjust / Invert   Maøu traéng nhaït ñöôïc cuoän  

 Image / Adjustment / Levels  

 Drag con tröôït  Input maøu traéng sang nuùt beân traùi, drag tröôït Input 

maøu xaùm sang phaûi moät chuùt  

 Menu Select / Modify / Contrast: 2 Pixel  

 Menu Select / Inverse / Nhaán Del  

 Menu select / Inverse  

 Menu / Filter / Blur / Gaussian Blur   R: 0.5  

Ctrl + D  

 Duøng coâng cuï choïn Elip taïo vuøng choïn nhoû ñaët aùp saùt vaùo chöõ  

 Filter / Distor / Twirl    Angle : thay ñoåi töø 100-> 200 cho moãi vuøng, 

thöïc hieän cho caùc vuøng khaùc  treân chöõ  noåi Ctrl + F  

 Double Click vaøo coâng cuï Magic Wand  

 Choïn vuøng ngoaøi neàn Text, Select / Inverse  

 Menu Image / Adjustment  / Brigh : +40    Contrast : -30 

 Menu Filter / Blur / Gaussian Blur : 1 Radius  

 Filter / Render / Lighting Effects  

   Nhaäp giaù trò maøu CMYK :  35    ,     67    ,   5   ,   3   

 Menu Select / Modify / Border / 5 Pixel  

 Menu Filter / Shrapen  / Shrapen Edge  

  laøm cöùng ñöôøng vieàn cuûa caùc kyù töï . 

 

Baøi 12 

 TOÂ CHUYEÅN SAÉC 4 GOÙC MAØU 

 
  Double Click vaøo coâng cuï Gradient Fill choïn Foreground to 

Transparency  

   + Choïn maøu toâ Foreground tuøy yù  

   + Drag mouse töø goùc vaøo taâm aûnh  

   + Thay ñoåi maøu cho Foreground vaø Drag goùc khaùc . 
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Baøi 13 

LOGO CHAÏM NOÅI 

 
 File / Baøn tay  hoaëc maãu hình traéng ñen tuyø yù 

 Môû moät File aûnh traéng ñen  (Logo hoaëc Clip Alt)  

 Chænh laïi kích thöôùc 128 . 128 Pixel -> Menu Image / Image Size  

 Chæ choïn vuøng choïn maøu Ñen: Coâng cuï Magic Wand  

 Choïn Ctrl + C -> Copy vuøng choïn vaøo Select / Similar.  

 Ctrl + V daùn aûnh töø Clipboard (boä nhôù ñeäm) -> Layer 1  

 Choïn Background  

 Menu Filter -> Noise -> AddNoise         Amount : 15  

 Gaussian , Monochromatic -> choïn Layer 1  

 Merge Down Layer 1 vaø Background  

 Filter -> Style -> Emboss  

  Angle :  -51    Height : 2    Amount : 40% . 

 

Baøi 14 

 TAÏO 3 CHIEÀU CHO LOGO 

 
Sau khi baïn ñaõ thöïc hieän xong baøi treân vaø baét ñaàu thöïc hieän theâm 

phaàn döôùi ñaây ñeå taïo hieäu quaû 3 chieàu 

 Choïn  Menu Image / Adjust / Brightness 

   Brightness : 100% laøm saùng  

 Filter / Nois e/ Addnoise : 10 

  Gaussian , Monochromatic : vaân thoâ  

 Menu Select / All  

 Menu Edit / Define  Pattern  

 File New 250 . 250 Pixel hoaëc > hôn  
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 Edit / Fill ->  Use Pattern , Opacity : 100%  

 

Baøi 15 

NUÙT KIM LOAÏI 

 

 
 File / New 80 . 40 Pixel maøu traéng  

 New / Layer -> Foreground : traéng Alt + Del  

 Filter / Noise / Add Noise  (Amount : 100 Gaussian , Monochromatic)  

 Filte Blur / Motion Blur Angle : 0  

  Distance : 10 hieäu öùng maët nhoâm ñaùnh boùng  

 Menu Image / Adjust / Hue / Saturation   Ctrl + U  

  Hue:  -120  Saturation = 20 Lightness: -10  

   Coâng cuï choïn hình vuoâng choïn vuøng  

   Ctrl + C  , Ctrl + V  -> Layer 2 giaáu Layer 1  

  + Choïn coâng cuï  Doulge  Highlights, Exposure: 20% coï veõ 9 

Pixel rìa saéc neùt: nhaáp vaøo goùc traùi treân cuûa hình aûnh treân Layer2 Nhaán giöõ 

Shift nhaáp tieáp thöïc hieän cho heát phaàn rìa treân cuøng vaø beân traùi  

  + Choïn coâng cuï  Brush  (Highlight  Ex: 20% coï 8 Pixel thöïc 

hieän nhö treân cho phaàn döôùi, phaûi)  

  + Layer 2 coøn choïn  

+ Coâng cuï Erase Paintbrush  Opacity; 100% coï 8 rìa saéc neùt, bo 

troøn caùc goùc cuûa nuùt  

  + Taïo Layer 3 ñaët döôùi Layer 2, toâ ñaày baèng maøu traéng  

  + Magic Wand Click choïn vaøo vuøng trong suoát cuûa Layer 2  

   Menu Select / Modify / Expant: 3 Pixel  

   Menu Select / Modify / Border: 3 Pixel  

  + Choïn Layer 3  

   Menu Select Inverse -> Foreground: Ñen  Alt + Del  

  + Ctrl + D huyû choïn  

Menu Image / Adjustment / Hue and Saturation  

   Colorize _ Hue : -120 , Saturation  : 15  

 

Baøi 16 
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NUÙT  CAÅM THAÏCH 

 
 File / New 64 x 64 trang giaáy maøu traéng  

 New Layer 1 -> Foreground: ñoû Alt + Del   

 Foreground: maøu traéng  

 Choïn coâng cuï Airbrush  Presure: 16%  coï 9 meàm  

 Toâ vaøi veät Ziczac ngang qua vuøng aûnh  

 Menu Filter / Distort / Glass  

  Distortion: 10 -> Smoothness: 5  

  Texture: Frosted , Scale: 100%  

 Taïo hieäu öùng vaân caåm thaïch  

 Choïn coâng cuï choïn hình chöõ nhaät nhaán giöõ  Alt + Shift  

 Veõ  vuøng choïn hình troøn töø taâm aûnh  khoaûng ¾ vuøng aûnh  

 Menu Edit / choïn Copy , Ctrl +V  pasts  

 Taïo neân 2 Layer  

 Giaáu Layer 1 vaø Back ground  

 Duplicate Layer 2 -> Layer 2 Copy  

 Menu Image / Adjustment  / Desaturate  

 Menu Image / Adjustment  / Brightness _ Contracst  

   Brightness: 15 

   Contract: 85  

 Magic Wand choïn vuøng trong suoát cuûa Layer 2 Copy -> taïo chanel 

môùi -> Ctrl +V  

 Giaáu Layer 2 Copy  

 Duplicate 2 Copy -> Layer 2 Copy 2  

 Filter / Artistic  _ Plastic Warp  

  Heighlight: 17  Detail: 12  Smoothness : 3  

 Choïn vuøng Layer 2 Copy 2  

 New Layer 3  

  Foreground : maøu ñen  

  Airbrush Presure: 6%   coï : 25 rìa meàm toâ veõ vuøng toái cho hình 

caàu.    Foreground:  traéng toâ vuøng saùng treân vò trí 10h -> ñieàu chænh 

Opacity  

 Choïn vuøng Layer 2  

 Taïo New Layer 4 ñaët treân Background  

 Menu Select / Feather: 3  

 Foreground: ñen Alt + Del  

  Ctrl +D, Duøng Move di chuyeån boùng vöøa toâ leäch xuoáng phía 

döôùi cuûa hoøn bi caåm thaïch, Ñieàu chænh Opacity: 40%  
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 Daïng  2 :  

  Coù saün nuùt treân  

  Merge caùc Layer (tröø Background vaø boùng ñoã)  

  Menu Image / Adjustment / Hue Saturation  

 Ñaùnh daáu muïc  color   Saturation: 100 

     Lightness : 50 

  Or Hue: -150  

  Saturtion: 79  

 

Baøi 17 

NUÙT TRAÉNG TREÂN NEÀN TRAÉNG 

 
  Hieäu öùng 3D ñöôïc taïo thaønh baèng caùch thay ñoåi saéc ñoä vaø giaù 

trò vuøng toái  

  Keát hôïp ñaët tính Stroke vôùi Filter  Neon Glow  

 1.     Taïo File / New  W : 5 inch, H : 2 inch, Re : 72       White 

   Ruler  : ñôn vò ño Inch  

Ñaët ñöôøng gioùng doïc ôû moãi vaïch chia Inch vaø 2 ñöôøng gioùng ngang, 

choïn coâng cuï choïn hình vuoâng, choïn 1 oâ vuoâng töông öùng hình  

 2.     New / Layer             Foreground: traéng  

  Menu Edit / Stroke    Width: 16 Pixel  

     Location: Inside  

     Mode: Overlay  

 3.    Filter / Astistic / Neon Glow   5.5 Brigh : 15  

  Duøng coâng cuï Move -> nhaán Alt, copy ra 4 baûn sao treân cuøng 

moät Layer  

4.    Thöïc hieän caùc böôùc treân cho 2 thanh ngang treân New / Layer  neùt 

roäng  10 Pixel, Location : Inside : Mode : Overlay  

5.    Choïn coâng cuï Text type  Mask goõ kyù töï vaøo töøng oâ choïn Font  

Suntax Heavy canh chænh chöõ vaø thöïc hieän caùc böôùc noãi nhö treân  

 6.    Eùp phaúng hình aûnh  (Flattern Image) xuaát theo daïng GIF  

  * Caùch khaùc :  

  Sau khi ñaõ taïo caùc böôùc töø 1 -> 5, troän taát caû caùc lôùp tröø  

Background, thay ñoåi maøu xaùm hoaëc maøu khaùc tuøy yù caùc nuùt roãng khi naûy 

seõ mang maøu Background vöøa gaùn  

  * Khaéc loõm : Taêng cöôøng aûo giaùc  

 File / New  choïn maøu Background ñaäm  

 Choïn View -> Show Grid  
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 Coâng cuï choïn hình chöõ nhaät choïn moät oâ vuoâng töông öùng treân caùc 

ñöôøng Grid  

 Nhaán Shift choïn theâm caùc oâ vuoâng keá tieáp vuøng choïn caùc nuùt ñang 

hieån thò. 

Taïo  New / Layer (2 )  

 Toâ ñaày maøu ñen ñaët treân Background  

 Vaø döôùi Layer 1  

 Filter / Blur / Gaussian  Blur , 6 Pixel  

 Choïn coâng cuï Move vaø phím muõi teân di chuyeån Layer 2 dòch sang 

phaûi xuoáng döôùi ñeå taïo boùng ñoã  

 Taïo New / Layer 3  

 Coâng cuï Type Mask goõ Text treân caùc nuùt, toâ ñaày maøu ñen cho lôùp 

Text cuûa nuùt  

 Image / Adjust / Brightness : -85 , Contract : +10. 

 

 

 

 

Baøi 18 

MAÃU CARLENDER 

 

Goõ Text treân neàn Background 

 1. Taïo Neàn:     Foreground: Xanh  

        Background: traéng  

  Filter / Render  / Clound  

 Duøng Paintbrush  choïn maøu Foreground tuøy yù, neùt coï meàm 100% 

Drag mouse ñeå taïo caùc Line treân neàn 

Background thay ñoåi maøu Foreground 

lieân tuïc ñeå taïo caùc xoaén maøu  

  Filter / Distor / Twist: laøm xoaén 

 2. Taïo Nuùt:  

  Pen veõ daïng bo goùc  

 Make Selection ñöôøng Path thaønh vuøng 

choïn  

 Ctrl + C -> Ctrl + V ( layer 1)  

 Choïn vuøng nuùt treân Layer  

 Nhaán giöõ Alt di chuyeån ñeå  copy theâm 11 

nuùt  
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 Menu / Filter / Eye candy / Carve  

 Trôû veà Background  

 Text 2 goõ  January  �July  

 Menu Select / Trasform Select 

  Ctrl + C , Ctrl + V  

 Filter Eye candy/ Carve: Taïo ieäu öùng noåi gôø 

 Filter Eye candy / Glow: Taïo hieäu öùng phaùt saùng 

  * Chöõ  CALENDER  

   - Treân Background -> goõ Text  

   - Transfrom Selection -> Rotate 90 ñoä  

 Ctrl +C , Ctrl + V  

 Filter Eye candy / Carve  

 Filter Eye candy / Motion Trail. Taïo hieäu öùng veät saùng  

 

Baøi 19 

CHAÂN DUNG SAØI GOØN 

 

 _ File / New  

 _ Maøu toâ chuyeån saéc treân Background  

 _ New / Layer  

 _ Choïn maøu chuyeån saéc khaùc toâ ñaày  

 _ Copy hình chaân dung sang file khaùc (Layer 1 ) 

 

 

 
 _ Choïn coâng cuï Text daïng vuøng choïn goõ chuoãi Text 



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

107 

 _ Duøng Move di chuyeån vuøng choïn coù aûnh sang vò trí khaùc  

  * Phaàn chöõ  Cong: MISS SAØI GOØN   Font : Brush 

     

 Treân thanh tuyø choïn cuûa coâng cuï Text choïn bieåu töôïng text vaø ñöôøng 

daãn cong, choïn daïng cong trong danh saùch thaû   

 Choïn vuøng choïn Text  

 Toâ maøu chuyeån saéc  

 New Layer -> ñaët döôùi Layer Text  

 Menu Select / Modify / Expand: 7  

 Menu Select / Feather: 3  

 Foreground: Xanh bieån       Background: traéng  

 Toâ chuyeån saéc  Foreground to Transparency  

 Bevel and Emboss  Taïo hieäu öùng noåi 

 New / Layer ñaët treân Layer vöøa toâ  

 Di chuyeån vuøng choïn leân treân (coâng cuï choïn baát kyø)  

 Foreground: traéng      Background: traéng  

 Maøu toâ chuyeån saéc  Foreround to Transparency  

 Drag mouse töø treân xuoáng döôùi Text  

 Bevel and Emboss  

 Copy caùc boâng hoa thay ñoåi maøu  

 Menu Image  / Adjust  / Hue Saturation, drag treân thanh tröôït cuûa 

muïc Hue ñeå choïn maøu tuøy yù  

   

Baøi 20 

TAÏO TROØNG MAÉT 

 New / Layer  

  Choïn maøu (R : 253 G  : 234 B  : 215) 

 New / Layer  

 Coâng cuï choïn  elip , nhaán giöõ  shift veõ voøng troøn hoaøn chænh laøm 

nhaõn caàu  

 Feather: 2 Pixel  Laøm môø ñöôøng vieàn  

 Foreground: Xanh (R : 61 G : 107 B : 134) 

 Filter / Noise / Amount : 27  

  Distribution: Gaussian  

   Ñaùnh daáu muïc Monochromatic  

 AÙp duïng Filter Blur  _  Rodial  Blur  

  Amount: 22  

  Blur method: Zoom  

  Qualitiy: Good  
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 Vieàn xanh xaâm bao quanh  

 Foreground:  R : 20   G : 59      B : 109  

 Menu Edit / Stroke: vieàn vuøng choïn  

  Width : 5  

  Location: center  

  Opacity: 100%  

 Filter Sharpen / Unshap  Mark  

  Amount: 150%  

  Radius: 8.5  

  Threshold: 5  

 Taïo con ngöôi  

  Foreground: ñen  

 Neùt coï cuûa coâng cuï Paint brush  

  Opacity 100%  

  Diameter: 78  

  Hardness: 100%  

  Spacing: 25%  

 Ñaët troû vaøo giöõa troøng maét -> Click Mouse  

  Coâng cuï Airbrush  

  Pressure: 29%  

  Neùt coï Diameter: 3  

  Hardness: 100%  

Foreground : ñoû  

  R : 225  G: 74   B: 60 

 Drag mouse töø vieàn con ngöôi ra ngoaøi ñeå taïo caùc maïch maùu  

 Taïo lôùp môùi, ñaët treân lôùp maét vöøa taïo  

 Select / All  

 R : 102        G : 102      B : 102 

 Alt + Del toâ maøu xaùm ñaõ gaùn  

 Ñònh Opacity cho lôùp toâ naøy laø 70%  

 Foreground: traéng 100%  

 Coâng cuï Airbrush  

 Pressire:70%  

 Diameter: 2  

 Hardness: 0%  

  Click mouse leân phaàn con ngöôi  
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BAØI 21 

 THIEÄP SINH NHAÄT 

 

 

Caùch thöïc hieän: 

- Toâ chuyeån saéc, söû duïng boä loïc Stylize /  Tiles ( 10-10) 

- Veõ vuøng choïn hình Elip, söû duïng boä loïc Render  / Lighting Effects, 

choïn daïng 5 nguoàn saùng phaùt leân treân, di chuyeån vò trí nguoàn saùng tuyø yù. 

- Vieàn hoa hoàng baèng maãu toâ Pattern. 

Caây neán vaø ngoïn neán töï veõ vaø hieäu chænh vôùi coâng cuï pen 

 



 Giaùo trình Photoshop CS 8.0 

 

Söu taàm vaø chænh söûa by Löu Hoaøng Ly 

110 

BAØI 22 

THIEÄP NOEL 

 

Caùch thöïc hieän: 

- Neàn maøu ñoû saäm 

- Custom Shape choïn maãu hình thoâng, bieán thaønh vuøng choïn löïa (vuøng 

choïn ñang ñaët treân neàn), nhaán Ctrl + J ñeå copy vuøng choïn aûnh hình thoâng 

ñaët treân moät lôùp môùi. 

Taïo moät layer môùi, vuøng choïn ñang hieån thò, ñònh Feather laø 10 (laøm vuøng 

phaùt saùng), choïn maøu Foregroud laø traéng, nhaán Alt+ Del ñeå toâ, giaûm 

Opacity trong hoäp layer giaûm maøu. 

Chöõ veõ ngaãu nhieân vôùi coâng cuï  Brush, neùt coï cöùng vaø nhoû tuyø yù. 

 

BAØI 33 

MAÃU HÌNH TRANG TRÍ 

 

 

Caùch thöïc hieän: 
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- Neàn toâ baèng maãu Patern coù ñònh khoaûng caùch. 

- Bieân söû duïng baèng maãu trong Custom shape, bieán path  thaønh vuøng choïn, 

toâ maøu. Laøm noåi (Bevel and Emboss), copy vaø saép xeáp. 

- Hình tim loàng hình maãu tuyø yù, taïo ñoä phaùt saùng vôùi boä loïc Eye Candy 

hoaëc gaùn Feather, toâ traéng. 

- Chöõ uoán cong vôùi Warp Text sau ñoù laøm phaùt saùng. 

 

BAØI 34 

MAÃU THIEÄP XUAÂN 

 

 

 

Caùch thöïc hieän: 

- Neàn beân traùi toâ maøu vaø öùng duïng boä loïc Swirl. 

- Taïo boùng cho traùo tao baèng caùch copy quaû taùo, thu nhoû vaø giaûm Opacity. 

- Neàn beân phaûi toâ maøu neàn, copy hình hoa hoàng töø file khaùc sang, söû duïng 

mode maøu hoøa troän trong danh saùch thaû cuaû hoäp layer. 

Maãu lòch töï nhaäp vaøo vaø söû duïng hieäu öùng noåi. 

 

Caùc maãu thieát keá Album aûnh cöôùi 
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